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6/1/2009  Initial draft delivered to VA Suzanne Van 

Order 

7/13/2009  Updated with placeholders for 16 new 

requirements; will subsequently update this 

guide with functionality, navigation steps and 

screenshots 

Suzanne Van 

Order 

7/20/2009  Modified Reports chapter with 3 new reports 

and updates to 1 existing report. 

Suzanne Van 

Order 

7/21/2009  Updated screenshots Suzanne Van 

Order 

7/22/2009  Updated Reports chapter to include new 

reports, screenshots and navigation steps. 

Updated Section 7.3. 

Suzanne Van 

Order 

7/24/2009  Updated Patient Selection, History, Primary 

Review, Reports and Tools screens to reflect 

new and enhanced functionality in “sweet 

16” Trac tickets. Updated Section 7.6. 

Suzanne Van 

Order 

7/29/2009;  

7/31/2009 

 Updated Reports chapter to include revised 

screenshots. Updated navigation steps and 

refined some functionality write-ups. 

Updated index markers. 

Suzanne Van 

Order 

8/4/2009  Updated document name and footers to 

reflect reversion to “Release 1.0” identifier. 

Suzanne Van 

Order 

8/7/2009  Finished adding functional, navigation and 

screenshots information for requirements in 

the Trac tickets. Generated new Index. 

Suzanne Van 

Order 

8/11/2009  Added alternate text to newly added and 

enhanced screenshots. 

Suzanne Van 

Order 

8/24/2009  Incorporated OQP and field test trainee 

review feedback into the draft. Added 

Appendix G. Submitted for EPS team 

review. 

Suzanne Van 

Order 

9/8/2009-

9/14/2009 

 Updated per EPS and Medora 

feedback/comments 

Suzanne Van 

Order 

9/21/2009-

9/22/2009 

 Updated section 2.2. Removed NUMI 

Workflow Diagrams  

Suzanne Van 

Order 

9/24/2009  Removed Acute Level of Care Review 

Process per Heidi Martin.  

Suzanne Van 

Order 

10/27/2009  Corrected clinical to chemical sec 13.4 Richard LeBlanc 

1/19/2010 
 Updated Chapter 10 to indicate that 

Admission reviews are not to be copied. 

Suzanne Van 

Order 

1/25/2010  Revised write-up in section 3.2 Suzanne Van 
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Order 

2/16/2010 
 v1.1.8 - Added instructions for ‘Enabling 3

rd
 

Party Browsing Extensions’ to Chapter 2 

Suzanne Van 

Order 

2/17/2010 

 v1.1.8 - Update section 7.6;  added 

subsections for new ‘paging’ functionality on 

the Patient Selection screen 

Suzanne Van 

Order 

4/1/2010 
 

v1.1.9 – initial document updates begun 
Suzanne Van 

Order 

4/9/2010 

 v1.1.9 - Updated 31. Text and tip related to 

new column sort feature and behavior of the 

Reset button for filters 

Suzanne Van 

Order 

4/13/2010 

 v1.1.9 – removed references to Save For 

Review Later button - has been removed 

from NUMI; updated Chapter 5 with new 

required field info on Primary Review 

screen; added screenshot of new error 

messages for rqd fields left blank 

Suzanne Van 

Order 

4/20/2010 

 v1.1.9 – added text to Chapter 3 intro and 

section 7.3 regarding new error message text 

that will replace the yellow Server Error in 

‘/’ Application messages 

Suzanne Van 

Order 

4/22/2010 

 v1.1.9 – updated sections related to modified 

Paging functionality for Patient Selection, 

Dismissed Patient Selection and Review 

Selection screens; updated 3.1.9 with 

additional screenshot and indication paging 

links are now within the table grid; updated 

3.1.11 to reflect replacement of Go button 

with Reset Page Size button 

Suzanne Van 

Order 

4/23/2010 
 v1.1.9 – updated section 2.1.11 to include 

behavior change to filter reset functionality 

Suzanne Van 

Order 

4/26/2010 

 v1.1.9 - Replaced screenshots for screens 

containing Paging features, History screen 

Stay Movement and Reviews tables; updated 

text description information for Reports 1 

and 5 

Suzanne Van 

Order 

4/27/2010 

 V1.1.9 – updated user tip in section 5.7 

related to identification of hospital admission 

reviews; updated section 6.1 with new 

screenshots for Physician UM Advisor 

worklist screen; updated section 7.2 with 

updated screenshots and descriptive text 

Suzanne Van 

Order 

4/29/2010 –  V1.1.9 – updated document per PIMS Suzanne Van 
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4/30/2010 feedback - added subsection for Paging 

features to chapter 2. Updated TOC to 

include changes retroactive to prior iterations 

of this artifact.  

Order 

5/12/2010 – 

5/14/2010 

 V1.1.9 – incorporated information about new 

‘red text’ user messages. 

Suzanne Van 

Order 

8/9/2010 – 

8/13/2010 

 V1.1.10 – modified Chapter 3 to reflect new 

behavior; removed images of Save For 

Review Later button; updated Dismissed 

Stay verbiage to reflect new automated 

dismissal of “non-reviewable” specialties; 

updated Chapter 5 to reflect new validation 

check for blank Review Type. 

Suzanne Van 

Order 

8/24/2010 – 

8/26/2010 

 
Updated per PIMS input. 

Suzanne Van 

Order 

8/30/2010 – 

8/31/2020 

 Updated Ch 3, Section 3.1.1 and Figures 16 

and 17 to reflect 34 day default date range 

modification. 

Suzanne Van 

Order 

10/5/2010 

 Per patch 1.1.11, updated sections 3, 4, 4.2, 

4.6, 8.7, 9.1, 9.3, 11.1.6, and 14. Added new 

sections 4.9 and 4.10.  

Suzanne Van 

Order 

10/8/2010 
 

Updated document per PIMS feedback. 
Suzanne Van 

Order 

10/19/2010 

 Inserted verbiage related to Flash Player 

requirement for CERME 2010 to Chapters 2 

and 4. Inserted Figure of Flash Player 

message into Chapter 2. 

Suzanne Van 

Order 

12/6/2010 
 Began inserting information related to release 

1.1.12 thru out the document. 

Suzanne Van 

Order 

12/24/2010; 

12/28/2010 

 Additional 1.1.12 updates added to the 

document. 

Suzanne Van 

Order 

1/13/2011 – 

1/18/2011 

 Updated document per 1/12/2011 baseline 

peer review discussion 

Suzanne Van 

Order 

1/19/2011 
 Updated Section 3.2 per conference call with 

C. Heuer and G. Johnson 

Suzanne Van 

Order 

1/20/2011 – 

2/8/2011 

 Updates made per Rqmts Specification 

Document 

Suzanne Van 

Order 

2/9/2011 
 Updated document per Formal peer review 

meeting 

Suzanne Van 

Order 

2/15/2011 

 Rewrote section 8.11 and 8.12 and updated 

screenshots per client requested requirement 

changes and RSD 

Suzanne Van 

Order 

3/2/2011  Updated sections 8.1 thru 8.10 with updated Suzanne Van 
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screenshots and verbiage that reflects the 

addition of bulletized instructional text on the 

report filter screens screen. Updated sections 

8.11 and 8.12 with updated screenshots 

Order 

3/21/2011 – 

3/22/2011 

 
Updated per release 1.1.12.1 enhancements. 

Suzanne Van 

Order 

4/1/2011 
 Updated document with input from the 

formal peer review discussion 

Suzanne Van 

Order 

4/4/2011 
 Began making updates per requirements in 

the 1.1.13 RSD 

Suzanne Van 

Order 

4/8/2011 -  

5/3/2011 

 Made additional updates per 1.1.13 RSD 

requirements 

Suzanne Van 

Order 

5/9/2011 – 

5/11/2011 

 Updates made to sections 3.3.3, 7.3, 3.2. 

Replaced various screenshots in the 

document. 

Suzanne Van 

Order 

5/25/2011 

 Updated document sections 2.1.18, 2.1.19, 

Figure 11, 2.3.1.1, 2.1.12, 2.1.13, Table 3, 

3.2.1, 7.3 with input from 5/25 formal peer 

review discussion 

Suzanne Van 

Order 

6/2/2011 
 Updated the document with input from the 

6/1 formal peer review discussion 

Suzanne Van 

Order 

6/6/2011 

 Updated Section 8.13.2 with steps for 

exporting Enhanced Reporting artifacts. 

Inserted figure depicting Format type 

selection and Export hyperlink 

Suzanne Van 

Order 

7/29/2011 
 Removed some FAQs per Product Support 

comments 
Lynne Case 

7/29/2011 – 

8/12/2011 

 Updated document with v1.1.13.1 

requirement functionality 

Suzanne Van 

Order 

8/30/2011 

 Revised Section 7.3 and 13.8 to reflect the 6 

month default change to 1 week per revised 

requirements 

Suzanne Van 

Order 

8/31/2011 1.0 

Removed references to green “Please 

wait….page is loading” message in Section 

3.2.1, as that has been removed from NUMI 

Suzanne Van 

Order 

12/29/2011 1.1 

Updated for Release 1.1.14.0:  Made general 

edits, updated screen names, dispersed 

contents from former section 13 Additional 

NUMI Information, added functionality 

updates per SDD, added Document Change 

Table to document specific changes 

Sandy Smith 

05/14/2012 1.2 
Updated section 5.1.1 to reflect the Modify 

Filter button and functionality; updated 
Sandy Smith 
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section 15 to list revised Treating Specialties 

features and updated section 15.3 with 

revised Treating Specialties details 

06/18/2012 1.2 

Per Harris PM, highlighted changes between 

release 13.2 and 14.0 in this User Guide for 

the customer.   

Sandy Smith 

06/19/2012 1.3 

Updated document per customer 

feedback/questions from today:  
 

The Version No. column label in the 

Revision History table should change to 

Document Version No. per discussion with 

Stacey Alfieri.  
 

On p. 1-2, there is a reference to OQP, but I 

believe their name changed to OQSV.  Same 

for Figure 191, pp. 2-10, 17-1, and Glossary.   

 

p. 5-2, first complete sentence on the page 

describes the possibility where “. . . the page 

number which the user previously selected no 

longer exists . . .” but doesn’t explain why 

that might happen.  Please add some 

explanation. 

 

On p. 5-14, Section 5.5, the first paragraph 

refers to Section 7.3, but I think it should 

refer to section 11.3.  

 

p. 5-15 has a sentence “NUMI 

transmits/sends everything except the above 

to VSSC.”   Then there is a list of items that 

are not counted.  Someone with better 

familiarity with VSSC processing needs to 

take a look at this.  My guess is that the word 

“above” should be changed to “following”, 

and/or the first bullet point needs to be 

separated into a description of the bullet 

points as things that VSSC screens out.  

 

On p. 5-16 the first bullet point under Figure 

31 talks about auto dismissal not catching 

non-reviewable stays because of the naming 

convention of the treating specialty.  Is the 

auto-dismiss program still dismissing by 

naming conve7ntion as well as treating 

specialty configuration?  (The note on page 

5-17 seems to be saying that it is, with 

Sandy Smith 
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configuration over-riding naming 

convention.)   

 

In various places, Section 5.6.1 refers to 

colorized patient links on the UM Review 

Listing and Figure 36 illustrates them but I’m 

not seeing this feature in v.1.1.14 any longer 

on any screen.  Am I missing something, or 

is this section outdated?  

 

Section 5.6, at the top of p. 5-21 there is 

message text for sensitive patients that 

doesn’t seem to appear when I click on the 

patient link for patients with #### in the SSN 

column in any of the screens.  The brief 

warning in Figure 37 and another full screen 

with a similarly worded short warning 

(**warning**, **restricted record**) appear 

after various actions, but not the longer 

wording.  Please either describe accurately 

what action on which screen will cause this 

text to be displayed, or remove it from the 

manual.  

 

The second sentence in Chapter 6 refers to 

the Patient Stay History screen as “read-

only”.  Actions like dismissing a stay and 

initiating a review can be taken from this 

screen, so please remove the “read-only” 

phrase so that the sentence begins with “The 

Patient Stay History screen displays 

information . . . “  

 

Two bullet items on p. 6-1 refer to RSD 

items, which is not appropriate for a User 

Guide.  Please remove.  

 

p. 6-5 refers to Chapter 12 for details about 

Unlocking and Deleting reviews, but that is 

now in Chapter 6 and 13, and Chapter 12 is 

for Reports.  

 

Section 5.3 states “(The default is for the 

"Include Observations" checkbox to not be 

selected.)”, but it was checked most of the 

time when I brought up the Patient 

Selection/Worklist screen, including when I 

had just logged in and the screen came up.  
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On p. 7-13, the following sentence refers to 

section 8.15 for admission information, but 

admission review types are now described in 

section 8.18.  I think this sentence should be 

reworded 

FROM: “Please see Chapter 12 for 

more information about reporting 

and Section 8.15 for information 

about the different types of 

admissions).” 

TO:  Please see Chapter 12 for more 

information about reporting and 

Section 8.18 for information about 

the different types of admission 

reviews).  

 

Also on p. 7-13, a note needs the word “now” 

removed because this User Guide should not 

be specific to v.1.1.14:  

FROM: At the time a review is created, 

NUMI will now save three additional data 

fields captured from CERMe: Criteria 

Subset, Episode Day of Care, and CERMe 

version. 

TO: At the time a review is created, NUMI 

will now save three additional data fields 

captured from CERMe: Criteria Subset, 

Episode Day of Care, and CERMe version.  

 

I’m not sure what this sentence on p. 7-15 is 

trying to say. Please reword and correct:  “On 

the Primary Review Summary screen you will 

complete the review by entering the Day 

Being Reviewed, the Current Level of Care, 

entering the Criteria Not Met Elaboration 

details, and Reviewer Comments, selecting 

the Selected Reason Description and, if the 

review does not meet criteria, selecting a 

Recommended Level of Care and Stay 

Reason, and selecting a Physician Advisor 

Reviewer and setting the Next Review 

Reminder DateVerify that Admitting 

Physician, Attending Physician, Treating 

Specialty, Service Selection, Hardware 

correct.”   

 

The following sentence on p. 8-1 is unclear.  
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Why would only “first time reviewers” select 

an admitting Physician?  This same sentence 

appears again at the beginning of Section 

8.11 on p. 8-11. Was the intent that the 

admission review is where an admitting 

physician should be selected? 

“First time reviewers should select 

the Admitting Physician from the 

Admitting Physician dropdown in the 

stay information section of the 

Primary Review Summary screen.”    

The 3rd  paragraph in section 8 says “A read-

only edit box near Criteria Subset is labeled 

“Episode Day of Care” and displays the 

information captured from CERMe.”  The 

only place I can find an illustration is in 

Chapter 9 which has a saved review display 

but it has “n/a” in that field.  Figure 62 

doesn’t include the field label because it isn’t 

a condition-specific review.  A sample 

review with condition-specific criteria that 

has Episode Day of Care data would be 

helpful.  

 

Add to the first paragraph of Chapter 9 that 

the saved review summary is also accessible 

from the UM Review Listing screen.   

 

The 2nd paragraph of Section 11.2 refers to 

Section 12 for information about unlocking, 

deleting, and copying reviews, but Section 12 

is now the Reports Menu.  It should refer to 

Section 13 for unlocking and deleting and 14 

for copying.  

 

Please search the manual for references to 

chapter 12 for Unlocking a review; this is 

now primarily in Chapter 13.  

 

Section 11.3 says “Section 3.1 and Section 

2.1.11 describe the use of these filters.”  

However, Section 3 now describes part of the 

login process.  

 

FAQ section of User Guide: 

P. 18-18 refers to Chapter 7 for deleting 

patient stays, but I think it should be Chapter 
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11.  

 

P. 18-18 refers to Chapter 4 [Table 7] for 

unsupported criteria, but this table is now in 

Chapter 7.  

 

p. 18-18, the first sentence and the next to 

last FAQ refer to Chapter 7 for info on 

Manual Synchronization, but that is now in 

Chapter 11.  

 

p. 18-19 refers to Chapter 5 for changing 

Attending Physician on a review, but this is 

now in Chapter 8.  

 

p. 18-20 refers to Chapter 7 for Dismissed 

Patient Stay info, but his is now in Chapter 

11.  

 

p. 1-20 describes a process for dismissing 

DOM, NH, REHAB and OUTPATIENT 

stays, and should be replaced by something 

describing how to use the Treating Specialty 

configuration so that they are auto-dismissed.  

 

On p. 18-21, the first FAQ under the 

Working with Reviews section describes 

functionality that works differently in 14.0.  

There is no “view” hyperlink any more.  You 

have to click on the patient hyperlink to get 

to the review display. Also, this paragraph 

refers to Chapter 9 for info on unlocking a 

review, and that info is now in Chapter 13.  

 

p. 18-21 has an FAQ on copying reviews (“. . 

. complete more than one review at a time . . . 

“) that refers to Chapter 10, but that info is 

now in Chapters 8, 11 and 14.  
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07/19/2012 1.4 

Updated doc for re-release of 14.0 and 

highlighted changes; per Harris PM, kept 

highlighting from original 14.0 release: 

revised Primary Review Screen (Fig. 62) for 

new Admitting Physician dropdown 

Sandy Pelletier 

10/22/2012 1.5 

Highlighted changes to document in response 

to addition of the Review Type Dropdown, 

IOC testing and customer feedback from 

10/26/2012:  

Review Type Dropdown Updates: 

Updated Figure 48, 51, 53, and 55-57 in 

section 7 and step #5 of sections 7.11 .1 and 

7.11.2 IOC: 

 

IOC Testing Updates: 

Added notes re: making the Continue 

Primary Review button active in section 

7.11.1 step #10, section 7.11.2, step #9, 

bottom of section 7.11.2 and section 7.12, 

step #1; added details to section 5.4.9 in the 

third to last and last paragraph to support 

changes to the Observation calculation. 

 

Customer Feedback Updates: 

Added reference to Fig. 23 in section 5.3;  

added reference to Fig. 34 in section 5.5.1, 

step #5 of Dismiss Type subsection;  

updated Fig. 41 in section 6; added reference 

to Fig. 43 in section in 6.1.6, step #2; Added 

reference to Fig. 62 in section 8.3; added 

reference to Fig. 65 in section 8.4; added 

reference to Fig. 69 in section 8.8; added 

references to Fig. 74 and 75 in section 8.11.1; 

added references to Fig. 88 and 89 in section 

8.22; updated Fig. 123 in section 12.2; 

deleted “Copy Review” erroneously included 

in list of buttons in step #5 of section 13.3; 

added reference to Fig. 189 in step #2 of 

section 15.2; added reference to Fig. 190 in 

section 15.3, page 15-14 and to Fig. 191 in 

step #1.  

Sandy Pelletier 

03/06/2013 1.6 

Highlighted changes reflect updated 

functionality in Increment 6: Section 1.4, 

added/corrected three features; section 5.2, 

Mike 

Chmielewski 
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added/corrected general list of Patient 

Selection/Worklist features; section 5.5, 

added/corrected content related to automatic 

stay dismissal and Dismissal Admission 

screen, corrected overriding of automatic 

dismissal job by Dismissal  

Administration; section 12 (throughout 

Reports), inserted details re: sorting order 

with observation reviews.   

 

To support changes in screens related to 

section 508 compliance, a note and a new 

Fig. 62 were added to section 8. 

 

3/28/2013 1.7 

Highlighted changes reflect updates per 

customer feedback: 

Made changes to cover page to denote 

v1.1.14.0, Increment 6 added to cover page,  

Increment 6 removed from footers, 

Updated section 5.3 to clarify initial default 

when the new user first logs in to NUMI, 

updated Fig. 63 to keep the caption with the 

figure, Section 12.2 updated to explain that 

CERMe Review Types display inside 

selection box, updated link for OQSV home 

page on p. 17.1, added link to VistA 

Software Documentation Library as a source 

for user documentation, updated section 

2.1.22 to reflect 2012.2, added text to steps in 

Section 7.8, Updated section 8.11.1, 

Adm/Atten MD to include parameter on 

name entry/format, text about duplicate 

names entry/no titles/characters limit, 

updated reason codes in Appendix D and E.  

Also updated Fig. 21 to add Modify button, 

updated Fig. 23 to no longer show cancel 

button, updated Fig. 51, updated 53 to show 

new criteria, updated Figs. 58 & 59 to reflect 

current 2012.2 criteria, updated Fig. 68 to 

show reason code example, updated Fig.75 to 

include physician’s name and format 

guidelines, updated Fig. 105 to no longer 

show cancel button, updated Fig. 176 to keep 

the caption with the figure  

Mike 

Chmielewski, 

Eric Dahlenburg 
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05/03/2013 1.8 

Highlighted changes reflect updates per 

customer feedback: 

Deleted section 2.1.3 and Fig 2, deleted the 

paragraph describing ellipses operation and 

original Fig 19, updated figure 23 (now Fig 

21), changed Figure 26 (now Fig 24) to have 

an 'All' option and changed text 

correspondingly, section 2.1.22 – Updated all 

incorrect uses of "CermE, deleted step 4 of 

section 5.4.5 and original Fig 28, added text  

to section 5.4.5 to clarify Filter selection 

criteria 'All', Fig 68 (now Fig 65), corrected 

capitalization of figure title, moved Fig 63 to 

section 8.3 and changed Fig 63 to 65 (now 

Fig 62), updated Fig 70 (now Fig 73), 

updated Fig 79 (now Fig 76), updated Fig 

104 (now Fig 101), updated text in section 12 

for all the reports where the manual has 

PRINT REPORT preview whereas the 

application only has Print Preview as a 

choice and added text where needed such that 

if a user wants to print it they need to right 

click on the report and click print, updated 

Fig 120 (now Fig 117) and text referencing 

this figure in sections 12.2 – 12.10, section 

15, changed to Admin Site to Admin Sites, 

updated Fig 193, (now Fig 190) updated text 

for step 2 and deleted 3.   

Mike 

Chmielewski, 

 

05/24/2013 1.9 

Per VA Feedback from initial submission of 

Increment 6 User Guide , made the following 

revisions: 

Revised last paragraph of section 5.4.5 for 

clarity based on VA suggested text.  Revised 

section 5.5 for clarity, regarding automatic 

dismissal of Initial Treating Specialties. 

Added note to beginning of section 6.1.7 

indicating that both sections 6.1.7 and 6.1.9 

are valid methods of selecting stays for 

reviews, but instructions in section 6.1.7 are 

preferred. Updated Figure 97. Updated 

instruction for printing from the Report Print 

Preview page for Reports Sections 12.2-

12.11.  

Eric Dahlenburg 
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7/31/2013 

 
2.0 

Added new section 5.1.2 Cell Tooltips, added 

explanation of source for columns in the last 

paragraph of section 5.2, added clarification 

to the patient status in section 5.4.9, changed 

Days Since Admission explanation in section 

5.4.10, added new section 6.1.12 Invalidating 

a Patient Stay, added explanation and 

examples of Free Text Searches in section 

11.4. Added alt text to figures. 

Dave Curl, 

Joshua Pappas 

8/14/2013 2.1 
Changed invalidated stay note in section 

5.6.1. 
Dave Curl 

8/16/2013 2.2 

Updated invalidated stay information in Case 

1 in section 5.2.1, removed invalidated stay 

deletion text from section 5.2.1 and 5.5, 

removed truncated footnote from section 

2.1.12, added paragraph explaining Stay ID, 

Movement ID and Checkin ID to section 6, 

changed reference to Chapter 0 to Section 7 

in section 6.1.9, changed figure caption for 

Figure 84, changed footnote 2 to reference 

the Movement ID field in Section 11.6, 

removed highlighting section 5.5 and 11.3, 

removed delete patient stay sentence from 

section 11.7, removed Invalidated stay 

removal / delete note from section 11.7, 

removed section 11.7.2, relabeled section 

11.7.3 to 11.7.2 

Dave Curl, 

Joshua Pappas 

5/6/2014 2.3 

1. Removed Table of Document Changes to 

comply with the documentation standards. 

The Revision table remains as is. 

 

2. Updated Section 5.6.3 Sensitive Patients. 

Changed the wording to be more explicit, 

defining the screen (Utilization Management 

Review Listing) on which the specific 

sensitive patient pop-up message appears. 

 

3. Updated Figure 63 to match changes 

introduced with v14.1 Criteria Met/Not Met 

wording. 

 

4. Updated Figure 192: OQSV Web Page. 

Keshvee Patel 
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Updated screen shot to match most recent 

version of the web page. 

 

5. Updated Section 17 Online Help Menu. 

Description wording is changed. Link to 

VDL turned into a hyperlink. 



May 2014 NUMI User Guide xvi 

Table of Contents 
Table of Contents ................................................................................................................... xvi 
Table of Tables ....................................................................................................................... xxi 
Table of Figures ...................................................................................................................... xxii 

1 Introduction ................................................................................................. 1-1 

1.1 Purpose......................................................................................................................... 1-1 
1.2 Scope ............................................................................................................................ 1-1 
1.3 Target Audience............................................................................................................ 1-2 
1.4 Overview ....................................................................................................................... 1-2 

2 User Instructions ........................................................................................ 2-1 

2.1 Getting Started .............................................................................................................. 2-1 
2.1.1 Allowing Pop-Ups for the Site ...................................................................................................... 2-1 
2.1.2 Making NUMI a Trusted Site ....................................................................................................... 2-2 
2.1.3 Allowing ActiveX Controls for the Site ......................................................................................... 2-2 
2.1.4 Setting Your Screen Resolution to 1024 x 768 or higher ............................................................ 2-3 
2.1.5 Making Sure You Have a VistA Account ..................................................................................... 2-3 
2.1.6 Setting Up Your Internet Browser ................................................................................................ 2-4 
2.1.7 Creating a NUMI Icon on Your Desktop ...................................................................................... 2-4 
2.1.8 Launching NUMI from Your Internet Browser.............................................................................. 2-5 
2.1.9 Locating Your NUMI Point of Contact (POC) .............................................................................. 2-6 
2.1.10 Using NUMI Search Filters .......................................................................................................... 2-6 
2.1.11 Using NUMI Hyperlinks ............................................................................................................... 2-7 
2.1.12 Sorting Information in NUMI Tables ............................................................................................ 2-7 
2.1.13 Using NUMI Buttons .................................................................................................................... 2-8 
2.1.14 Using NUMI Screen ‘Tabs’ .......................................................................................................... 2-8 
2.1.15 NUMI Menus................................................................................................................................ 2-8 
2.1.16 Using Screen ‘Bars’ ..................................................................................................................... 2-9 
2.1.17 Printing NUMI Reports ............................................................................................................... 2-10 
2.1.18 Exporting NUMI Reports to an Excel Spreadsheet ................................................................... 2-10 
2.1.19 Using NUMI Dropdown Boxes ................................................................................................... 2-11 
2.1.20 Using NUMI Paging Features .................................................................................................... 2-11 
2.1.21 Adobe Flash Player (for CERME 2012)..................................................................................... 2-13 

3 VISN, Then SITE Screen ............................................................................. 3-1 

4 National Utilization Management Integration (NUMI) - Screen ............... 4-1 

4.1.1 Entering Access and Verify Codes .............................................................................................. 4-1 
4.1.2 How your login credentials are authenticated.............................................................................. 4-2 
4.1.3 Updating Your Network Account Name (at Login)....................................................................... 4-3 
4.1.4 Hiding / Showing the Welcome Message .................................................................................... 4-4 
4.1.5 Switching the Login Site .............................................................................................................. 4-4 
4.1.6 Session Timeout / Lost Sessions ................................................................................................ 4-4 

4.2 Application Problem Notification ................................................................................... 4-5 

5 Patient Selection/Worklist .......................................................................... 5-1 

5.1 Accessing Patient Information ...................................................................................... 5-1 
5.1.1 General Search Information ........................................................................................................ 5-1 
5.1.2 Cell Tooltips ................................................................................................................................. 5-1 

5.2 General Navigation ....................................................................................................... 5-2 
5.2.1 Information Feeds from VistA ...................................................................................................... 5-3 

5.3 Include Observations .................................................................................................... 5-5 



May 2014 NUMI User Guide xvii 

5.4 Using Filters and Paging Features ................................................................................ 5-6 
5.4.1 Finding Patients By Patient Category .......................................................................................... 5-7 
5.4.2 Finding Patients Using the Reminder Date Filter ........................................................................ 5-7 
5.4.3 Filtering by Reviewer ................................................................................................................... 5-8 
5.4.4 Finding Patients Using the Ward Filter ........................................................................................ 5-8 
5.4.5 Filtering by Service or Treating Specialty .................................................................................... 5-9 
5.4.6 Filtering by Movement ............................................................................................................... 5-10 
5.4.7 Finding Patients Using the Patient Search Filter ....................................................................... 5-11 
5.4.8 Reset Button .............................................................................................................................. 5-12 
5.4.9 Patient Status Column ............................................................................................................... 5-12 
5.4.10 Days Since Admission ............................................................................................................... 5-13 

5.5 Dismissing a Patient Stay ........................................................................................... 5-13 
5.5.1 Dismissing/Distinguishing Stays ................................................................................................ 5-16 

5.6 Selecting Patients for Review ..................................................................................... 5-18 
5.6.1 Selecting a Patient from the Patient Movements List ................................................................ 5-18 
5.6.2 Deceased Patients .................................................................................................................... 5-19 
5.6.3 Sensitive Patients ...................................................................................................................... 5-19 

5.7 Viewing Patient Information for Different Sites ........................................................... 5-20 
5.7.1 Switching to a Different Site ...................................................................................................... 5-20 

5.8 Assigning and Reassigning Reviewers to Patient Stays ............................................. 5-21 
5.8.1 Assigning/Reassigning a Reviewer ........................................................................................... 5-21 

6 Patient Stay History .................................................................................... 6-1 

6.1.1 Patient Stay List........................................................................................................................... 6-3 
6.1.2 Currently Selected Stay Information ............................................................................................ 6-3 
6.1.3 Reviews for Currently Selected Stays List ................................................................................... 6-3 
6.1.4 Table of Stay Movements and Table of Reviews ........................................................................ 6-3 
6.1.5 Showing and Hiding the Table of Reviews for a Patient.............................................................. 6-3 
6.1.6 Dismiss a Patient Stay................................................................................................................. 6-4 
6.1.7 Selecting a Review from the Reviews Table ............................................................................... 6-5 
6.1.8 Selecting a Review from the Reviews for Currently Selected Stays List ..................................... 6-5 
6.1.9 Selecting a Patient Movement from the Stay Movements Table ................................................. 6-6 
6.1.10 Viewing Patient Insurance Information ........................................................................................ 6-7 
6.1.11 Printing out a Patient Worksheet ................................................................................................. 6-7 
6.1.12 Invalidating a Patient Stay ........................................................................................................... 6-8 

7 InterQual Criteria ........................................................................................ 7-1 

7.1 Finding InterQual® Medical Criteria Subsets ................................................................. 7-3 
7.1.1 Finding Subsets using Keyword(s) and Medical Code(s) ............................................................ 7-4 

7.2 Viewing Subset Notes ................................................................................................... 7-5 
7.3 Selecting an InterQual® Medical Criteria Subset .......................................................... 7-6 

7.3.1 Changing a Subset Selection ...................................................................................................... 7-7 
7.4 Printing a Review Summary .......................................................................................... 7-8 
7.5 Viewing InterQual® Notes ............................................................................................. 7-8 
7.6 Viewing CERME Help Topics ....................................................................................... 7-9 
7.7 Viewing Clinical Evidence Summaries ........................................................................ 7-10 
7.8 Change the Current Level of Care Option .................................................................. 7-11 
7.9 Transition Plan ............................................................................................................ 7-11 
7.10 Quality Indicator Checklist ....................................................................................... 7-12 
7.11 Creating Reviews .................................................................................................... 7-12 

7.11.1 Creating an Admission Review .................................................................................................. 7-12 
7.11.2 Creating a Continued Stay (CS) Review ................................................................................... 7-15 

7.12 Continue Primary Review Button ............................................................................. 7-17 

8 Primary Review Summary .......................................................................... 8-1 



May 2014 NUMI User Guide xviii 

8.1 Selecting the Day Being Reviewed Date ...................................................................... 8-5 
8.2 Selecting Admission Review Type ................................................................................ 8-6 
8.3 Selecting or Changing Current Level of Care ............................................................... 8-6 
8.4 Enter Criteria Not Met Elaboration ................................................................................ 8-7 
8.5 Adding Reviewer Comments ........................................................................................ 8-7 
8.6 Selecting a Stay Reason ............................................................................................... 8-8 
8.7 Selecting or Changing Recommended Level of Care ................................................... 8-8 
8.8 Assigning a Physician Advisor to a Review that has Not Met Criteria .......................... 8-9 

8.8.1 Physician Advisor Review Not Required ................................................................................... 8-10 
8.9 Changing the Next Review Reminder Date ................................................................ 8-11 
8.10 Indicating No More Reviews on a Stay .................................................................... 8-11 
8.11 Admitting Physician ................................................................................................. 8-12 

8.11.1 Adding an Admitting/Attending Physician .................................................................................. 8-13 
8.12 Working with Admission Sources ............................................................................ 8-15 

8.12.1 Select /Change Admission Sources .......................................................................................... 8-15 
8.12.2 Selecting or Changing Attending Physician............................................................................... 8-15 

8.13 Selecting or Changing Treating Specialty................................................................ 8-16 
8.14 Selecting or Changing Service Section ................................................................... 8-16 
8.15 Selecting or Changing Ward .................................................................................... 8-16 
8.16 Adding Custom Notes .............................................................................................. 8-16 
8.17 Indicating an Unscheduled Readmit Within 30 Days ............................................... 8-17 
8.18 Working with Admission Review Types ................................................................... 8-17 

8.18.1 Admission Review Types for Admission Reviews ..................................................................... 8-18 
8.18.2 Select / Change Admission Review Type.................................................................................. 8-18 

8.19 Showing a Patient’s Reviews................................................................................... 8-19 
8.20 Copying a Review from the Primary Review Screen ............................................... 8-19 
8.21 Viewing CERME Review Text ................................................................................. 8-20 
8.22 Saving and Locking a Final Review ......................................................................... 8-20 
8.23 Days Since Last VA Acute Care Discharge Calculation .......................................... 8-22 

8.23.1 Calculation Rules....................................................................................................................... 8-22 

9 Saved Review Summary ............................................................................ 9-1 

10 Physician Advisor Review .................................................................... 10-1 

10.1 Physician Advisor Review ....................................................................................... 10-1 
10.2 Selecting a Physician Advisor Review ..................................................................... 10-2 
10.3 Agreeing / Disagreeing with Current Level of Care ................................................. 10-3 
10.4 Entering Physician Advisor Comments.................................................................... 10-4 
10.5 Saving and Locking a Final Review ......................................................................... 10-4 

11 Tools Menu ............................................................................................. 11-1 

11.1 Patient Selection/Worklist Option ............................................................................ 11-2 
11.2 Utilization Management Review Listing Option ....................................................... 11-2 

11.2.1 Printing Utilization Management Review Listing Screen Information ........................................ 11-3 
11.2.2 Exporting Utilization Management Review Listing Screen Information ..................................... 11-3 
11.2.3 Filtering Reviews by Free Text .................................................................................................. 11-4 
11.2.4 Filtering Reviews by Date .......................................................................................................... 11-5 
11.2.5 Filtering Reviews by Reviewer .................................................................................................. 11-5 
11.2.6 Filtering Reviews by Attending .................................................................................................. 11-5 
11.2.7 Filtering Reviews by Ward ......................................................................................................... 11-5 
11.2.8 Filtering Reviews by Service/Specialty/Status........................................................................... 11-6 
11.2.9 Filtering Reviews by Review Type............................................................................................. 11-6 

11.3 Dismissed Patient Stays .......................................................................................... 11-6 



May 2014 NUMI User Guide xix 

11.4 Free Text Search Option ......................................................................................... 11-8 
11.5 Physician Advisor Review Option ............................................................................ 11-9 
11.6 Manual VistA Synchronization Option ................................................................... 11-10 
11.7 Patient Stay Administration Option ........................................................................ 11-14 

11.7.1 Finding Patient Stays that were Removed from VistA ............................................................. 11-15 
11.7.2 Restoring a Patient Stay .......................................................................................................... 11-15 

11.8 Logout Option ........................................................................................................ 11-16 

12 Reports Menu ......................................................................................... 12-1 

12.1 Report #1 - Summary Met/Not Met .......................................................................... 12-4 
12.2 Report #2 - Reasons for Admission Reviews Not Meeting Criteria ......................... 12-7 
12.3 Report #3 - Reasons for Continued Stay/Concurrent Reviews Not Meeting Criteria 12-
11 
12.4 Report #4 - Summary RLOC Reason .................................................................... 12-14 
12.5 Report #5 - Patient Reviews Met/Not Met ............................................................. 12-17 
12.6 Report #6 - Patient Reviews Met/Not Met ‘Custom’ .............................................. 12-20 
12.7 Report #7 - Patient Details .................................................................................... 12-23 
12.8 Report #8 - Physician Reviews .............................................................................. 12-26 
12.9 Report #9 - Physician Advisor Response .............................................................. 12-29 
12.10 Report #10 - Unscheduled Readmits in Less than 30 Days .................................. 12-32 
12.11 Report #11 - RLOC Aggregate .............................................................................. 12-34 
12.12 Report #12 - Clinical Comments Detail .................................................................. 12-36 
12.13 Enhanced Reporting .............................................................................................. 12-39 

12.13.1 Updating your Network Account Name for Enhanced Reporting ............................................ 12-40 
12.13.2 Generating Enhanced Reporting Reports ............................................................................... 12-41 

13 Unlocking and Deleting Reviews .......................................................... 13-1 

13.1 Unlocking a Locked Primary Review ....................................................................... 13-1 
13.2 Unlocking the Physician Advisor Portion of a Locked Review ................................. 13-2 
13.3 Deleting a Review .................................................................................................... 13-4 

14 Copying Reviews ................................................................................... 14-1 

15 Admin Menu............................................................................................ 15-1 

15.1 Accessing the NUMI Users Feature ........................................................................ 15-2 
15.1.1 Finding VistA Users by Name.................................................................................................... 15-3 
15.1.2 Finding VistA Users by Site ....................................................................................................... 15-3 
15.1.3 Finding VistA Users by Status ................................................................................................... 15-3 
15.1.4 Assigning Privileges to a NUMI User ......................................................................................... 15-3 
15.1.5 Viewing NUMI User Information and Privileges ......................................................................... 15-5 
15.1.6 Editing NUMI User Information .................................................................................................. 15-7 
15.1.7 Deactivating a User’s Site ......................................................................................................... 15-8 

15.2 Accessing the NUMI Site Admin Feature ................................................................ 15-8 
15.2.1 Finding a VistA User ................................................................................................................ 15-11 
15.2.2 Adding a User to NUMI Physician Advisor Panel .................................................................... 15-11 
15.2.3 Adding a User to NUMI Primary Reviewer Panel .................................................................... 15-12 
15.2.4 Adding a User to NUMI Site Administrators Panel .................................................................. 15-12 
15.2.5 Adding a User to NUMI Report Access Panel ......................................................................... 15-12 
15.2.6 Removing a User from the NUMI Physician Advisor Panel ..................................................... 15-13 
15.2.7 Removing a User from the NUMI Primary Reviewer Panel ..................................................... 15-13 
15.2.8 Removing a User from the NUMI Site Administrators Panel ................................................... 15-13 
15.2.9 Removing a User from the NUMI Report Access Panel .......................................................... 15-13 

15.3 Accessing the NUMI Treating Specialty Configuration Feature ............................. 15-14 



May 2014 NUMI User Guide xx 

16 Logging Out of the NUMI Application .................................................. 16-1 

17 Online Help Menu ................................................................................... 17-1 

17.1 Selecting the Online Help Menu .............................................................................. 17-1 

18 Glossary of Terms ................................................................................. 18-1 

Appendix A – NUMI Screen Flow ......................................................................................... 18-5 
Appendix B – NUMI Tips for Success ................................................................................... 18-6 
Appendix C – NUMI Terminology ......................................................................................... 18-8 
Appendix D – UM Admission Reason Codes ....................................................................... 18-9 
Appendix E – UM Continued Stay Reason Codes ............................................................. 18-11 
Appendix F – Frequently Asked Questions (FAQ) .............................................................. 18-16 
Appendix G – NUMI Review – Screens Encountered ........................................................ 18-22 



May 2014 NUMI User Guide xxi 

Table of Tables 
Table 1: Select VISN, then Site screen features .......................................................................... 3-1 

Table 2: National Utilization Management Integration (NUMI) features ................................... 4-1 

Table 3: Patient Selection/Worklist Features ............................................................................... 5-4 

Table 4: Patient Stay History Features......................................................................................... 6-2 

Table 5: InterQual Criteria Screen – McKesson CERME Features ............................................ 7-2 

Table 6: InterQual Criteria CERMe Screen – NUMI Features .................................................... 7-2 

Table 7: InterQual
®

 Criteria Subsets not implemented in NUMI ................................................ 7-3 

Table 8: Review Outcomes and IQ Criteria Met Values ............................................................. 8-1 

Table 9: Primary Review Summary Screen Features .................................................................. 8-4 

Table 10: Physician Advisor Screen Features ........................................................................... 10-1 

Table 11: Tools Menu features .................................................................................................. 11-1 

Table 12: Reports Menu list of reports ...................................................................................... 12-3 

Table 13: Admin Users features ................................................................................................ 15-1 

Table 14: Admin Site features ................................................................................................... 15-1 

Table 15: Treating Specialty Configuration features ................................................................. 15-2 

Table 16: Glossary of Terms...................................................................................................... 18-1 

Table 17: UM Admission Reason Codes ................................................................................... 18-9 

Table 18: UM Continued Stay Reason Codes ......................................................................... 18-11 

 



May 2014 NUMI User Guide xxii 

Table of Figures 
Figure 1: Pop-up Blocker Settings ............................................................................................... 2-1 

Figure 2: Install ActiveX Control dropdown ............................................................................... 2-2 

Figure 3: Internet Explorer Security Warning window ............................................................... 2-2 

Figure 4: Screen Resolution settings............................................................................................ 2-3 

Figure 5: Create Shortcut Wizard with NUMI URL ................................................................... 2-4 

Figure 6: Select a Title for the Program window ......................................................................... 2-5 

Figure 7: Windows Security Alert dialog box ............................................................................. 2-6 

Figure 8: Sidebar ........................................................................................................................ 2-10 

Figure 9: Scrollbar ..................................................................................................................... 2-10 

Figure 10: NUMI Paging Hyperlinks ........................................................................................ 2-12 

Figure 11: Adobe Flash Player Dialog Box Select .................................................................... 2-13 

Figure 12: Select VISN, then Site ................................................................................................ 3-1 

Figure 13: National Utilization Management Integration (NUMI) System ................................. 4-1 

Figure 14: VistA Login Error Message ....................................................................................... 4-2 

Figure 15: Login Security Warning ............................................................................................. 4-3 

Figure 16: Session Idle Message.................................................................................................. 4-5 

Figure 17: Lost Session Error Message ....................................................................................... 4-5 

Figure 18: Page load error message ............................................................................................. 5-4 

Figure 19: Patient Selection/Worklist with 34-day default .......................................................... 5-5 

Figure 20: Patient Selection/Worklist with search results ........................................................... 5-5 

Figure 21: Patient Selection/Worklist with Include Observations checkbox .............................. 5-6 

Figure 22: Patient Category Filter................................................................................................ 5-7 

Figure 23: Reminder Date filter ................................................................................................... 5-8 

Figure 24: Reviewer filter with Unassigned option selected ....................................................... 5-8 

Figure 25: Ward filter .................................................................................................................. 5-9 

Figure 26: Movement filter ........................................................................................................ 5-10 

Figure 27: Patient Search filter .................................................................................................. 5-11 

Figure 28: Data Management for UM Review Process - NUMI / VSSC .................................. 5-15 

Figure 29: Dismiss Type dropdown / Dismiss Stays button ...................................................... 5-17 

Figure 30: Selected Dismiss Stay option ................................................................................... 5-17 

Figure 31: Enabled Dismiss Type and Dismiss Stays features .................................................. 5-18 

Figure 32: Select Dismiss Type advisory message .................................................................... 5-18 

Figure 33: Utilization Management Review Listing Patient Selection/Worklist colorized 

hyperlinks ........................................................................................................................... 5-19 

Figure 34: Sensitive Patient Warning for unlocked review ....................................................... 5-20 

Figure 35: Current Lookup Site dropdown ................................................................................ 5-20 

Figure 36: Assign Reviewer dropdown illustration ................................................................... 5-21 

Figure 37: Assign Reviewers button with tooltip ...................................................................... 5-21 

Figure 38: Patient Stay History .................................................................................................... 6-2 

Figure 39: Patient Stay History screen tabs and buttons.............................................................. 6-4 

Figure 40: Dismiss Stay from Patient Stay History ..................................................................... 6-4 

Figure 41: Review Summary screen with Unlock, Delete, Print and Copy options .................... 6-6 

Figure 42: Patient Movements and Reviews tables ..................................................................... 6-7 

Figure 43: Patient Worksheet example ........................................................................................ 6-8 



May 2014 NUMI User Guide xxiii 

Figure 44: Invalidating a Patient Stay .......................................................................................... 6-9 

Figure 45: Unsupported Review Type error message .................................................................. 7-1 

Figure 46: NUMI Application ‘CERMe’ screen ......................................................................... 7-3 

Figure 47: Instruction (Level of Care) Subset Notes example .................................................... 7-5 

Figure 48: Informational Subset Notes example ......................................................................... 7-6 

Figure 49: Criteria InterQual
®

 Criteria checkboxes .................................................................... 7-7 

Figure 50: Change Subset button ................................................................................................. 7-7 

Figure 51: Review Summary ....................................................................................................... 7-8 

Figure 52: InterQual
®

 Notes example .......................................................................................... 7-9 

Figure 53: Clinical Evidence Summary Subsets ........................................................................ 7-10 

Figure 54: Current Level of Care option examples ................................................................... 7-11 

Figure 55: Review Type options ................................................................................................ 7-14 

Figure 56: Admission criteria example ...................................................................................... 7-15 

Figure 57: Continued Stay criteria example .............................................................................. 7-17 

Figure 58: IQ Criteria Met error message .................................................................................... 8-2 

Figure 59: Example required field messages on Primary Review screen .................................... 8-3 

Figure 60:  Red text example ....................................................................................................... 8-4 

Figure 61: Calendar ...................................................................................................................... 8-5 

Figure 62: Review Date prompt ................................................................................................... 8-6 

Figure 63: Primary Review screen ............................................................................................... 8-6 

Figure 64: Criteria Not Met Elaboration ...................................................................................... 8-7 

Figure 65: Reviewer Comments .................................................................................................. 8-7 

Figure 66: Expanded Stay Reason Categories ............................................................................. 8-8 

Figure 67: Recommended Level of Care options ........................................................................ 8-9 

Figure 68: Physician Utilization Management Advisor dropdown ............................................. 8-9 

Figure 69: Physician Advisor Reviewer review not required checkbox indicator .................... 8-10 

Figure 70: Next Review Reminder Date field with calendar displayed .................................... 8-11 

Figure 71: Further Review on Stay checkbox............................................................................ 8-12 

Figure 72: Admitting Physician dropdown ................................................................................ 8-12 

Figure 73 - Warning for Duplicate Physician Name ................................................................. 8-13 

Figure 74 - Warning for Blank Physician Name ....................................................................... 8-14 

Figure 75: Admission Source Options ....................................................................................... 8-15 

Figure 76: Attending Physician dropdown ................................................................................ 8-15 

Figure 77: Treating Specialty dropdown ................................................................................... 8-16 

Figure 78: Service Section dropdown ........................................................................................ 8-16 

Figure 79: Ward dropdown ........................................................................................................ 8-16 

Figure 80: Custom field text example ........................................................................................ 8-17 

Figure 81: Unscheduled Readmit Within 30 Days checkbox .................................................... 8-17 

Figure 82: Admission Review Type dropdown ......................................................................... 8-17 

Figure 83: Review Type Options ............................................................................................... 8-18 

Figure 84: Admission Review Type select option message ...................................................... 8-19 

Figure 85: Show Reviews table display ..................................................................................... 8-19 

Figure 86: CERME Review Text example ................................................................................ 8-20 

Figure 87: Saving review legend ............................................................................................... 8-21 

Figure 88: Unsaved review message .......................................................................................... 8-21 

Figure 89: Commit error ............................................................................................................ 8-21 



May 2014 NUMI User Guide xxiv 

Figure 90: Days Since Last VA Acute Care Discharge field ..................................................... 8-22 

Figure 91: Saved Review Summary ............................................................................................ 9-1 

Figure 92: Physician Advisor Review with no reviews assigned .............................................. 10-1 

Figure 93: Physician Advisor list of reviews sent by Reviewers ............................................... 10-2 

Figure 94: Physician Advisor Review screen ............................................................................ 10-3 

Figure 95: Agree Reasons .......................................................................................................... 10-3 

Figure 96: Disagree Reasons ..................................................................................................... 10-3 

Figure 97: NUMI Tools Menu ................................................................................................... 11-1 

Figure 98: Patient Selection/Worklist screen ............................................................................. 11-2 

Figure 99: Print Function Disabled message ............................................................................. 11-3 

Figure 100: Utilization Management Review Listing screen with grayed out Print and Export 

buttons ................................................................................................................................ 11-4 

Figure 101: Utilization Management Review Listing screen with results and selectable buttons

 ............................................................................................................................................ 11-4 

Figure 102: Dismissed Stays screen with 1 week default date range ........................................ 11-8 

Figure 103: Free Text Search screen ......................................................................................... 11-9 

Figure 104: Physician Advisor Review screen ........................................................................ 11-10 

Figure 105: Server Busy Error Message .................................................................................. 11-11 

Figure 106: Manual VistA Synchronization search results screen .......................................... 11-12 

Figure 107: Stays selected for Synchronizing ......................................................................... 11-13 

Figure 108: Synchronized Stays confirmation message .......................................................... 11-13 

Figure 109: Patient Search Message ........................................................................................ 11-13 

Figure 110: NUMI Patient Stay Administration screen ........................................................... 11-14 

Figure 111: Stay retrieval advisory message. .......................................................................... 11-15 

Figure 112: Patient Stay Administration with Restore button displayed ................................. 11-16 

Figure 113: Reports Menu ......................................................................................................... 12-3 

Figure 114: Percent of Reviews Meeting Criteria filters ........................................................... 12-4 

Figure 115: Admission Review Types list display .................................................................... 12-4 

Figure 116: Percent of Reviews Meeting Criteria output .......................................................... 12-5 

Figure 117: Percent of Reviews Meeting Criteria printout ........................................................ 12-6 

Figure 118: Export to Excel download advisory ....................................................................... 12-6 

Figure 119: Excel format dialog box ......................................................................................... 12-6 

Figure 120: Percent of Reviews Meeting Criteria spreadsheet .................................................. 12-7 

Figure 121: Reasons for Admission Reviews Not Meeting Criteria filters ............................... 12-8 

Figure 122: Reasons for Admission Reviews Not Meeting Criteria output .............................. 12-9 

Figure 123: Reasons for Admission Reviews Not Meeting Criteria printout .......................... 12-10 

Figure 124: Reasons for Admission Reviews Not Meeting Criteria spreadsheet .................... 12-11 

Figure 125: Reasons for CS/Concurrent Reviews Not Meeting Criteria filters ...................... 12-11 

Figure 126: Non-Admission CERMe Review Type options ................................................... 12-12 

Figure 127: Reasons for CS/Concurrent Reviews Not Meeting Criteria output ..................... 12-12 

Figure 128: Reasons for CS/Concurrent Reviews Not Meeting Criteria printout ................... 12-13 

Figure 129: Reasons for CS/Concurrent Reviews Not Meeting Criteria spreadsheet ............. 12-13 

Figure 130: Summary RLOC Reason Criteria filters .............................................................. 12-14 

Figure 131: Summary RLOC Reason output ........................................................................... 12-15 

Figure 132: Summary RLOC Reason printout ........................................................................ 12-16 

Figure 133: Summary RLOC Reason spreadsheet .................................................................. 12-17 



May 2014 NUMI User Guide xxv 

Figure 134: Patient Reviews Met/Not Met filters .................................................................... 12-18 

Figure 135: Patient Reviews Met/Not Met output ................................................................... 12-19 

Figure 136: Patient Reviews Met/Not Met printout ................................................................ 12-19 

Figure 137: Patient Level Met/Not Met spreadsheet ............................................................... 12-20 

Figure 138: Patient Reviews Met/Not Met Custom filters ...................................................... 12-20 

Figure 139: Patient Reviews Met/Not Met Custom output ..................................................... 12-21 

Figure 140: Patient Reviews Met/Not Met Custom spreadsheet ............................................. 12-22 

Figure 141: Patient Reviews Met/Not Met Custom printout ................................................... 12-23 

Figure 142: Patient Details filters ............................................................................................ 12-24 

Figure 143: Patient Details filters with patient name populated .............................................. 12-24 

Figure 144: Patient Details output ........................................................................................... 12-25 

Figure 145: Patient Details printout ......................................................................................... 12-25 

Figure 146: Patient Details spreadsheet ................................................................................... 12-26 

Figure 147: Physician Reviews filters ..................................................................................... 12-26 

Figure 148: Physician Reviews output .................................................................................... 12-27 

Figure 149: Physician Reviews printout .................................................................................. 12-28 

Figure 150: Physician Reviews spreadsheet ............................................................................ 12-29 

Figure 151: Physician Advisor Response filters ...................................................................... 12-29 

Figure 152: Physician Advisor Response output ..................................................................... 12-30 

Figure 153: Physician Advisor Response printout................................................................... 12-31 

Figure 154: Physician Advisor Response spreadsheet ............................................................. 12-31 

Figure 155: Unscheduled Readmits in Less than 30 Days filters ............................................ 12-32 

Figure 156: Unscheduled Readmits in Less than 30 Days output ........................................... 12-33 

Figure 157: Unscheduled Readmits in Less than 30 Days printout ......................................... 12-33 

Figure 158: Unscheduled Readmits in Less than 30 Days spreadsheet ................................... 12-33 

Figure 159: RLOC Aggregate Report filters ........................................................................... 12-35 

Figure 160: RLOC Aggregate CERMe Review Types filter ................................................... 12-35 

Figure 161: RLOC Aggregate Report output ........................................................................... 12-36 

Figure 162: RLOC Aggregate Report printout ........................................................................ 12-36 

Figure 163: RLOC Aggregate Report spreadsheet .................................................................. 12-36 

Figure 164: Clinical Comments Detail Report filters .............................................................. 12-38 

Figure 165: Clinical Comments Detail Report output ............................................................. 12-38 

Figure 166: Clinical Comments Detail Report printout ........................................................... 12-39 

Figure 167: Clinical Comments Detail spreadsheet................................................................. 12-39 

Figure 168: Example Enhanced Reporting List ....................................................................... 12-40 

Figure 169: Enhanced Reporting - no active reports ............................................................... 12-40 

Figure 170: Enhanced Reporting Security Warning ................................................................ 12-40 

Figure 171: Enhanced Reporting report viewer window ......................................................... 12-42 

Figure 172: Format dropdown selection and Export hyperlink ............................................... 12-42 

Figure 173: Review Summary window ..................................................................................... 13-2 

Figure 174: Review Summary with Unlock Physician Advisor Review button ....................... 13-3 

Figure 175: Primary Review Summary screen with Copy This Review button ........................ 14-2 

Figure 176: Review Summary screen with Print and Copy This Review buttons ..................... 14-3 

Figure 177: Admin Menu........................................................................................................... 15-2 

Figure 178: NUMI User List screen .......................................................................................... 15-2 

Figure 179: Find VistA Users search fields ............................................................................... 15-3 



May 2014 NUMI User Guide xxvi 

Figure 180: Add NUMI User ..................................................................................................... 15-4 

Figure 181: Find VistA User results .......................................................................................... 15-4 

Figure 182: Add User Permissions ............................................................................................ 15-5 

Figure 183: View User Privileges .............................................................................................. 15-6 

Figure 184: View NUMI User Information ............................................................................... 15-6 

Figure 185: Edit NUMI User screen .......................................................................................... 15-7 

Figure 186: Site Admin screen (top section) ............................................................................. 15-9 

Figure 187: Site Admin screen (middle section) ..................................................................... 15-10 

Figure 188: Site Admin screen (bottom section) ..................................................................... 15-11 

Figure 189: NUMI Treating Specialty Configuration Feature ................................................ 15-14 

Figure 190: Select Treatment Dismissal Behavior list box ..................................................... 15-15 

Figure 191: Help Menu dropdown ............................................................................................. 17-1 

Figure 192: OQSV Web Page .................................................................................................... 17-2 

Figure 193: NUMI Basic Screen Flow ...................................................................................... 18-5 

Figure 194: Screens Encountered during NUMI Reviews ...................................................... 18-22 

 
  



May 2014 NUMI User Guide xxvii 

 



 

May 2014 NUMI User Guide 15-15 

1 Introduction 

1.1 Purpose  

The purpose of this document is to provide NUMI users with a comprehensive overview of the 

application, as well as navigation steps for using the various features of each screen. Throughout 

the guide are tips and additional information for the reader. This information appears in gray 

highlighted text with the  icon.  

 

1.2 Scope  

This document represents a guided tour of the NUMI application. Users are presented with step-

by-step navigation instructions and comprehensive information about the many features of the 

NUMI application, its options and its screens in a ‘one stop shopping’ format. This guide is 

organized into the following sections: 

 

 Chapter 1: Introduction 

 Chapter 2: User Instructions 

 Chapter 3: VISN, Then SITE Screen 

 Chapter 4: National Utilization Management Integration (NUMI) - Screen 

 Chapter 5: Patient Selection/Worklist 

 Chapter 1: 
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 Patient Stay History 

 Chapter 7: InterQual Criteria 

 Chapter 8 : Primary Review Summary 

 Chapter 9: Saved Review Summary  

 Chapter 10: Physician Advisor  

 Chapter 11: Tools Menu 

 Chapter 12: Reports Menu 

 Chapter 13: Unlocking and Deleting Reviews 

 Chapter 14: Copying Reviews 

 Chapter 15: Admin Menu 

 Chapter 16:  Logging Out of the NUMI Application 

 Chapter 17: Online Help Menu 

 Chapter 18: Glossary of Terms 

 Appendix A: – NUMI Screen Flow 

 Appendix B: – NUMI Tips for Success 

 Appendix C: – NUMI Terminology 

 Appendix D: – UM Admission Reason Codes 

 Appendix E : – UM Continued Stay Reason Codes 

 Appendix F : – Frequently Asked Questions (FAQ) 

 Appendix G : – NUMI Review – Screens Encountered 
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1.3 Target Audience  

This guide is intended for users of different degrees of knowledge and experience with the 

NUMI application. It is particularly geared towards: 

 

 Veterans Health Administration (VHA) Utilization Management (UM) Staff 

 VHA Utilization Review Staff 

 NUMI Site Point of Contact (POC)/Administrators (these are UM staff members) 

 

1.4 Overview 

The National Utilization Management Integration (NUMI) application is a web-based solution 

that automates utilization review assessment and outcomes. The Utilization Management (UM) 

Process is a tool used to help ensure that patients are receiving the right care, at the right time, 

and in the right place. UM is both a quality and efficiency tool, as it is used to move patients 

efficiently through the VA system to maximize use of resources. UM reviewers assess patient 

admissions and hospital stay days using standardized objective evidence-based clinical criteria to 

determine whether patients meet criteria for acute hospital care. 

 

The NUMI project was established to meet a specific business need. The Office of Quality 

Safety and Value (OQSV) has a need to provide automation support to field Utilization 

Management nurses that perform reviews of clinical care activities. These reviews are considered 

core procedures to support both quality improvement and business/compliance functions central 

to VA’s mission. National UM policy includes review of all admissions and all hospital bed days 

of care, with a mandate that all review information be entered into the NUMI application. 

 

The NUMI application standardizes UM review methodology and documentation at the facility 

level and creates a national VHA utilization information database. In NUMI, patient movement 

data is obtained from read-only Veterans Health Information Systems and Technology 

Architecture (VistA) access to pre-populate a patient stay database, eliminating redundancy and 

errors from manually re-entering patient data.  A Commercial Off-the-Shelf (COTS) product, 

McKesson Care Enhanced Review Management Enterprise (CERME), is integrated into NUMI 

to provide access to the InterQual® standardized clinical appropriateness criteria and algorithms. 

The CERME functionality is used to determine whether patient admissions and hospital days 

meet clinical appropriateness criteria for acute care hospital care. The national NUMI database is 

built in Structured Query Language (SQL) and will enable facility, Veterans Integrated Service 

Network (VISN), and national reporting of UM review outcomes. 

 

The NUMI system provides critical functionality to help UM reviewers to organize UM review 

workload, document UM review outcomes, and generate reports to help identify system 

constraints and barriers to providing the appropriate services at the appropriate level of care. 

NUMI users can perform the following functions: 

 

http://www.google.com/search?hl=en&client=firefox-a&hs=KI1&rls=org.mozilla:en-US:official&q=veterans+integrated+service+network&revid=724376706&sa=X&ei=W2-VT6DyIemf6AHhq6TABA&ved=0CDEQ1QIoAA
http://www.google.com/search?hl=en&client=firefox-a&hs=KI1&rls=org.mozilla:en-US:official&q=veterans+integrated+service+network&revid=724376706&sa=X&ei=W2-VT6DyIemf6AHhq6TABA&ved=0CDEQ1QIoAA
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 Pre-populate patient stay information from VistA into a NUMI SQL database which 

records patient stay information. UM reviewed outcomes, reasons, and recommended 

levels of care are saved in the NUMI database. 

 Generate a list of patient admissions and hospital days that need to be reviewed to 

assist UM reviewers in organizing their workload 

 For newly admitted patients, collect patient and treatment information to determine 

whether patients meet clinical criteria for inpatient admission 

 Following admission, collect treatment information for each hospital day to determine 

whether patients meet continued stay criteria 

 Standardize documentation of a) reasons for inpatient admissions or continued stays 

that do not meet clinical criteria for inpatient care, and b) recommended levels of care 

for admissions and continued stay days not meeting criteria 

 Provide  Physician Advisors with an automated UM review list to access reviews, 

document agreement or disagreement with current levels of care, and add comments 

and recommendations regarding patients not meeting criteria 

 Generate summary reports of UM outcomes to provide insight into system constraints 

and barriers and identify quality improvement opportunities. 

 Assign specific reason codes for reviews that do not meet criteria. The VA-specific 

reason code structure will enable UM staff to aggregate and analyze the most 

prevalent reasons why patients are not meeting criteria at their current level of care. 

This information provides insight to help identify quality and access improvement 

opportunities. 

 Display a list of patient stays and review information, with filters and search features 

to assist in organizing individual reviewer workloads 

 Allow the reviewer to filter the display of patients based upon observation status in 

both Worklists and Reports. 

 Allow the Administrator to select the Automatic Dismissal Filter criteria on a per site 

basis. 

 Upon any synchronization, the program shall automatically check the Treating 

Specialty and other filter parameters for compliance with Automatic Dismissal Filter 

criteria and if the patient’s clinical parameters lie within the boundaries of the filter 

criteria, that patient shall be dismissed. 

 

The importance of implementing a national automated Utilization Management Program is 

specifically addressed in The Office of Inspector General (OIG) Report:  Healthcare Inspection:  

Evaluation of Quality Management, Veterans Health Administration (VHA) Facilities Fiscal 

Year 2006 (Project No. 2006-00014-HI-0003, WebCIMS 371342).  NUMI was developed to 

address the Utilization Management data needs of the VHA and to provide the UM staff with a 

web-based solution for capturing patient information in compliance with VHA DIRECTIVE 

2010-021 (Utilization Management Policy).  
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2 User Instructions 

Once you have been authorized to use the NUMI application and have completed NUMI 

training, at the end of the training session you will be given the NUMI uniform resource locator 

(URL) address. This chapter discusses some things to consider before you login for the first time. 

Subsequent chapters (please see the breakdown in Section 1.2) will explain the NUMI screens 

and provide step-by-step navigation instructions for using the various features. Note: if you are 

unable to change the settings on your computer, please contact your local Information Resource 

Management (IRM) support team for assistance.  Tips to help you make the most out of using the 

NUMI application can be found in Appendix B. 

 

2.1 Getting Started 

2.1.1 Allowing Pop-Ups for the Site  

The NUMI application uses pop-up windows, so it is important that your computer is set up to 

allow for these.  If your computer currently has a pop-up blocker, this must be disabled in order 

to use NUMI effectively. (Symptoms you may see that indicate pop-ups are blocked may 

include: a pop-up blocker bar displaying and indicating pop-ups are blocked; or the  

InterQual Criteria doesn’t open properly; clicking on a review hyperlink in a reviews table 

doesn’t display the review screen). If you do not have permission to change your pop-up blocker 

settings, please contact your local IRM for assistance. If you do have permission, here is how to 

double check your pop-up window settings:  

 

1. Open a new browser (if you have several browser windows open, close all but 

one). 

2. Select Tools>Pop-Up Blocker>Turn Off Pop-up Blocker (Figure 1). Note: if 

the pop up blocker is turned off, Steps 3 and 4 are irrelevant. In order to execute 

those steps, select Tools>Pop Up Blocker>Pop Up Blocker Settings and then you 

can proceed to Step 3). 

3. When the Pop Up Blocker Settings screen displays, type the address of the web 

site into the Address of Web site to allow field.  

4. Click the <Add> button. 

5. Click <Close> to exit the screen.  

6. To apply the changes you just made, close your browser and then reopen it.  

 

 

Figure 1: Pop-up Blocker Settings 
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2.1.2 Making NUMI a Trusted Site 

1. From your internet browser, select Tools>Internet Options 

2. Click the Security tab.  

3. Click on Trusted Sites.  

4. Type in the NUMI URL. (The URL will be provided to you after you have 

completed NUMI training). 

5. Click the Apply button. 

6. Click the OK button. 

2.1.3 Allowing ActiveX Controls for the Site 

If you need to install ActiveX controls, you will see the message bar: “This site might 

require the following ActiveX control:” right below the address line of your browser 

window. Follow these steps to install ActiveX controls: 

 

1. Click on the message bar to reveal the dropdown menu.  

2. Click on “Install ActiveX Control” (Figure 2).   

3. When the Security Warning window displays, as illustrated in Figure 3, click 

the <Install> button. Note: You will only need to install ActiveX controls 

once. 

 

 

Figure 2: Install ActiveX Control dropdown 

 

 

Figure 3: Internet Explorer Security Warning window 
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2.1.4 Setting Your Screen Resolution to 1024 x 768 or higher  

To minimize the need for scrolling while doing your reviews, the recommended screen solution 

when using NUMI is 1024 x 768. The screen resolution is changed on the Settings screen. Here 

are some different ways to navigate to the Setting screen: 

 

1. From your desktop, select Start>Control Panel>Display>Settings OR 

2. From your desktop, select Start>Control Panel>Appearances & 

Themes>Display>Settings OR 

3. From your desktop, right-click and select Properties>Settings. 

4. Click and drag the Screen Resolution bar to 1024x768 or higher (Figure 4).  

5. Click the <OK> button. 

 

  Depending on which operating system your computer uses, your Settings screen may 

look different than Figure 4.   

 

 

Figure 4: Screen Resolution settings 

2.1.5 Making Sure You Have a VistA Account 

You must have a VistA account in order to login to NUMI. If you are using Computerized 

Patient Record System (CPRS), you already have an active VistA account. Your IRM contact at 

your facility will be able to assist with VistA account issues, or your NUMI POC may be able to 

help.  (Please see Section 2.1.9 for more information about finding out who the NUMI POC at 

your facility is). Once you have a VistA account, your access to sites within NUMI will be set up 

by a NUMI Administrator. (If you will have multi-site access in NUMI, please be aware that the 

access is completely independent from access to other applications at other facilities including: 
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CPRS, VistA and VistAWeb. Please follow your usual procedure for requesting access to 

applications outside of NUMI). 

2.1.6 Setting Up Your Internet Browser 

Make sure that the browser you are using is Internet Explorer 6.0 or higher. This is the only 

browser that will let you access the NUMI application. If you do not have it installed on your 

computer, please contact your local IRM support team for assistance or enable compatibility 

views under the Tools menu if your browser supports those. 

2.1.7 Creating a NUMI Icon on Your Desktop 

It is highly recommended that you create an icon for the NUMI application on your desktop so 

that you can access it quickly. 

 

To create a desktop icon for NUMI 

You can create an icon for NUMI using the Create Shortcut Wizard. Just follow these steps: 

 

1. Right-click on your desktop and select <New>. 

2. Select <Shortcut>. 

3. The Create Shortcut Wizard window will open, as shown in Figure 5. 

4. Type the NUMI URL address into the Type the location of the item 

field. Click the <Next> button. 

5. The Select a Title for the Program window will open, as shown in Figure 6. 

6. Enter a name for the shortcut in the Type a name for this shortcut 

field. 

7. Click the <Finish> button.  

8. The wizard will close and the icon you just created will appear on your 

desktop. You should now be able to access NUMI by double-clicking on the 

icon, or by right-clicking it and selecting the “Open” option. 

 

 

Figure 5: Create Shortcut Wizard with NUMI URL 
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Figure 6: Select a Title for the Program window 

2.1.8 Launching NUMI from Your Internet Browser 

In addition to being able to access NUMI through an icon on your desktop, you can also launch 

the application via your internet browser. 

 

To launch NUMI using your internet browser  

1. Open your internet browser. 

2. Type the NUMI URL into your browser’s address line. 

3. Press the <Enter> key on your keyboard and the Select VISN, then Site 

screen will display. 

 

 You can have other VistA applications and NUMI open at the same time. Please note, 

however, that NUMI will not follow the active patient in other applications such as CPRS, 

and vice versa. So please be sure you are looking at the same patient for whom you are 

performing a review.  

 

  After launching NUMI for the first time, it is recommended that you add the site to 

your list of browser Favorites. 

 

  NUMI uses a secured website, identified by the prefix https:// in your browser’s 

address line. It is likely you will see a dialog box similar to the one illustrated in Figure 7 

the first time you use the site. If you do, click the <Yes> button to proceed. 
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Figure 7: Windows Security Alert dialog box 

2.1.9 Locating Your NUMI Point of Contact (POC) 

As mentioned earlier in this chapter, you will be given the URL to the NUMI application after 

you have completed NUMI training. You will also be given information about your NUMI 

Facility Site POC/Administrator. That individual is a member of the UM staff and should be 

contacted if you need assistance while using the NUMI application. (Note: the NUMI 

POC/Administrator is not the same as an IRM representative. The NUMI POC/Administrator 

manages the NUMI account, while IRM takes care of VistA and other software and hardware 

issues). Additional NUMI assistance may be found through NUMI Online Help. To access that, 

click the Help dropdown (located at the top of all main NUMI screens) and select the User 

Guide option.   

2.1.10 Using NUMI Search Filters 

Many NUMI screens offer a variety of filters that you can use to search for patients and other 

information. You can select multiple filters if you wish to refine your search to a more detailed 

level. Here are general instructions for using filters:  

 

1. First, activate the filter you wish to use by clicking on the checkbox in the 

filter header. Then… 

2. If the filter is for a beginning and ending date range (e.g.,  Reminder Date), or 

for other date fields such as Admission, Discharge, or Review, choose a date 

by clicking on the calendar icon, or by manually typing a date in. When 

manually typing a date in, be sure to use the format mm/dd/yyyy. 

3. If the filter is for a Dropdown box, choose an option from the dropdown by 

clicking on it. 

4. If the filter is for List of items, single click on an item in the list. In some cases 

you may be able to control-click to select or deselect multiple independent 



 

May 2014 NUMI User Guide 2-7 

items, or shift-click to select a range of items. This will depend on the 

particular field. 

5. If the filter is for a Text Entry field, type the information you wish to search 

for into the text entry field. The format in which you can enter data in these 

fields will depend on the field. 

6. If the filter contains other checkboxes, click on one or more checkboxes. 

7. If the filter contains radio buttons you may select one of the options.  

8. In most cases, at the bottom of the filter bank you will need to click the 

<Find> button to see any changes in the information that is displayed – 

although in some cases the page will be updated immediately. 

 

Note: After performing a search (on the Patient Selection/Worklist), if you click on the <Reset> 

button, your filter selections will be set to their initial default state and when the screen is re-

loaded, the Reminder Date checkbox will once again be selected and display default information. 

For more information about NUMI filters, see Section 5.4. 

2.1.11 Using NUMI Hyperlinks 

NUMI offers a variety of hyperlinks
1
 that will quickly redirect you to other screens and 

information. Hyperlinks can be found in NUMI data displayed in table format. Some tables will 

be closed when the screen first displays, and must be opened (e.g., the Show Reviews button on 

the Patient Stay History screen will open the Reviews table). Here are general instructions for 

using hyperlinks: 

 

1. While viewing a table, click on the hyperlink beside the desired patient or 

information. For example, clicking on this hyperlink would automatically 

take you to the Patient Selection/Worklist.  

2. The link will take you to another location in the NUMI application.  (e.g.,  

clicking on the patient’s name in the Patient Selection/Worklist will take you 

to the Patient Stay History screen). 

3. Depending on the hyperlink, it may perform different functions depending on 

the status of a patient or review, and on your privileges. 

2.1.12 Sorting Information in NUMI Tables 

NUMI offers the ability to sort information in the tables on the application. If the content of the 

page is changed by resetting the page size or clicking the Next, Previous, Last Page or First Page 

hyperlinks, the sort does not need to be re-done. Here are general instructions for using the sort 

feature: 

 

1. Click on an underscored column header in the table (e.g., Patient Name on 

the Patient Selection/Worklist). 

2. The screen will refresh and the information will be sorted in ascending order. 

                                                 
1
 A hyperlink is a reference to a document or object that the reader can directly access by clicking on it. 
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3. Click on the header again to refresh the screen and change the display to 

descending order. 

2.1.13 Using NUMI Buttons 

NUMI displays a series of buttons that, when clicked, will display additional information. Here 

are the different ways in which clicking a button feature works: 

 

1. Takes you to another screen (e.g.,  the Export To Excel button on any of 

the report screens opens the report in the Excel application). 

2. Displays a pop-up window (the Patient Worksheet button on the Patient 

Stay History screen opens a window containing Stay information for a 

patient). 

3. Displays informational text (e.g.,  the Notes icon button   on the 

InterQual Criteria displays read-only InterQual
®

 Notes information). 

4. Expands and collapses fields (e.g.,  the + and – Stay ‘toggle’ buttons on the 

Patient Stay History and Primary Review Summary screens,expand and 

collapse the list of Stay Reasons). 

2.1.13.1 Using NUMI Radio Buttons 

Some NUMI screens contain ‘radio’ buttons. . Here are general instructions for 

using those: 

 

1. Click on the desired radio button to select that option. 

2.1.14 Using NUMI Screen ‘Tabs’ 

Some NUMI screens contain tabs   that, when 

clicked, will take you to other NUMI screens. Certain buttons may be grayed out, depending on 

which screen you are working on. Here are general instructions for using tabs: 

 

1. While on a screen that displays tabs (e.g.,  the Patient Stay History screen), 

click on a tab. 

2. You will be redirected to the screen that the tab corresponds to.  

2.1.15 NUMI Menus 

NUMI provides menus, which are accessible from the major NUMI screens. These menus 

provide access to various features of the NUMI application.  

2.1.15.1 Admin Menu 

The Admin Menu is only available to NUMI Administrator users. Non-administrator users will 

see this menu option on the Graphical User Interface (GUI); however, its dropdown menus will 

be disabled. If Administrator users have problems using this menu or its features, validate that 
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their profile indicates they have the appropriate access privileges. Please see Chapter 6 for more 

information about this menu. 

2.1.15.2 Reports Menu 

The Reports Menu is available to all NUMI users. These reports are generated on-demand. All 

reports generate in Portrait orientation by default, except those marked (L), which generate in 

Landscape orientation. Please see Chapter 12 for more information about this menu. 

2.1.15.3 Tools Menu 

The Tools Menu is accessible to all NUMI users. However, the accessibility of certain options is 

based on individual access privileges. Please see Chapter 11 for more information about this 

menu. 

2.1.15.4 Help Menu 

Online help for NUMI functionality consists of a Help Menu option on the major NUMI screens. 

The only option under this menu is User Guide. Selecting the option opens a new webpage to the 

main Office of Quality Safety and Value (OQSV) web page, where they will have hyperlinked 

access to view the latest version of the NUMI User Guide. Please see Chapter 17 for more 

information about this menu. 

2.1.16 Using Screen ‘Bars’ 

Some NUMI screens contain gold-colored bars  that, when 

clicked, will display or hide the information in the NUMI tables on that screen. Here are general 

instructions for using bars: 

 

1. While on a screen that displays bars (e.g.,  Patient Stay History screen), click 

on a bar. 

2. The corresponding table for that bar will either display or be hidden, 

depending on whether the “Show” or “Hide” bar was selected. 

2.1.16.1 Using Sidebars 

Some screens contain sidebars. The sidebar on the InterQual Criteria in NUMI (as shown in 

Figure 8) is a good example of one. A sidebar is an auxiliary box of information, appearing next 

to the main information on a screen that may contain functional rows or items that can be clicked 

or selected.  
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Figure 8: Sidebar 

2.1.16.2 Using Scrollbars 

Throughout the NUMI application, you will find scrollbars. (Figure 9 shows an image of the 

scrollbar that appears on the right hand side of the InterQual Criteria). A scrollbar is a long 

rectangular area containing a bar that can be dragged to scroll up, down, left or right. Depending 

on the screen, the scrollbar can be horizontal or vertical.   

 

 

Figure 9: Scrollbar 

2.1.17 Printing NUMI Reports 

After generating a report, right-click on the report and the Print option will be displayed in a sub 

menu Click <Print> to print out a hardcopy report on your local printer. Detailed information 

about generating and printing reports can be found in Chapter 12.  Note: information can also be 

printed out from the Utilization Management Review Listing screen. The Print Preview 

button on the Utilization Management Review Listing screen works the same way that it does 

for reports. See Section 11.2.1 for more information. 

2.1.18 Exporting NUMI Reports to an Excel Spreadsheet 

All NUMI reports have an Export to Excel feature. After generating a report request, click the 

<Export to Excel> button to export the report to an Excel spreadsheet format. Use Excel’s 
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print feature to print the spreadsheet out. Detailed information about generating and exporting 

reports can be found in Chapter 12. Note: information can also be exported to Excel from the 

Utilization Management Review Listing screen. The Export to Excel button on the 

Utilization Management Review Listing screen works the same way that it does for reports. See 

Section 11.2.2 for more information. 

 

  While working in NUMI, if you use the BACK button on your browser instead of one 

of the screen tabs (shown in Section 2.1.14) or the Tools menu, you may get an error 

message. Always navigate around NUMI using the tabs or the Tools menu and you will 

avoid error messages and delays. 

2.1.19 Using NUMI Dropdown Boxes 

Some NUMI screens display dropdown boxes that contain selectable options, similar to this 

example:     To choose an option from a dropdown, 

click on the down arrow to display the list of options. Select the desired option by clicking on it.   

2.1.20 Using NUMI Paging Features 

The Patient Selection/Worklist, Dismissed Patient Stays and Utilization Management Review 

Listing screens contain paging features that allow you to navigate thru lists of information in the 

tables. When these screens first open and you use NUMI’s filters (see Section 2.1.10) to search 

for information, the results table will display the first 30 rows of results. You can navigate thru 

each screen of results by selecting the Next, Last Page, Previous and First Page pagination 

hyperlinks. If you wish to see more than 30 rows of results at a time, just type in a different value 

and click the reset page size button. As long as the screen remains open, the system will continue 

to display the number of rows in the result table that you specified. However, once you close the 

screen and reopen it, your search results will once again display the first 30 rows of results. The 

sections below explain how to use each paging feature.  

2.1.20.1 Using the Next and Previous Page Paging Features 

When you open a screen that contains paging features, Next and Last Page hyperlinks will 

display within the table grid. If you are already on the first page, you will not see a Previous link. 

Likewise, if you are already on the last page, you will not see a Next link. (Figure 10 illustrates 

the screen with all paging links displayed).   
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Figure 10: NUMI Paging Hyperlinks 

To use the Next and Previous Page features 

1. From any page but the last page, click the Next hyperlink. 

2. The next page of results will display and a Previous hyperlink will become 

visible at the top and bottom of the table.  

3. Click the Previous hyperlink 

4. The previous page of results will display. 

2.1.20.2 Using the First and Last Page Paging Features 

If you are already on the first page, the Next and Last Page links will display. Likewise, if you 

are already on the last page, the First Page and Previous links will display. 

To use the First Page and Last Page features 

1. From any page but the first page, click the First Page hyperlink. 

2. The first page of results will display. OR 

3. Click the Last Page hyperlink. 

4. The last page of results will display. 

2.1.20.3 Using the Row Results Display Paging Feature  

To specify how many result rows you want to see in the table 

1. Type the number of result rows you want to see in the Page Size field. (Note: 

the default is 30.) 

2. Click the <Reset Page size> button. 

3. The screen will refresh and display the number of rows you specified for each 

page in the table, and the total number of pages in the listing will change 

according to the change size you specified. 
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2.1.21 Adobe Flash Player (for CERME 2012) 

CERME 2012.2 InterQual® criteria are loaded into NUMI. CERME 2012.2 requires the use of a 

Flash Player and expects that your desktop has Flash Player installed. (It is likely that you 

already have Flash Player installed, because it is part of the standard desktop package for VA 

employees. If you are not certain whether you have Flash Player, please contact your local IRM 

representative or your NUMI POC for assistance). If your desktop does not have Flash Player, a 

reminder screen will display when you try to access CERME, as illustrated in Figure 11.  This 

message cannot be disabled, as it is part of the McKesson CERME 2012.2 core package. Just 

click the OK button to close this message and proceed into CERME to complete your review.  

(Flash Player is used for a CERME insurance screen that NUMI does not utilize, so you will be 

able to use CERME).  

 

 

Figure 11: Adobe Flash Player Dialog Box Select 
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3 VISN, Then SITE Screen 

This chapter describes the Select VISN, then Site (NUMI Start) screen. This screen is 

considered the ‘start page’, and is the first of two screens in the login process (Figure 12). This is 

where you will choose a specific VISN and Site. The features of this screen are listed in Table 1. 

 

Table 1: Select VISN, then Site screen features 

FEATURES 

Select VISN 

Select Site 

 

 

Figure 12: Select VISN, then Site 

 

To select VISN and Site information 

1. Click on the Select VISN dropdown. Choose a VISN from the list by clicking 

on it.  NOTE: Depending on your UM role, you may have access to several 

sites.  However, you must always log onto NUMI using your home VISN 

and the facility associated with your VistA Access and Verify Codes. After 

you are logged into NUMI with your home location, you can then select a 

different site. 

2. Click the Select Site dropdown. Choose a Site from the list by clicking on it. 

3. Click the <Submit> button and the National Utilization Management 

Integration (NUMI) screen will display.  

 

  If VISN and/or Site information is not selected from the dropdowns, you will see the 

messages: “Please select a VISN” and/or “Please select your hospital site”. 
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4 National Utilization Management Integration 
(NUMI) - Screen 

This chapter describes the National Utilization Management Integration (NUMI) screen (Figure 

13).  This screen displays a welcome message, and you will be able to provide your VistA 

Access and Verify Codes and login to the NUMI application. The features of this screen are 

listed in Table 2. 

 

Table 2: National Utilization Management Integration (NUMI) features 

FEATURES 

Login to NUMI with VistA Access and Verify Codes 

Update Network Account Name 

Hide / Show Welcome Message 

Switch Login Site 
 

 

 

Figure 13: National Utilization Management Integration (NUMI) System 

4.1.1 Entering Access and Verify Codes 

As with other VistA applications, you must enter a valid Access Code and Verify Code in order 

to login to NUMI. 

 

To enter your Access and Verify Codes and login to NUMI 

1. Type your VistA Access Code into the Access Code field and press the 

<Tab> key on your keyboard. 

2. Type your VistA Verify Code into the Verify Code field. 

Click the <Access NUMI System> button and the Patient Selection/Worklist screen will display 

if your credentials match.  If not, see Section 4.1.2 below. 

 

  If you enter an invalid Access or Verify Code, the messages “You must enter a 

valid access code” or “You must enter a valid verify code” will display. 

 



 

May 2014 NUMI User Guide 4-2 

  If you receive an error message like this one: “This account does not exist in 

NUMI”, ask your local NUMI POC/Administrator to set up a NUMI profile for you. 

 

  The maximum number of login attempts permitted is determined by the local VistA. 

If you exceed the maximum number, VistA will lock you out of the application for 20 

minutes. You may see an error message similar to this: “Unable to login to VistA. The 
error was: Device IP address is locked due to too many invalid signon 

attempts”. After 20 minutes, VistA will clear your login restriction and you can try to login 

again.   

 

Occasionally, after you’ve entered your correct Access and Verify Codes you may see 

an error message similar to the one shown in Figure 14.  If this happens, close down your 

Internet browser and restart the login process. Doing this resets your browser and you will 

then be able to log in successfully. 

 

 

Figure 14: VistA Login Error Message 

4.1.2 How your login credentials are authenticated 

When you login to NUMI, your NUMI credentials will be compared against your Windows 

credentials.  (Note: the purpose of this comparison is to control the Enhanced Reporting 

content - not to authenticate your access to the NUMI application.  For more information about 

Enhanced Reporting, please see Section 12.13).  

 

The system authenticates and tracks users when communication to the system is first established. 

You must prove your identity to the NUMI web site by supplying a valid VistA Access and 

Verify Code combination in order to establish this communication. Rather than passing your 

confidential credentials back and forth with each transaction, the system generates a unique 

"Session ID" (i.e., Windows session credentials) to identify your session as authenticated. 

Subsequent communication between you and the web site will be tagged with the Session ID as 

"proof" of the authenticated session.  

 

For example, when you visit a retailer’s website you want to collect articles in a ‘shopping cart’ 

and then go to the checkout page to place your order. A Session ID enables the system to keep 

track of your cart’s status.  

 

There are 3 possible credential comparison scenarios: 

 

The Login Credentials Match 

If your NUMI login credentials match your Windows credentials, you will be logged in without 

seeing any dialog or pop-up boxes.  
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The Login Credentials are Blank 

If your NUMI login credentials are blank (e.g., new NUMI user), the system will apply the 

current credentials you are using and proceed with logging you in.  

 

The Login Credentials do not match 

When you login to NUMI, if your Windows credentials do not match the credentials saved in 

NUMI, you will see a Security Warning message similar to the one illustrated in Figure 15. 

(One reason for a credential mismatch would be if you logged in to NUMI from someone else’s 

computer). You will be given the opportunity to either update your network account name or 

logout of NUMI and log back in using your own credentials, as described in Section 4.1.3. 
 

 

 

 Figure 15: Login Security Warning 

4.1.3 Updating Your Network Account Name (at Login) 

If you wish to update your network account name 

1. With the Security Warning message displayed, click on the Update My 

Network Account name in NUMI hyperlink. 

2. The system will update your network account name in the NUMI User table. 

This update will not be visible to you. 

3. The Patient Selection/Worklist will display. 

 

If you wish to logout without updating your network account name 

1. With the Security Warning message displayed, click on the Logout 

hyperlink. 
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2. The system will not update your network account name in the NUMI User 

table and you will be logged out. You will then able to login to NUMI as you 

normally would, using your own credentials. 

 

If you wish to continue on without updating your network account name 

1. With the Security Warning message displayed, click on the Click here to 

continue to the Patient Selection/Worklist hyperlink. 

2. The Patient Selection/Worklist will display. 

4.1.4 Hiding / Showing the Welcome Message 

As a convenience, NUMI gives you the option to cosmetically hide the Welcome Message on the 

login screen. 

 

To hide/show the Welcome Message 

1. Click the gold <Click to hide Welcome Message> bar at the top of the 

screen. 

2. The message will be hidden and the text display on the bar will change to 

<Click to view Welcome Message>.   

3. Click it to redisplay the Welcome Message.   

4.1.5 Switching the Login Site 

After you login, NUMI gives you an option to change your VISN and/or Site dropdown 

selections (and view information for other sites that you are permitted to look at), at the click of a 

hyperlink. This feature is handy in a situation where you accidentally chose a VISN or Site 

dropdown item, but meant to choose something else.     

 

To switch to a different Login Site 

1. Click on the Switch Login Site hyperlink on the Select VISN, then Site 

screen.  

2. The screen will be refreshed, and you can choose another VISN and/or Site 

before clicking the <Access NUMI System> button and logging in. 

4.1.6 Session Timeout / Lost Sessions 

Timeout due to Inactivity 

After 15 minutes of inactivity, a dialog box with an audible “beep… beep… beep… beep… 

beep” will display at the top of the screen with a countdown timer set for 5 minutes and the 

message illustrated in Figure 16.  If the OK button is clicked within the 5 minutes, you will be 

returned to the last screen you were on in NUMI. Note: if the OK button is not clicked before the 

5 minutes elapse, the system will log you out of NUMI, but your browser will remain open 
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Figure 16: Session Idle Message 

Lost Session 

When the Hypertext Transfer Protocol (HTTP) session is lost due to a connection issue, high 

load or network issue from Medical Domain Web Services (MDWS), VistA or NUMI, the error 

message displayed in Figure 17 will display.  Please note: this is not a ‘timeout’. This problem is 

due to a dropped connection or high user volume on the system. 

 

 

Figure 17: Lost Session Error Message 

4.2 Application Problem Notification  

VistA will lock your Access and Verify Codes after the maximum number of permitted login 

attempts is exceeded. VistA will automatically unlock your Access and Verify Codes after 20 

minutes and you may try to login again. See Section 4.1.1 for more information. 

 

  While working in NUMI, if you use the BACK button on your browser instead of one 

of the screen tabs (shown in Section 2.1.14) or the Tools menu, you may get an error 

message. Always navigate around NUMI using the tabs or the Tools menu and you will 

avoid error messages and delays. 
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5 Patient Selection/Worklist 

This chapter describes the Patient Selection/Worklist (Figure 19). If you have rights to create 

and conduct primary reviews or are a super user, this is the first screen that will appear after you 

successfully complete the login process. The top section of the screen will show a drop-down list 

of sites to which you have access. This screen is where UM Reviewers will search for patient 

stays, select patients for review, assign and reassign reviewers, and view patient information for 

different sites (if they have permission to visit multiple sites).  The features of this screen are 

listed in Table 3. 

 

When the screen first opens you will see the search filters, but no patient data rows will 

automatically display. You will see instructions for using the filters to obtain search results, as 

shown in Figure 19, and the Date filter will be pre-selected and pre-populated with a 34-day 

default date range. (You may click the <Find> button to display the last 34 days of stays in the 

table, or enter different or additional filtering criteria, then click the <Find> button.) 

5.1 Accessing Patient Information 

5.1.1 General Search Information 

After you select the search criteria and perform a search on the Patient Selection/Worklist, the 

resulting screen will not display the original select criteria controls.  Instead, an unmodifiable 

summary of the search criteria will display.  

 

This summary includes the date and time of the last synchronization with VistA for this site, and 

the date and time of the most recent generation of this worklist. 

 

A button called “Modify Filter” can be used to display the original search criteria controls. After 

the button is clicked, the original search filters are displayed for selecting a new search. 

 

Upon performing a search, the resulting worklist will display one row per patient with at least 

one stay matching the search criteria. Displayed row details will represent the most recent stay 

that meets the search criteria of one or more patient stays, displayed in the format illustrated in 

Figure 20.  Search criteria that are different from the default criteria will remain effective when 

you leave the Patient Selection/Worklist and return to it as long as you remain logged in.    

 

To select a patient for review, click on their hyperlinked name in the Patient Name column.   

 

5.1.2 Cell Tooltips 

Sometimes the information for a given cell in the Patient Selection/Worklist will not entirely fit 

into the cell.  When this happens ellipses (…) will appear in the cell.  Hovering the mouse over 

the cell will show the complete value for the cell. 
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5.2 General Navigation 

 Links: When an active link is selected (e.g.,  a Patient Name hyperlink is clicked) and 

you leave the Patient Selection/Worklist and then return to it, the original sort order will 

be retained and you will be returned to the original page display of the worklist . 

 

 Other Pages in NUMI: When you leave the Patient Selection/Worklist to view another 

screen, link or report (e.g., the Report menu is clicked) and you return to the Patient 

Selection/Worklist, the sort order will be retained on the worklist and you will be 

returned to the original page displayed in the worklist. Additionally, the sort order will be 

applied when searching on new criteria. After navigating to different pages in the 

worklist, when you return to the first page (i.e., Page 1) the sort order will be retained and 

displayed. If other users discharge patients in the interim between visits to the Patient 

Selection/Worklist, this will affect your existing search results and cause a re-sort which 

may invalidate the current page number.  If this is the case, the page number previously 

shown will be set to the final page in the Patient Selection/Worklist. If the user re-

searches with new criteria, the page number will be set to the first page. 

 

 Pagination: When the filter selections are made and displayed on the worklist and 

multiple pages exist, you will still be able to click on the First Page, Next, Previous and 

Last Page hyperlinks to navigate through the results.  

 

Depending on how refined your search is it may take a few seconds for the bottom part of this 

screen to load, showing the patient stays for the site. Please be patient to allow this screen to load 

completely before changing sites or clicking on filters.   

 

The Patient Selection/Worklist displays an “X” column, and clicking any boxes in the column 

will flag those stays for dismissal. The Patient Selection/Worklist includes functionality that lets 

you distinguish dismissed stays for patients in non-reviewable specialties. Please see Section 

5.5.1 for more information. 

 

The Patient Selection/Worklist also includes the dismissal and review assignment controls 

available at the top and bottom of the worklist.  

IMPORTANT: Each row in the Patient Selection/Worklist represents a patient/admission. The 

patient stay row will have several information fields including: Patient Name, SSN, Admitting 

Diagnosis, Reason Code, Reason Description, Criteria Subset, Episode Day of Care, Next 

Review Date, Status, admit date, discharge date, date of last review, whether that review met 

criteria, and reviewer. 
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To make it easier to see the individual rows in the table, the background of each row alternates in 

color between white and shaded. The table will also show you last Specialty, Ward and 

Attending for each patient, taken from the patient stay record. 

 

5.2.1 Information Feeds from VistA 

NUMI obtains Admissions, Ward transfers, and Discharge movements from VistA on an hourly 

basis during the daytime (i.e., at the top of each hour) and resynchronizes other movements at 

Midnight (local time) each night. Therefore, it is possible that some stays may not be in NUMI 

yet, or have not been updated yet. Reviewers may also see stays that have Transfers and 

Discharges, even though they have not had a chance to do an Admission review yet. After the 

midnight synchronizer information feed occurs, most stays that were dismissed the previous day 

will not display again in the worklist. Certain stays can be undismissed using the Dismissed 

Patient Stays screen. 

 

Stays will be updated by the synchronizer when it detects that a stay has changed. This includes 

stays that have been dismissed or that have had continuing stay reminders set by the reviewer. 

(The purpose of this is to alert a reviewer that there has been a movement. Whether or not it is of 

sufficient clinical significance to warrant a review before the scheduled reminder is at the 

discretion of the reviewer). For situations where a patient is not in the NUMI database and needs 

to be loaded manually, please see Section 11.6, which describes how to use the Manual VistA 

Synchronization feature to manually synchronize information from VistA into the NUMI 

Patient Selection/Worklist. 

 

The NUMI system detects: 

 

 Case 1: Stays deleted in VistA but still in NUMI   
 

When a stay is invalidated - meaning it is not in VistA but is still in NUMI - and the stay is 

selected for review, the system will move it to the Dismissed Patient Stays screen and the 

Patient Stay Administration screen.  If you select the stay from the Dismissed Patient Stays 

screen it will not be restored. It will only be restored if the stay was an unintentional dismissal by 

a NUMI reviewer. 
 

For the Case 1 scenario, this is the message that will display when a user selects a stay that has 

been deleted in VistA but is still in NUMI: “The patient stay you have selected appears 
to have been deleted from VistA.  Stay ID: <stay number>. This patient stay 

has been moved to the Patient Stay Administration screen”. 
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 Case 2: Stays not retrieved from VistA for one of the 3 reasons below. Should you 

get one of these messages, you may need to contact your local IRM to find out if 

there is a problem with VistA connectivity or local network issues. 

 

 MDWS timed out before it returned the stays from VistA 

 MDWS service is unavailable 

 MDWS could not connect to VistA because the VistA node is unavailable 

 

For the Case 2 scenario, this is the message that will display if MDWS times out before 

returning stays from VistA:  “Stay <stay number> for patient <patient name> cannot 
be retrieved from VistA as the server is busy at this time. Please try 

again”. 

 

For the Case 2 scenario, this is the message that will display if the MDWS service is unavailable:  
“An error has occurred. The MDWS service is unavailable at this time. The 

error has been recorded and tech support has been notified. We apologize for 

the inconvenience and will fix the error as soon as possible”.  

 

For the Case 2 scenario, this is the message that will display if the VistA node is unavailable:  
“An error has occurred. The <site name> VistA node is unavailable at this 

time. The error has been recorded and tech support has been notified. We 

apologize for the inconvenience and will fix the error as soon as possible”.  

 

  While working on the screen, you may see a message in red text advising there was a 

problem loading the webpage (Figure 18). Refreshing your browser will reload the 

webpage and display the NUMI screen.    

 

 

Figure 18: Page load error message 

 

Table 3: Patient Selection/Worklist Features 

FEATURES 

Include Observation Stays 

Use Filters and Paging Features 

Find Patients By Category 

Dismiss a Reminder for a Patient Stay 

Select a Patient for Review 

View Patient Information for Different Sites 

Assign/Reassign Reviewers to Patient Stays 

Distinguish Stay Dismissals 
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Figure 19: Patient Selection/Worklist with 34-day default 

 

 

Figure 20: Patient Selection/Worklist with search results 

5.3 Include Observations  

Stays or reviews can be listed with or without Observation stays or reviews depending on 

whether you select the “Include Observations” checkbox. (The default for a new user is for the 

"Include Observations" checkbox to not be selected. The OBS checkbox will remember the last 

setting even after logging out and back into NUMI. If at any time you choose to include 

observations, this selection will be your new default the next time you log in. (See Figure 21.) 



 

May 2014 NUMI User Guide 5-6 

 

Figure 21: Patient Selection/Worklist with Include Observations checkbox 

If you select the “Include Observations” checkbox, any Observation stays or reviews will always 

precede any non-observation reviews or stays, regardless of other sorting selections you make.  

Once selected, the Include Observations checkbox will remain effective when you leave the 

Patient Selection/Worklist or other screens and return to them, and when you log back in.    

The “Include Observations” checkbox can be found on the following screens: 

 

• Patient Select Screen 

• Review Select Screen 

• Dismissed Stay Patient Select Screen 

• Free Text Search 

• Patient Stay Admin 

 

Certain reports also offer the “Include Observations” checkbox.  This is noted where applicable.  

See Section 12 for details. Note that subtotals will be captured on reports for Observation 

stays/reviews.  These will be counted in a sub total number (Subtotal No) whereas “Grand Total” 

will include all stays/reviews. 

5.4 Using Filters and Paging Features 

NUMI offers filters and paging features (see Section 2.1.20) so you can navigate thru the list of 

patients quickly and conveniently.  Additionally, all columns in the list can be sorted in 

ascending or descending order by clicking on the column headers.  

 

  The filters on NUMI screens are additive. This means you can select several filters in 

order to get very specific search results. After performing a search, if you click on the 

<Reset> button, your filter selections will be cleared and when the screen is re-loaded the 

Reminder Date checkbox selected and default information redisplayed. While additive 

filters can be helpful if you need to, for example, look at a specific set of Reminder Dates 

for a specific Ward in a specific Date range, it is possible to create such precise (and even 

mutually exclusive) criteria that no records will be found in NUMI. This is something to be 

aware of when using multiple filters. For more information about using NUMI filters, 

please see Section 2.1.10. 
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5.4.1 Finding Patients By Patient Category 

You can specify which types of patients will be displayed in your search by selecting the 

following radio button options from the Patient Category filter:  

 Patients Pending a Review: Includes patients with undismissed stays that still have an un-

reviewed admission or bed day of care 

 Patients Currently in Beds: Include patients with dismissed and undismissed stays, but 

not discharged patients 

 Patients with Undismissed Stays: Includes patients with undismissed stays 

 

 

Figure 22: Patient Category Filter 

5.4.2 Finding Patients Using the Reminder Date Filter 

As mentioned in the Patient Selection/Worklist introduction, when the Patient 

Selection/Worklist first opens the Reminder Date checkbox will be pre-selected, as will the Start 

Date and End Date checkboxes, and a 34 day range will be pre-populated, as illustrated in Figure 

19. The default Start and End dates will always appear as the last 34 days, but each time they 

appear on the screen, you can edit them as desired.  (See Section 8.9 for more information about 

Review Reminder Dates). Use this filter to search for patients based on review reminder dates.  

 

To find patients by reminder date  

1. Click on the Reminder Date checkbox to activate the filter, if it is not already 

selected (Figure 23).   

2. Click on the Start Date checkbox. 

3. Click in the Start Date textbox and type the desired Start Date in 

mm/dd/yyyy format, or scroll through the calendar and click the desired Start 

Date in the calendar.  

4. Click on the End Date checkbox. 

5. Click in the End Date textbox and type the desired End Date in mm/dd/yyyy 

format, or scroll through the calendar and click the desired End Date in the 

calendar. 

6. Click the <Find> button. A list of patients for the date range you specified 

will display. The results will include all movement types (e.g.,  Admissions, 

Discharges, etc.). 
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Figure 23: Reminder Date filter 

5.4.3 Filtering by Reviewer 

When the reviewer checkbox is selected, the Patient Selection/Worklist will populate the 

reviewer filter with the current user’s login name in the Reviewer drop-down section of the 

screen. You can also use this filter to search for patients by another specific reviewer name, by 

‘all’ reviewers, or by reviews that do not have a reviewer assigned to them. 

 

To filter by Reviewer 

1. Click on the Reviewer checkbox to activate the filter.  

2. Select the defaulted reviewer name and click the <Find> button. OR 

3. Select another reviewer in the dropdown by clicking on their name, and click 

<Find>.  OR 

4. Click on <All> in the dropdown (Figure 24) and then <Find>, to view stays 

that have been assigned to all reviewers.  

 

 

 
 

Figure 24: Reviewer filter with Unassigned option selected 

 

  To select multiple reviewer dropdown options, click on the first option, then press and 

hold the Ctrl key down on your keyboard and click on the other options you are interested 

in. You may also press and hold the Shift key down and select a block of options. 

5.4.4 Finding Patients Using the Ward Filter 

Use this filter (Figure 25) to search for patients by specific Ward location. 
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Figure 25: Ward filter 

To find patients by single Ward 

1. Click the Ward checkbox to activate the filter. 

2. Click on the desired Ward. 

3. Click the <Find> button. 

To find patients by multiple Wards 

1. Click the Ward checkbox to activate the filter. 

2. Click on the first Ward. Press and hold the <Ctrl> key down on your 

keyboard and click on the other Wards you are interested in. You may also 

press and hold the <Shift> key down and select a block of Wards, or click 

<All> to choose all Wards. 

3. Click the <Find> button. 

 

  There may be instances where you may expect to see a particular ward in the Ward 

dropdown, but it does not display. Ward lists are populated as movements for those wards 

occur. For example, for a patient that requires a ward not listed in the dropdown, you can 

use the Manual VistA Synchronization feature (see Section 11.6 for more information) to 

search for a patient that you know is in a particular ward. Once their information has been 

synchronized and pulled into NUMI, that ward will display in the Wards dropdown.  

5.4.5 Filtering by Service or Treating Specialty 

Use this filter to search for patients by a particular Service or Treating Specialty, or a 

combination of both (e.g., Service = Medicine and Treating Specialty = NHCU [ECU]). You 

may also search for patients that have no specified Treating Specialty. 

 

To filter by Service or Treating Specialty 

1. Click on the Treating Specialty and Service checkbox to activate the filter  

2. Select options from the Treating Specialty window by clicking on them, 

then click the <Find> button.  OR 

3. Click the <All> option, then <Find>,  to search by all Treating Specialties). 

4. Select options from the Service dropdown by clicking on them. 

5. Click the <Find> button. 
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  To select multiple specialty dropdown options, click on the first option, then press and 

hold the Ctrl key down on your keyboard and click on the other options you are interested 

in. You may also press and hold the Shift key down and select a block of options. 

 

  If you select filters that are contradictory, it could result in partial or zero results found.  For 

example, if you choose a Psychiatry Service and a General Surgery Treating Specialty, you will 

probably not get any results back.  So, to filter by a specific Service, select the service but leave 

the Treating Specialty set to “All”.  Or, if you want to filter by a specific Treating Specialty only, 

select the specialty but leave the Service filter set to “All”.   

5.4.6 Filtering by Movement 

Use this filter (Figure 26) to search for patients by Movement type. This refers to any movement 

that the patient has undergone while at the hospital and includes Admissions, Continued Stays, 

Discharges and Transfers. 

 

To filter by Movement Type 

1. Click on the Movement checkbox to activate the filter on the Patient 

Selection/Worklist). 

2. Click on the desired Movement checkboxes. 

3. Click the <Find> button. 

 

 

Figure 26: Movement filter 

 

  If you click the Movement filter but you don’t select any movement types, NUMI will 

not retrieve anything because it won’t know which types of movements to include when it 

does the search. 

 

  Note: If you wish to find missing hospital admission review records (i.e.,  stays with no 

reviews) you can either sort by the Date of Last Review column, or search by selecting the 

“Unassigned” option in the Reviewer filter dropdown".  
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5.4.7 Finding Patients Using the Patient Search Filter 

The Patient Search selection filter is illustrated in Figure 27. NUMI uses VistA’s search 

capabilities to look for a patient. A list of possible matches will be shown in the lower window. 

The reviewer selects one of those patients and NUMI searches its database to see if there are any 

stays for that site/selection combination. Use this filter to search for patients by Name or Social 

Security Number.  

 

  Because twins and other patients can have the same or similar names, it is strongly 

recommended that you search for patients using their full Social Security Number. This 

will confirm the identity of the patient.  

 

 

Figure 27: Patient Search filter 

To find patients by Full Social Security Number (SSN) 

1. Click the Patient Search checkbox to activate the filter. 

2. Type the patient’s full SSN in the Find Patient field (in xxx-xx-xxxx OR 

xxxxxxxxx format). 

3. Click the <Find Patient> button. 

4. When the patient whose SSN matches your search criteria displays in the 

result window, click on the patient’s name and the stays stored in NUMI for 

that patient will be displayed in the table, unless they have been dismissed. 

Dismissed stays can be found on the Dismissed Patient Stays screen. (See 

Section 11.3 for more information). 

 

To find patients by Last Name 

1. Click the Patient Search checkbox to activate the filter. 

2. Type the patient’s Last Name in the Find Patient field. (You can further 

refine your search by entering the patient’s First and Last Name).  

3. Click the <Find Patient> button. 

4. When the list of patients displays in the result window, click on a patient 

name and their information will be populated in the table on the screen.  

 

To find patients by First Letter of Last Name and Last four digits of the patient SSN 

1. Click the Patient Search checkbox to activate the filter. 
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2. Type the first initial of the patient’s last name, followed by the last 4 digits of 

their SSN (e.g.,  W0000) in the Find Patient field. 

3. Click the <Find Patient> button and the patient information will display in 

a table. Finding patients this way may initially bring back a list of names 

because this lookup method is not necessarily unique. 

5.4.8 Reset Button 

After obtaining search results on the Patient Selection/Worklist, when you click on the Reset 

button the system will restore all fields to their default values.  The fields and default values are: 

 

 Reminder Date – Checkbox selected and defaults with a 34-day range   

 Reviewer – Checkbox not selected and will display the logged in user’s name   

 Ward – Checkbox not selected and defaults to All 

 Treating Specialty and Service – Checkbox not selected and defaults to All 

 Movement – Checkbox not selected and no default values display 

 Patient Search – Checkbox not selected and no default values display 

5.4.9 Patient Status Column 

In cases where the most recent stay for a patient is a non-observation stay, the Status column on 

the right side of the Patient Selection/Worklist may provide some combination of the following: 

 

 Green Circle: A green circle icon appears if the patient is up-to-date on reviews and no 

new movement information has been detected since the last review. 

 Blue Triangle: A blue triangle icon appears if the patient is behind on reviews (i.e., there 

are bed days of care for which there are no saved reviews), or a review has been 

performed on the patient’s discharge date. 

 Red Square: A red square appears if the patient has more than one undismissed stay. 

 

When the Status column is sorted, patients with a recent non-observation stay will show the 

following descending order (reversed for ascending order) as applicable: 

 

 Blue Triangle 

 Blue Triangle and Red Square 

 Green Circle and Red Square 

 Green Circle 

 

Patients that have not been discharged and have a 48 hour or longer stay since admission will 

display a red “48+” indicator. 

 

For observation patients, the Status column will contain the total time in hours and minutes that 

the patient has been on observation status. ("Observation patients” refers to patients whose most 

recent stay meets the search criteria of an observation stay.) 
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The total time on observation will be calculated by subtracting the current date and time from the 

admission date and time.  If the patient has been discharged, the total time will reflect the 

admission time less the discharge time. The Total Time in the Status column will increment 

every sixty seconds without refreshing the screen for patients that have not been discharged. For 

patients that have not been discharged with a Total Time exceeding eighteen hours, the time will 

be displayed in red, providing a visual means of identifying patients whose observation period is 

winding down.  

 

5.4.10 Days Since Admission 

The number of days since admission for a particular patient will be displayed as a tooltip when 

hovering over the Admit Date or the Discharge Date (D/C Date) columns for that patient’s row. 

This will be the day since admission for the most recent stay that meets the search criteria. 

(There may be a more recent admission that does not meet the search criteria, because that stay 

may have been dismissed. Days Since Admission will not be in reference to that admission.) 

Note however that if the patient is known to have been discharged, either from a patient 

movement or from a dismissal type, the tooltip shall read "Days Since Admission: Discharged." 

5.5 Dismissing a Patient Stay  

Use this feature to dismiss a patient stay movement. When you dismiss a stay from the Patient 

Selection/Worklist, it will move to the Dismissed Patient Stays screen under the Tools menu. 

(This screen is described in more detail in Section 11.3). It is important to note that only the 

selected stay movement will be dismissed, however, the entry of a new movement or discharge 

in VistA will refresh the patient’s entry again on the Patient Selection/Worklist with updated 

information. The system will now let you distinguish patient stay dismissal types.  Having this 

ability will assist with reporting and identifying patients in non-reviewable specialties. This is 

explained in Section 5.5.1.  

 

The Patient Selection/Worklist is patient-based; therefore, a dismissal of a given row in the 

Worklist will result in the dismissal of the stay that is currently being represented by that patient 

in the Worklist. (i.e., the most recent stay that meets the current search criteria.) If the stay 

represented by the patient is already dismissed, then the dismissal will have no effect, except 

potentially informing the user via dialog box. 

 

This action is also available on Patient History Stays. See Section 6.1.6.  

 

NUMI / Veterans Integrated Service Network (VISN) Support Services Center 

 (VSSC) Processes 

 

NUMI will automatically place stays into the Dismissal Admission Screen based on the 

following two conditions: 

1. The Stay has an initial treating specialty that is configured in the 

Dismissal Administrative Screen. 
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2. The initial treating specialty is not listed at all in the Dismissal 

Administrative Screen, but contains one of the following character 

patterns: ‘%DOM%’, ‘%NH%’, ‘%OUTPATIENT%’, ‘%REHAB%’, 

Representing the treating specialties categories of DOMICILIARY, 

NURSING HOME, OUTPATIENT, and REHAB and their derivatives. 

 

(Example: “NURSING HOME” Would cover treating specialties NHCU, NH Hospice, NH Long 

Term Dementia Care, NH Long Stay Maintenance Care, etc.) 

 

 

 

NUMI shall automatically undismiss a stay if movement into a reviewable treating specialty (as 

determined by the Dismissal Administrative Screen) is detected. Subsequent moves into auto-

dismissible treating specialties after the initial treatment specialty will not result in an auto-

dismissal. 

 

This process happens whenever a new stay is synchronized with VistA.  

 

Scenario #1: 

A VistA synchronization runs on Tuesday at 4:30am Eastern Time (ET): Patient was admitted to 

the Rehab ward Tuesday at 12:30am ET – if any NUMI users are on the system Tuesday 

between 12:30am ET and 4:30am ET they will not see the patient stay on the Patient 

Selection/Worklist until the VistA synchronization runs. NUMI users who do not log in until 

after 4:30am ET on Tuesday will never see the patient stay on the Patient Selection/Worklist.  

 

Scenario #2: 

A VistA synchronization runs on Tuesday at 4:30am ET. A patient is admitted to the Rehab ward 

Tuesday at 7:00am ET.  Users will not see the patient on the Patient Selection/Worklist until 

4:30am ET Wednesday  

 

VSSC receives NUMI data and does its own additional screening. VSSC does a daily update at 

5:00am ET and reports should be refreshed by 9:30am ET. Users accessing VSSC reports will 

not see the data from the previous day until after 9:30am ET. (The date through which the report 

contains NUMI Review data is noted on the report header). As the NUMI data is received by 

VSSC, VSSC does additional screening: 

 

 Patients with acute admission but no discharge or movement in 10 days (these are 

excluded as potentially invalid admissions) 

 Stays that are less than 12 hours 

 

A data management process flow for the UM Review Process for NUMI / VSSC is illustrated in 

Figure 28.  
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Figure 28: Data Management for UM Review Process - NUMI / VSSC 

Any reviewer can dismiss a patient from the Patient Selection/Worklist There are several reasons 

that you may wish to dismiss a patient stay: 

 

 A patient stay is in a treating specialty that does not require review and 

automatic dismissal hasn’t been configured to automatically dismiss the 

stay.  (It is important to note that the nightly screening job does not screen 

out stays where the treating specialty has changed). 

 A patient has been discharged and has all reviews for their stay entered in 

NUMI. 

 A patient is not going to be reviewed in NUMI. Perhaps you are not 

reviewing 100% of patients yet, and the patient is not in your review 

sample. 
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 A patient’s admission was cancelled (invalidated) in VistA.  For example, 

perhaps a patient was admitted to acute care. The actual stay was very 

short, and the written admission orders are cancelled and the stay is 

reclassified in VistA.  When the reviewer selects the patient stay for 

review, they would see a message indicating that the stay for the patient 

cannot be retrieved because it may be invalid. (This is not an error, but an 

occurrence in clinical decision making with change of status of a patient). 

Note: It is advisable to check CPRS and/or VistA to confirm that a stay 

has changed or has been deleted because the invalid stay message can 

appear if NUMI cannot connect to VistA and find the stay, even if it is still 

there. It may be important to compare the exact date/timestamps of the 

patient movements to determine if NUMI matches VistA, or if something 

was changed in VistA. 

 

  Each evening, Treating Specialties that are not reviewable in NUMI will automatically 

be marked “inactive” and moved to the Dismissed Patient Stays screen after the 

information is sent to NUMI from VistA. (“Inactivated” stays will not appear on the Patient 

Selection/Worklist unless a review is performed on them).  To identify stays that are not 

reviewable, the system compares the Treating Specialty descriptions to the descriptions in 

the Dismissal Administrative settings or if its initial treating specialty is not listed at all in the 

Dismissal Administrative Screen, but contains one of the following character patterns: 

‘%DOM%’, ‘%NH%’, ‘%OUTPATIENT%’, ‘%REHAB%’. The system then sets the stays to 

‘dismissed’ and moves them to the Dismissed Patient Stays screen. This is a scheduled job 

that will run daily. As the synchronizer runs throughout the day, there is a chance for 

additional non-reviewable specialties to appear in NUMI. 

 

You can generate a report showing all patient stays that have been dismissed. (This report is also 

discussed in Section 11.3).  

 

If you dismiss a patient stay in error, you can retrieve that patient and get them to reappear on the 

Patient Selection/Worklist screen by going to the Dismissed Patient Stays screen, locating the 

patient stay, and performing a review.  

5.5.1 Dismissing/Distinguishing Stays 

To dismiss / distinguish a stay 

1. Perform a search for patients using the desired filters. 

2. When the results display, the Dismiss Type dropdown and Dismiss Stays button are 

disabled (Figure 29). After selecting at least one stay checkbox on the screen, the Dismiss 

Type dropdown will be enabled. After choosing an option from the Dismiss Type 

dropdown, the Dismiss Stays button will be enabled. 

3. Click the checkbox in the X column in the far left hand column beside the name of the 

patient stay you wish to dismiss, as illustrated in Figure 30.  (Note: if you hover your 

mouse over the X this tool tip will display: “Use the checkboxes to select stays 

to be dismissed”). 
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4. Click on the Dismiss Type dropdown and select an option by clicking on it. You may 

choose Dismiss Non Reviewable Treating Specialty, Dismiss No Further 

Reviews, or Patient Discharged, no further reviews needed. (If you select 

multiple checkboxes, whatever Dismiss Type dropdown option you choose will be 

applied to all checked stays. If you wish to categorize the stays individually, select a 

single checkbox and then choose the desired Dismiss Type option). 

5. Click on the <Dismiss Stays> button next to the dropdown. If you hover your mouse 

over the Dismiss Stays button, this tool tip will display: “Click this button to 

dismiss selected stays with the selected Dismiss Type”.  

6. The stay you chose will be dismissed and moved to the Dismissed Patient Stays screen 

with the reason you selected.  

 

  If you click the Dismiss Stay button without selecting an option from the dropdown 

first you will see a message in red text advising you to select a Dismiss Type.  (Figure 32) 

 

 
Figure 29: Dismiss Type dropdown / Dismiss Stays button 

To change the Dismiss Type 

If you select an option from the Dismiss Type dropdown (Section 3.2.1, Step 6) and dismiss the 

stay, and you wish to go back and change the dismiss type to something else, you can do that by 

following these steps.  

 

1. Navigate to the Dismissed Patient Stays screen. 

2. Click the hyperlinked patient name for the stay you wish to make the change to. 

3. Perform a review on the patient. 

4. Navigate to the Patient Selection/Worklist screen. 

5. Perform a search for the patient (Figure 31). 

6. When the patient displays in the results, click the “x” checkbox beside their name. 

7. Click on the Dismiss Type dropdown and select the new value. 

8. Click the <Dismiss Stays> button. 

9. The stay will be dismissed with the new Dismiss Type value. 

 

 

Figure 30: Selected Dismiss Stay option 
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Figure 31: Enabled Dismiss Type and Dismiss Stays features 

 

 
Figure 32: Select Dismiss Type advisory message 

 Only a checked patient stay row is dismissed. It will reappear if there is another 

movement for the patient or a new hospital admission, to make UM reviewers aware of new 

admissions and continued stays requiring reviews.    

5.6 Selecting Patients for Review 

5.6.1 Selecting a Patient from the Patient Movements List 

Use this feature to select a patient stay to enter a review. 

 

To select a patient movement for review 

1. Conduct a search for patients using the desired filters.  

2. When the results display, click on a hyperlinked name in the Patient Name 

column in the worklist. ( 

3. The Patient Stay History screen will display (Figure 38).  

 

  When search results display on the Utilization Management Review Listing page, 

locked reviews will display a blue Patient Name hyperlink, while reviews that have been 

unlocked for editing will display a red Patient Name hyperlink. If a locked review is 

unlocked for editing, the blue link will turn red. Similarly, if a review that was unlocked for 

editing is save/locked back to the database, the red link will turn blue.  Figure 33 depicts 

these colorized links: 
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Figure 33: Utilization Management Review Listing Patient Selection/Worklist colorized hyperlinks 

  If you select a stay and the record no longer exists in VistA, the stay will be 

automatically  invalidated.  A dialogue box will open and display the message: “The patient 

stay you have selected appears to have been deleted from VistA. Stay ID: <stay id>. This 

patient stay has been moved to the Patient Stay Administration screen.” Click the <OK> 

button to dismiss the dialogue. This warning may occur because an invalid patient 

admission was entered into VistA, and the record was deleted from the hospital database – 

but not before the NUMI synchronizer came in and read the information. See Section 5.2.1 

for more information about admission feeds from VistA to NUMI and Section 11.7 for 

more information about reviews that are in NUMI but the associated stay can no longer be 

found in VistA. 

 

  When a patient is selected for review, (depending on reminder dates or dismissals and 

the filters used), the name will remain in the patient stay list on the Patient 

Selection/Worklist and you will be able to perform a second review right away, if you wish. 

5.6.2 Deceased Patients 

A review may be performed for a now-deceased patient for the purpose of documenting 

information related to their final stay in the hospital. If you select a deceased patient from the 

movement list, this message will display: “Warning – Patient is Deceased! Warning! 

This patient is deceased as of mm/dd/yyyy. Do you wish to continue?”, along with 

<Continue> and <Cancel> buttons. Click the <Continue> button to proceed.  After all reviews 

are entered on deceased patients, don’t forget to dismiss their final hospital stay from the Patient 

Selection/Worklist. 

5.6.3 Sensitive Patients 

Sensitive patient records will display #### in the SSN column. (Note: throughout NUMI, except 



 

May 2014 NUMI User Guide 5-20 

on the Patient Stay History screen, if you know a sensitive patient’s SSN you can still search for 

them by partial or full SSN). If you are on the Utilization Management Review Listing option 

and select a Sensitive patient review that has been locked to the database (indicated by a blue 

hyperlink), you will see the pop-up in Figure 34: 

 

 

Figure 34: Sensitive Patient Warning for unlocked review 

 Once you select the “Ok” button, a Sensitive Patient Bulletin will be sent to the 

Information Security Officer at your site for justification. 

 

5.7 Viewing Patient Information for Different Sites 

You will be able to use this feature if you have permission to view patient information for 

different sites. Please note that you may only view patient information for one site at a time.  

5.7.1 Switching to a Different Site 

To select a different site 

1. Click the Current Lookup Site dropdown (Figure 35) 

2. Select a site by clicking on it. 

3. Click the <Go> button to view patient information for that site. 

 

 

Figure 35: Current Lookup Site dropdown 

 

  You can switch to a site where you do not have a particular set of permissions and you 

can still navigate to the desired web page, but you will not be able to see any patient data. 

For example: if you get access to a site where you do not have Primary Review rights and 

you navigate to the Patient Selection/Worklist you will not see patient data there. 
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5.8 Assigning and Reassigning Reviewers to Patient Stays 

When you select a stay from the Patient Reviews screen and complete a review on that patient, 

NUMI will automatically assign this stay to you. However, NUMI gives you the flexibility to 

manually assign and reassign stays to yourself or to others, as described in Section 5.8.1. 

5.8.1 Assigning/Reassigning a Reviewer 

To assign a reviewer to a patient stay 

1. Conduct a search for patients using the desired filters. 

2. Click on the Assign Reviewer dropdown for each patient stay that you wish 

to assign a reviewer to. 

3. Select a reviewer from each dropdown by clicking on their name (Figure 36).  

4. Click the <Assign Reviewers> button. If you hover your mouse over the 

<Assign Reviewers> button a tooltip will display (Figure 37).  

5. The review will be assigned and the reviewer you selected will see the 

patient information in their worklist.  

 

To reassign a reviewer for a patient stay 

1. Click on the Assign Reviewer dropdown for a patient that has already been 

assigned to a reviewer. 

2. Select another reviewer from the list by clicking on their name. 

3. Click the <Assign Reviewers> button, The review will be reassigned and 

the name of the new reviewer you selected will display in the table.  

 

 

Figure 36: Assign Reviewer dropdown illustration 

 

 

Figure 37: Assign Reviewers button with tooltip 

  If you complete a review on a stay, you become the assigned reviewer regardless of 

whether or not the review was previously assigned to someone else. 
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6 Patient Stay History 

This chapter describes the Patient Stay History screen (Figure 38). The Patient Stay History 

screen displays information from VistA once you select a stay from the Patient 

Selection/Worklist.  Patient Stay History is related to the most recent status of a patient’s stay in 

the hospital. Any reviewer can view prior movements and reviews for the stay, print out a 

worksheet for the patient stay for use when out on rounds, and begin a review by clicking a 

hyperlink, and copy an existing review. Upon initial display, the CERME and Primary Review 

buttons are grayed out. A list box displays a list of all known stays for the selected patient in 

reverse chronological order. 

 

The Patient Stay History screen contains a Patient Stays list and a Stay Movements grid. The 

Patient Stays list contains a column for the Stay ID, which is the internal NUMI database ID for 

the patient stay record and is also shown in the Selected Stay field on the screen. The Stay 

Movements grid contains a column for the Movement ID, which is an internal Vista ID for stay 

movements associated with the patient stay record in NUMI. The Movement ID is synonymous 

with the Checkin ID which is mentioned elsewhere in this guide.  So, to recap, the Stay ID is the 

internal NUMI database ID for the patient stay record, the Movement ID and Checkin ID are 

synonymous and are the internal Vista ID for the stay movements that are associated with the 

patient stay record. 

 

The most recent undismissed stay is selected by default, and the information in the ‘Selected 

Stay Information’ Panel on the screen is set based upon that stay.  Upon selecting a new stay in 

the Stay List, the information in the ‘Selected Stay Information’ Panel on the Stay History screen 

is updated to reflect the information for the newly selected stay. 

Details from the Patient Stay History Screen include:  

 

 Admitting Physician: The Admitting Physician details are derived from the information 

entered by a reviewer on the Primary Review Screen, as described in Section 8. 

 Admission Sources: The Admission Source details are derived from information entered 

by a reviewer on the Primary Review Screen, as described in Section 8.12. 

 

  If NUMI is unable to connect to VistA to obtain information associated with a new 

stay, the following error message, “NUMI cannot access VistA at <facility name>. If 
you can access VistA through CPRS, please contact the National Service Desk. 

If you cannot access VistA or CPRS, then please wait to use this feature in 

NUMI until VistA at <facility name> comes back online.” will display. 

 

  If NUMI’s connection to VistA does not quickly return data upon selecting a new stay, 

the following error message “NUMI is requesting movement records from VistA.” 

will display and remain there until data is returned from VistA or an actual timeout 

occurs. 
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  If NUMI finds that a given stay is not reflected in VistA, the following error message 

“This stay cannot be found in VistA. Do you want to invalidate the stay?” will 

display.  See section 6.1.12 Invalidating a Patient Stay for more information. 

 

The features on this screen are listed in Table 4.  
 

Table 4: Patient Stay History Features 

FEATURES 

Show / Hide Reviews Table  

Dismiss a Patient Stay 

Select a Review from the Reviews Table 

Select Review links from Movement History Table 

View Patient Insurance Information 

Print out a Patient Worksheet 
 

 

 

Figure 38: Patient Stay History  
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6.1.1 Patient Stay List 

All patient stays are displayed in the Patient Stay List in the upper left hand portion of the screen. 

The most recent undismissed stay is always displayed first in the list and is the stay upon which 

the “Selected Stay Information” and “Reviews for Selected Stays” lists are based. Selecting a 

different Patient stay will re-populate the screen with new data for that newly selected stay. 

6.1.2 Currently Selected Stay Information 

The “Selected Stay Information” list includes most patient information for the currently selected 

patient stay. 

6.1.3 Reviews for Currently Selected Stays List 

The reviews for selected stays list is also based on the currently selected patient stay. It displays 

all reviewable dates for the selected patient stay. In addition, a hyperlink next to each date allows 

the user to conduct a review or view an existing review for that date. 

6.1.4 Table of Stay Movements and Table of Reviews 

The Stay Movements table is displayed when the Patient Stay History screen first opens. This 

table cannot be hidden. The Reviews table, however, is hidden when the screen first opens. 

Instructions for displaying that table are described in Section 6.1.5.  

6.1.5 Showing and Hiding the Table of Reviews for a Patient 

1. Click the gold colored <Show Reviews> bar (depicted in Figure 39) to 

display the table containing the patient’s reviews since they were admitted. 

(Figure 42) While the table is open, the text on the bar will display <Hide 

Reviews>. (For more information about NUMI bars, please see Section 

2.1.16). 
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Figure 39: Patient Stay History screen tabs and buttons 

6.1.6 Dismiss a Patient Stay 

Patient stays can be dismissed from the Patient Stay History. 

 

To dismiss a patient stay: 

 

1. Select the stay you wish to dismiss. 

2. Choose the reason from the Select a Dismiss Type for Current Stay 

dropdown menu. The Dismissal Type dropdown will have the same options 

listed on the Patient Selection/Worklist (Figure 40). 

3. Click the Dismiss Currently Selected Stay. 

4. The Patient Stays column will reflect “Dismissed” in the D/U detail column. 

 

 

Figure 40: Dismiss Stay from Patient Stay History 

On the Patient History Screen, it is possible to select other stays for that patient for 

dismissal.  This is in contrast to the Patient Selection/Worklist where the dismissal action 

defaults to the most recent stay with no abilities to select other stays for that patient.  
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6.1.7 Selecting a Review from the Reviews Table 

Note: There are two methods for selecting stays for reviews, Selecting a Review from the 

Reviews Table (Section 6.1.7)  and Selecting a Patient Movement from the Stay Movements 

Table (Section 6.1.9 ). While both are valid methods of selecting reviews, Section 6.1.7, 

Selecting a Review from the Reviews Table provides instructions for the preferred method. 

  

Patient reviews that have not been locked into the database and may be requiring further review 

and completion or that have been unlocked will display a Review hyperlink in the Reviews table. 

Clicking the hyperlink will open the Review Summary screen (Figure 41) and you can continue 

working on the review from there. You will also have the option to copy the review – just click 

the <Copy This Review> button. 

 

Reviews that have been locked to the database will display a View hyperlink in the Reviews 

table. Clicking the hyperlink will open the Review Summary screen, and you can look at the 

review and, if desired, you can edit the review, delete the review, or copy the review and save it 

with another date. When you open the review, you will see <Close>, <Copy This Review>, 

<Unlock>, <Delete> and <Print> buttons. If the review included an admission or day that did 

not meet criteria, depending on the state of the review you will also see the <Unlock Physician 

Advisor Review> button. (See Section 13.2 for more information).  

6.1.8 Selecting a Review from the Reviews for Currently Selected 
Stays List 

The Review/View functionality is also available from the “Reviews for Currently Selected 

Stays” list on the upper right hand side of the screen. This functions exactly the same as selecting 

from the Reviews Table, with the added feature of being able to see exactly which days in the 

Patient Stay are available for review or have already been reviewed. Additionally, selecting a 

review from the “Reviews for Currently Selected Stays” list automatically pre-populates the 

review date in the review. 

 

When unlocking a Primary Review Summary with no Admission Review Type 

displayed, you will not be able to save the review until a valid option from the Admission 

Review Type dropdown is selected. The valid dropdown options are discussed in Section 

8.18.  
 

There are some restrictions imposed when copying reviews. You are prohibited from copying a 

review and applying it to a different patient. You are also prohibited from copying a review and 

using a stay date related to a different hospital admission. 

 

From this versatile screen you can Unlock, Delete, Print and Copy a review with the click of a 

button. (See Chapter 13 for more details about Unlocking and Deleting reviews, and Chapter 14 

for more details about Copying reviews).  

 

To select a review from the Reviews table 



 

May 2014 NUMI User Guide 6-6 

1. Click the gold <Show Reviews> bar (illustrated in Figure 39) to display the 

Reviews table. 

2. Click on the View or Review hyperlink for the review you want to see. 

3. A separate window will open and display the Review Summary screen 

(Figure 41).  

 

 

Figure 41: Review Summary screen with Unlock, Delete, Print and Copy options 

6.1.9 Selecting a Patient Movement from the Stay Movements Table 

Each patient will receive one review per day. Select a patient movement from the table as a 

starting point for reviewing a day of a stay because the Attending, Ward, and/or Treating 

Specialty are already populated. Any of these aspects related to the movement, as well as the 

date, can be corrected later on the Primary Review screen.  (See Chapter 8 for detailed 

information about the Primary Review screen).  Note: the Attending Physician from VistA may 

need to be updated in NUMI if it has been entered inaccurately on the unit, or in Admissions. 

This does not update it in VistA or on the Patient Selection/Worklist, but NUMI reports will 

display the corrected Attending information. 

 

  To get to the InterQual Criteria screen, you must click on a Review link from the Stay 

Movements table. The review link that you select determines the ward, treating specialty 

and attending physician that will be populated on the review.  

 

To select a patient movement from the Stay Movements table  

1. Click the Review hyperlink in the Stay Movements table for the movement 

you want to see.  
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2. Remember that the Attending Physician, Ward, and Treating Specialty from 

that movement will pre-populate on the Primary Review screen. 

3. The InterQual Criteria screen will display. (See Section 7 for information 

about the InterQual Criteria screen and its use in NUMI). 

 

 

Figure 42: Patient Movements and Reviews tables 

6.1.10 Viewing Patient Insurance Information 

The display of patient insurance is for informational purposes only and does not impact the 

review process. (Insurance review data can be entered into the VistA Claims Tracking 

application or another facility/VISN-designated program for tracking of this information). The 

Insurance field will be collapsed when the Patient Stay History screen first opens. 

 

To display Insurance information 

1. Click the <+> button, beside the Insurance field (shown in Figure 38) and 

the patient’s insurance information will display. If the patient does not have 

insurance, a “0” will display in the field. 

6.1.11 Printing out a Patient Worksheet 

NUMI offers a convenient feature that allows you to print out a hardcopy worksheet with 

admission information for a patient, and use it to take notes to assist you in entering reviews into 

NUMI. This can be helpful if you like to do all your CPRS research first and then enter reviews, 

or if you need to take notes when out on the units. Worksheets can be valuable tools if a reviewer 

needs to pick up patients from another reviewer.  
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To print a patient worksheet 

1. Click the <Patient Worksheet> button (shown in Figure 39).  

2. A worksheet with information for the patient will display in a new window, 

as shown in Figure 43. Right-click and select the <Print> option to print it 

out on your local printer. 
  

 

Figure 43: Patient Worksheet example 

 

6.1.12 Invalidating a Patient Stay 

If you click on a patient stay id and the stay cannot be found in Vista, or no longer exists in 

Vista, then the Invalid Stay dialog will appear (Figure 44).  When this occurs the user has the 

option of invalidating the stay.  Choose Invalidate to invalidate the stay, or choose Do Not 

Invalidate to leave the stay in its current state. 

If you choose Do Not Invalidate then whatever stay was selected will remain selected.  You can 

invalidate the stay at a later time if you wish. 
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Figure 44: Invalidating a Patient Stay 
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7 InterQual Criteria  

This chapter describes the InterQual Criteria screen in the NUMI application (Figure 46). The 

InterQual Criteria screen is actually the portion of McKesson CERME integrated into NUMI 

that automates the usage of the InterQual
®

 criteria, to determine whether a stay meets criteria or 

not. With very few exceptions, everything on this screen is McKesson CERME. When the screen 

is first displayed, the Primary Review button and the Continue Primary Review button will be 

grayed out. 

 

  CERME 2012 criteria are loaded and can be selected as appropriate for your reviews. 

The Quality Indicator Checklist and the Transition Plan screens are just for reference. No 

data entered on these screens will be saved in the NUMI database.  If you check any boxes 

on those screens and click the Continue Primary Review button to proceed to the Primary 

Review Summary screen from the quality indicator checklist or the transition plan screen, 

you will see the error depicted in Figure 45.  

 

 

Figure 45: Unsupported Review Type error message 

  It is important to note that the current process you follow for using CERME (e.g.,  

select an InterQual
®
 Product, Category and Subset, view criteria notes, evaluate/select 

criteria, etc.) is based on your InterQual
®
 training. CareEnhance Review Manager training 

and National Policy will remain exactly the same.  

 

  CERME 2012 requires the use of a Flash Player. If you try to access the InterQual 

Criteria screen and you do not have Flash Player loaded on your personal computer (PC) 

desktop, you will receive a message advising that you need to have Flash Player (see Figure 

11). Just click the OK button to close this message and proceed into CERME to complete your 

review. Please see Section 2.1.21 for more information. 

 

When you have completed your CERME activities on this screen, just click the <Continue 

Primary Review> button to move on to the NUMI Primary Review screen.  

The McKesson CERME features of this screen are listed in 
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Table 5, and the NUMI features are listed in Table 6.  
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Table 5: InterQual Criteria Screen – McKesson CERME Features 

CERME 2012 FEATURES 

Find InterQual
®

 Medical Criteria Subsets 

View InterQual
®

 Medical Criteria Subset Notes 

Select an InterQual
®

 Medical Criteria Subset 

Print a Review Summary 

View InterQual
®

 Notes 

View CERMe Help Topics 

View Clinical Evidence Summaries 

Change Current Level of Care 

Create a Review (Admission, Continued Stay, and Discharge screen) 

Transition Plan 

Quality Indicators Checklist 

 

Table 6: InterQual Criteria CERMe Screen – NUMI Features 

NUMI FEATURES 

The “Continue Primary Review” Button 

The “Patient Selection/Worklist”, “Patient Stay History”, “CERMe” and 

“Primary Review button bar (navigational tabs for moving through a review) 

The read-only information in the Review For, Age and Admission Dx fields 

 

IMPORTANT 
Below is a list of some features that may display as you are working on the InterQual Criteria 

screen. These are McKesson CERME features and are not applicable to NUMI. Please do not use 

them:  

 

 Add Reviewer Comments field (Any comments entered here will NOT be captured with the 

rest of the review. The Primary Review screen, described in Chapter 8, will provide you with 

an opportunity to enter review comments). 

 Hide Comments checkbox 
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Figure 46: NUMI Application ‘CERMe’ screen 

7.1 Finding InterQual® Medical Criteria Subsets  

Use this feature to find Subsets, which are groupings by specialty under each InterQual
®

 Level of 

Care. Within each Subset are the InterQual
®

 medical criteria Products, Categories and 

Subcategories that the Subset is based upon. A specific subset of InterQual
®

 criteria is 

implemented in NUMI. The subsets that are NOT implemented in NUMI are listed in Table 7.  

 

  Behavioral Health Procedure Review Subsets are not supported in NUMI. CERME 

will let you choose the Behavioral Health Procedure Review subsets below and do a review, 

but when you try to continue NUMI will stop you and reset the review to its previous state.  

 

Table 7: InterQual
®
 Criteria Subsets not implemented in NUMI 

InterQual Product Category Unsupported Subsets 

BH: Geriatric Psychiatry Procedure Review - Geriatric Acute Short-

Term Electroconvulsive 

Therapy (ECT) 

- Geriatric 

Continuation/Maintenance 

Electroconvulsive Therapy 

- Geriatric 

Neuropsychological 

Testing 

- Geriatric Psychological 

Testing 

BH: Adult Psychiatry Procedure Review - Adult Acute Short-Term 

Electroconvulsive Therapy 

(ECT) 
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InterQual Product Category Unsupported Subsets 

- Adult 

Continuation/Maintenance 

Electroconvulsive Therapy 

- Adult Neuropsychological 

Testing 

- Adult Psychological 

Testing 

 

No reviews need to be done for non-implemented subsets (i.e., procedures within Behavioral 

Health), and they cannot be saved.  

 

To find Subsets by InterQual
®

 Product and Category 

1. Select an option in the InterQual
®

 Products window by clicking on it.  

2. A list of categories will be populated in the Categories window. 

3. Click on an option in the Categories window and a list of hyperlinked 

Subsets will populate in the table on the screen. 

 

 If you select the BH: Chemical Dependency & Dual Diagnosis InterQual
®

 Product and 

the Adult or Adolescent Category options, an additional Subcategory-level window will 

display. Once you have selected a subcategory, a list of hyperlinked Subsets will display in 

the table. 

7.1.1 Finding Subsets using Keyword(s) and Medical Code(s) 

Use this feature to search for InterQual
®

 Medical Criteria Product subsets using Keywords and 

Medical Codes. The Keyword search feature is handy when you are not sure which subset to use 

for an admitting diagnosis. The Medical Code search feature is handy in cases where concurrent 

coding has been done (i.e., a patient stay gets an ICD-9 code upon admission, and that code is 

changed concurrently as the diagnosis changes). 

 

To find Subsets using Keyword(s) 

1. Type the desired keyword(s) into the Keyword(s) field. 

2. Click the <Find Subsets> button. 

 

To find Subsets using Medical Code(s) 

1. Type the desired ICD-9 medical code(s) into the Medical Code(s) field). 

2. Click the <Find Subsets> button. 

 

 Use commas in between multiple Keywords and Medical Codes 

 If a Keyword or Medical Code search produces no results, the message “No Subsets 

Found” displays 



 

May 2014 NUMI User Guide 7-6 

 

7.2 Viewing Subset Notes 

Use this feature to look at InterQual
®

 Medical Criteria Subset Notes. The types of criteria notes 

include: Instruction (Level of Care) Notes which facilitate level of care choices and explain 

correct applications (Figure 47), Informational Notes which clarify criteria points (Figure 48), 

and Glossary Notes that include frequently referenced notes and definitional terms (not shown). 

 

To view Subset notes 

1. Select an InterQual
®

 Product, a Category, and a Subcategory (if 

applicable). 

2. When the list of Subsets displays in the table, click on the yellow Notes icon 

  beside the desired subset.  

3. Another window will open and display the notes for that Subset. 

 

 

Figure 47: Instruction (Level of Care) Subset Notes example 
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Figure 48: Informational Subset Notes example 

7.3 Selecting an InterQual® Medical Criteria Subset 

To select a Subset 

1. Select an InterQual
®

 Product, a Category, and a Subcategory (if 

applicable). 

2. When the list of Subsets displays in the table, click on the desired Subset 

Description hyperlink. 

3. Select the applicable review type from the Review Type drop down list 

(Figure 55). 

4. A set of criteria with checkboxes will display (Figure 49). 

5. To expand or collapse the criteria fields, click the <+> and <-> buttons. 

 

 The criteria that displays will depend on the Subset you choose. Review criteria from 

the selected subset decision tree for a patient is captured and displayed on the Review 

Summary and Physician Advisor Worklist screens for reference.  
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Figure 49: Criteria InterQual
®

 Criteria checkboxes 

  Clicking the <Next Step> button in the lower left portion of the sidebar may display 

the message: “There are no more steps to display”. This applies to McKesson 

CERME and is not applicable to NUMI.  If you see this message, click the <Continue 

Primary Review> button at the top right hand side of the page to proceed. 

7.3.1 Changing a Subset Selection 

To change a Subset selection 

1. Click on the Subset information row in the sidebar to display the <Change 

Subset> button (Figure 50).  

2. Click the <Change Subset> button.  

3. The following message displays: “Changing subsets will erase all criteria 

point selections, reviewer notes, and the review outcome. Would you like to 

change subsets?” 

4. Click the <Yes> button and select another Subset.  

 

 

Figure 50: Change Subset button 

5. Criteria Met or Criteria Not Met will display based on the criteria 

checkboxes you select. 
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7.4 Printing a Review Summary 

While this screen has a feature for printing a review summary, it should be noted that this 

summarizes CERMe data selected only, and does not include the other review data. 

 

To print a review summary 

1. Click the <Review Summary> button on the sidebar. 

2. The summary information will display in the right hand side window, as 

shown in Figure 51. Use your browser’s print feature to print out the 

information. 

 

 

Figure 51: Review Summary 

7.5 Viewing InterQual® Notes 

Any InterQual
®

 Notes that display will depend on the criteria you have selected, and will 

populate to the lower left hand window in the sidebar, as illustrated in Figure 52.  



 

May 2014 NUMI User Guide 7-10 

 

Figure 52: InterQual
®
 Notes example 

7.6 Viewing CERME Help Topics 

The Help dropdown contains a variety of McKesson CERME help topics that can be viewed 

from within the NUMI application. These are not NUMI help topics. The dropdown is located on 

the far right hand side of the InterQual Criteria screen, beneath the <Continue Primary 

Review> button, as shown in Figure 51. 

 

To view the CareEnhance Review Manager topic 

1. Click the Help dropdown. 

2. Click CareEnhance Review Manager. The topic will display in a separate 

window. 

 

To view the Guide to Conducting Reviews topic 

1. Click the Help dropdown. 

2. Click Guide to Conducting Reviews. The topic will display in a separate 

window. 

 

To view the InterQual
®
 Abbreviations and Symbols topic 

1. Click the Help dropdown. 

2. Click InterQual
®
 Clinical Reference. 

3. Click Abbreviations and Symbols. The topic will display in a separate 

window. 

 

To view the InterQual
®
 Clinical Reference 2011 topic 

1. Click the Help dropdown. 

2. Click InterQual
®

 Clinical Reference. 

3. Click Clinical Reference 2011. The topic will display in a separate window. 

 

To view the InterQual
®
 Clinical Reference / Drug List topic 

1. Click the Help dropdown. 

2. Click InterQual
®

 Clinical Reference. 

3. Click Drug List. The topic will display in a separate window. 

 

To view the Historical InterQual
®

 Clinical Reference topic 

1. Click the Help dropdown. 

2. Click InterQual
®
 Clinical Reference. 

3. Click Clinical Reference 2010. The topic will display in a separate window. 

 

To view the About CareEnhance Review Manager topic 

1. Click the Help dropdown. 
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2. Click About CareEnhance Review Manager. The “About” information will 

display in a separate window. 

7.7 Viewing Clinical Evidence Summaries 

Use this feature to view InterQual
®

 Clinical Evidence Summaries. These are a collection of 

concise, current white papers that synthesize medical research on complex and controversial 

diagnoses to support second-level physician review recommendations and promote evidence-

based standards of care. 

 

To view Clinical Evidence Summaries 

1. Click the Clinical Evidence Summaries information row in the sidebar 

(shown in Figure 53). 

2. A list of Categories will display. 

3. Click on a Category (or, to search for specific information, type in one or 

more Keywords and click the <Find Subsets> button).  

4. A list of Clinical Evidence Subsets will display. 

5. Click on a Subset Description hyperlink for the clinical evidence summary 

you wish to see. A Book View of the summary you chose will display. 

 

 

Figure 53: Clinical Evidence Summary Subsets 
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7.8 Change the Current Level of Care Option 

 Hyperlinked Current Level of Care options will display when Behavioral Health 

InterQual
®

 Product / Category combinations are selected.      

 

To change the Current Level of Care 

1. Click on a product in the InterQual
®

 Products window (e.g.,  BH: Chemical 

Dependency & Dual Diagnosis).  

2. Click on a category in the Categories window (e.g.,  Adult). 

3. Click on a subcategory in the SubCategories window (e.g. Adult Concurrent 

Review) 

4. Click on a Subset Description Link to select it. 

5. A list of hyperlinked Current Level of Care options will display, as illustrated 

in Figure 54. 

6. Click on a Current Level hyperlink.  

7. A list of Current Level Criteria will be displayed. 

8. In the Left Panel, Click on ‘Select Current Level of Care; link. 

9. A list of hyperlinked Current Level of Care options will display, as illustrated 

in Figure 54 with the previously selected Current Level option highlighted. 

10. Click on a unhighlighted Current Level hyperlink 

11. A popup Dialog Box will be displayed containing the message “Changing 

this choice will erase all criteria. Click Yes to change or No to keep the old 

value” will display. 

12. Click the <Yes> button and select another Current Level hyperlink. 

13. A list of Current Level Criteria will be displayed that reflects the new 

Current Level hyperlink selected. 

 

 
 

 

Figure 54: Current Level of Care option examples 

7.9 Transition Plan 

The Transition Plan is a comprehensive discharge planning guideline intended to provide 

reviewers with a means to document, track and report on the discharge plan throughout the 

episode of care. It provides a framework for identifying discharge needs and outlines the 

interventions necessary to ensure continuity of quality patient care. Evidence has demonstrated 

that attention to transitioning care from one setting to another can significantly improve 

outcomes, impact quality of care and reduce readmissions.  
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 The Transition Plan is available in the criteria books and as a reportable, interactive checklist in 

CareEnhance® Review Manager.   

 

Within the criteria, select criteria points are flagged with a new green icon , indicating that the 

patient may be at risk for readmission and could benefit from comprehensive discharge planning.  

 

To view Transition Notes 

1. Click on the green Transition Notes icon beside a subset in the table. 

2. Another window opens and displays the Transition Notes for that subset. 

7.10 Quality Indicator Checklist 

The National Quality Forum (NQF) inpatient quality measures can be found in the "Quality 

Indicator Checklist". This checklist is designed for ease of use, to improve quality of care, and to 

enable reporting.   The Quality Indicator Checklist is available in the criteria books and as a 

reportable, interactive checklist in CareEnhance® Review Manager.  

 

Within the criteria, select criteria points that have associated NQF inpatient quality measures are 

flagged with a new orange icon. To view Quality Indicator Notes 

 

1. Click on the orange Quality Indicator Notes icon beside a subset in the table. 

2. Another window opens and Displays the notes for that subset. 

7.11 Creating Reviews  

Below are the basic steps for creating Admission and Continued Stay Reviews. Note: if a 

reviewer has previously performed a review for a stay that does Not Meet criteria and has 

specified reasons and assigned the review to a Physician Advisor, then they return and change 

the review so that the stay meets criteria, the prior reasons and Physician Advisor review will all 

be lost.  

 The system will not permit you to create more than one review per patient, per day.  If 

an attempt is made to save a second review for a single calendar day, an error message will 

be displayed indicating: “A review has already been saved for <review date> by 
<reviewer name>. Only one review per day can be entered into NUMI. Please 

modify the saved review, if necessary, or select another day”, and the review 

will not be saved. 

 

  InterQual
®

 Notes can be displayed for certain Admission, Continued Stay and 

Discharge criteria. Criteria that have notes associated with them will display in the 

InterQual
®

 Notes window on the lower left hand side of the InterQual Criteria screen.  

7.11.1 Creating an Admission Review 

An Admission Review is performed upon hospital admission to acute care treating specialties, or 

transfer to a higher LOC to determine whether that patient meets criteria for that level of care. 
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For information about how the system identifies the various admission review types, please see 

Section 8.15. 

 

To create an Admission Review 

 

1. From the Subset menu, click on the LOC: Acute Adult InterQual
®

 Product.  

2. Click on a category in the Categories window.  

3. A listing of Subsets will populate in a table on the screen.  

4. Select a Subset by clicking on its Subset Description hyperlink. 

5. Select the Admission option from the Review Type Dropdown list (Figure 

55) to indicate to the system that the review is an Admission.  

6. Click the <+> button beside the criteria to expand the Admission criteria 

fields (Figure 56).  

7. Click on the desired checkboxes.  

8. A checkmark will appear beside each box you have selected.  (The criteria 

checkboxes you select will determine what displays in the IQ Criteria Met 

field on the Primary Review screen. Please see Table 8 for more 

information). 

9. When you have selected criteria for both Severity of Illness and Intensity of 

Service, you will notice that if the patient has met criteria on both factors 

there will be a green Criteria Met box in the upper right corner. If the 

patient has not met criteria on both factors, you will see a red Criteria Not 

Met box. 

10. Click the <Continue Primary Review> button and the Primary Review 

Summary screen will display. (Note: A Review Type must be selected from 

the Review Type Dropdown for the <Continue Primary Review> button to 

become active.) On the Primary Review Summary screen you will complete 

the review by entering the Date you are reviewing, indicating if the 

admission is an unscheduled readmit within 30 days, selecting an Admission 

Review Type, seeing if the IQ Criteria is met, selecting the Current Level of 

Care, entering the Criteria Not Met Elaboration details and any Reviewer 

Comments,  choosing the Selected Reason Description and, if the review 

does not meet criteria, selecting a Recommended Level of Care Reason, and 

selecting a Physician Advisor Reviewer, selecting the “Check here if criteria 

is NOT MET and formal hospital policy does NOT require physician review” 

check box, selecting the “Check this box if you will not be doing further 

views on this stay” checkbox and setting a reminder by selecting the Next 

Review Reminder date. Select the Admitting Physician from the dropdown, 

select the Admission Source the dropdown, select the Attending Physician 

from the dropdown, select the Treating Specialty from the dropdown, and 

select the Service Section from the dropdown. Verify the Ward, is correct. 

(Note: when generating NUMI reports and using the Admission Review 

Type filter, the information that displays will be determined by the admission 

review type that was selected). Please see Chapter 12 for more information 

about reporting and Section 8.18 for information about the different types of 

admission reviews). There is a free text field to enter comments on the 



 

May 2014 NUMI User Guide 7-15 

Primary Review Summary screen. This field will accommodate extensive 

comments and is intended for your use to document information for future 

reference and to assist you in identifying specific findings of this review. 

11. Click the <FINAL SAVE/Lock to Database> button to save your work. (See 

Chapter 8 for detailed instructions on using the features of the Primary 

Review Summary screen). 

 

  At the time a review is created, NUMI will save three additional data fields captured 

from CERMe: Criteria Subset, Episode Day of Care, and CERMe version. 

 

  IMPORTANT: If you ever need to come back to the InterQual Criteria screen to make 

changes to the InterQual
®
 criteria portion of the Admission review, you MUST click the 

<Continue Primary Review> button for NUMI to capture the changes, and reflect them in 

the review accordingly. Otherwise your changes will be lost. 

 

 Both the Severity of Illness criteria and the Intensity of Services criteria rules from the 

same criteria subset must be met on Admission. Thus, in NUMI, once criteria checkboxes 

have been selected for Severity of Illness and Intensity of Service, the criteria for 

Admission will be met and the review status will automatically change to . 

 

 
 

 

Figure 55: Review Type options 
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Figure 56: Admission criteria example 

 Selecting certain criteria may display advisory messages, such as: “Admit to 
Inpatient/Observation”, “Admit to Inpatient / Observation and refer to Dual 
Diagnosis criteria subset for concurrent review” or “Admit to Inpatient 

Detoxification”. Click the <OK> button to continue working. 

7.11.2 Creating a Continued Stay (CS) Review 

A Continued Stay (CS) Review is performed to determine if a continued stay day in the acute 

care setting meets clinical criteria. The system will only permit you to create one Continued Stay 

review per day. 

 

To create a Continued Stay Review 

 

1. From the Subset menu, click on the LOC: Acute Adult InterQual
®

 Product.  

2. Click on a category in the Categories window.  

3. A listing of Subsets will populate in a table on the screen.  

4. Select a Subset by clicking on its Subset Description hyperlink. 

5. Select the Continued Stay option from the Review Type Dropdown list 

(Figure 55).  

6. Click the <+> button beside the criteria to expand the fields (Figure 57).  

7. Click on the desired checkboxes.  

8. A checkmark will appear beside each box you have selected.  (The criteria 

checkboxes you select will determine what displays in the IQ Criteria Met 

field on the Primary Review Summary screen. Please see Table 8 for more 

information). 
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9. Click the <Continue Primary Review> button and the Primary Review 

Summary screen will display. (Note: A Review Type must be selected from 

the Review Type Dropdown for the <Continue Primary Review> button to 

become active.) On the Primary Review Summary screen you will complete 

the review by entering the Day Being Reviewed, the Current Level of Care, 

the Criteria Not Met Elaboration details, and Reviewer Comments, selecting 

the Selected Reason Description and, if the review does not meet criteria, 

selecting a Recommended Level of Care and Stay Reason, selecting a 

Physician Advisor Reviewer and setting the Next Review Reminder Date. 

Then verify that Admitting Physician, Admission Source, Attending 

Physician, Treating Specialty, Service Selection, Ware and Custom are 

correct. Enter clinical comments to assist you for further reference. If this is a 

review that does not meet criteria and will be forwarded to a Physician 

Advisor Reviewer for review, clinical comments that provide information 

about why the patient is not meeting criteria will be helpful for the Advisor. 

10. Click the <FINAL SAVE/Lock to Database> button to save your work. (See 

Chapter 8 for detailed instructions on using the features of the Primary 

Review Summary screen). 

 

  IMPORTANT: If you ever need to come back to the InterQual Criteria screen to make 

changes to the InterQual
®
 criteria portion of the Continued Stay review, you MUST click 

the <Continue Primary Review> button for NUMI to capture the changes, and reflect 

them in the review accordingly. Otherwise your changes will be lost. (Note: A Review Type 

must be selected from the Review Type Dropdown for the <Continue Primary Review> 

button to become active.) 
 

 Once one or more criteria checkboxes for Intensity of Service have been selected, the 

criteria for Continued Stay will be met. The review status will remain   . 

  You can select the <Continue Primary Review> button regardless of whether criteria 

have been met. Note: if criteria have not been met, the review will become a Physician 

Advisor review (unless, by formal hospital policy, a Physician Advisor review is not 

required. Please see Section 8.8.1for information about indicating a Physician Advisor 

Reviewer review is not required). 
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Figure 57: Continued Stay criteria example 

 Selecting certain Continued Stay criteria may display this message: “Choosing these 
criteria indicates that the patient may be ready for discharge or transfer. 

Would you like to review the discharge screens for assistance in discharge 

planning? (For more information click on the Help tab to access the 

appropriate criteria review process e.g., Acute Care, Acute Rehabilitation, 

LTAC)”, along with <Yes> and <No> buttons. Click the desired button to continue working. 

7.12 Continue Primary Review Button 

Select this button to leave the InterQual Criteria screen in the NUMI application and proceed 

with the primary review. The type of review and whether it meets criteria or not will change the 

display of the Primary Review Summary screen when it displays after the <Continue Primary 

Review> button is pressed. 

 

To continue a Primary Review  

1. Click the <Continue Primary Review> button at the top right hand side of 

the screen. (Note: A Review Type must be selected from the Review Type 

Dropdown for the <Continue Primary Review> button to become active.). 

2. The Primary Review Summary screen will display. 
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  If you click the <Continue Primary Review> button and the review is not supported 

in NUMI, you will see the message: “Unsupported review type. Please use another 

CERMe review”. You will need to select another review. A Behavioral Health Procedure 

Review is one example of when this message may display. (Table 7 lists the non-

implemented InterQual
®
 Criteria Subsets in NUMI).     
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8 Primary Review Summary 

This chapter describes the Primary Review Summary screen. The Primary Review Summary 

screen is where you will select a day to be reviewed during the patient stay and add and update 

patient review information such as review and reminder dates, levels of care, Attendings, and 

stay reasons. 

 

During the initial patient review, if the Admitting Physician field is not already populated by 

VistA, the reviewer should select an Admitting Physician from the Admitting Physician 

dropdown in the stay information section of the Primary Review Summary screen. 

 

A read-only edit box near Criteria Subset is labeled “Episode Day of Care” and displays the 

information captured from CERMe. 

 

To flag an unscheduled re-admission within 30 days of discharge, the reviewer can select the 

“Check if Unscheduled Readmit within 30 Days” checkbox.  This appears when the CERMe 

review type is “continued stay” or “BH concurrent” and the day being reviewed is the same as 

the admission date. 

 

The Primary Review Summary screen also displays the following text near the “Check if 

Unscheduled Readmit within 30 Days” checkbox: “You are conducting a <insert review type 

description> review for the day of admission. This should only be done for patients who have 

transferred into your facility from another medical facility. If this is an unscheduled re-

admission, please check the unscheduled re-admission checkbox.”  This message will only 

appear when the CERMe review type is “continued stay” or “BH concurrent” and the day 

reviewed is the same as the admission date. 

 

  

In the IQ Criteria Met field, a visible Met / Not Met indicator is displayed for your 

convenience. The value that displays in the field (Yes/No) will be determined by the criteria 

checkboxes that were selected on the InterQual Criteria screen. Table 8 shows the detailed 

review outcomes and what will populate in the field. (The IQ Criteria Met field value will also 

display in the Met? column on the Patient Selection/Worklist screen). 

 

Table 8: Review Outcomes and IQ Criteria Met Values 

InterQual Criteria Screen Review      

Outcome Value  

Primary Review Summary Screen IQ 

Criteria Met Field Value 

Observation Met – Yes Yes 

Acute Met – Yes Yes 

Intermediate Met – Yes Yes 

Critical Met – Yes Yes 

Criteria Met – Yes Yes 



 

May 2014 NUMI User Guide 8-2 

InterQual Criteria Screen Review      

Outcome Value  

Primary Review Summary Screen IQ 

Criteria Met Field Value 

Criteria Not Met – No No 

Alternate Met – Yes Exception/Not allowed   

N/A Exception/Not allowed   

 

 If the InterQual
®

 product criteria you selected results in a review outcome of Alternate 

Met – Yes or N/A, when you select the Continue to Primary Review button from the 

InterQual Criteria and the Primary Review Summary screen displays, the error message 

shown in Figure 58 will display and you will be returned to the InterQual Criteria screen. 

An example of criteria selections that are not supported in NUMI and will produce the 

error message would be selecting the LOC Acute Adult Product and either the Transition 

Plan or Quality Indicator Checklist categories.   

 

 

Figure 58: IQ Criteria Met error message 

 

A “Criteria Not Met Elaboration” box will appear when the reviewer is creating a review that has 

not met criteria.   

 

For reviews that do not meet criteria, a “Custom” text box will appear on the Primary Review 

Screen. You can type up to 100 characters in this box.  The full content of the Custom will 

appear as a tooltip when you hover your mouse over this area. 

 

On this screen you can also, select the Admission Review Type, see if the IQ Criteria is met, 

select the Current Level of Care, enter the Criteria Not Met Elaboration details and any Reviewer 

Comments,  choose the Selected Reason Description and, if the review does not meet criteria, 

select a Recommended Level of Care Reason, and select a Physician Advisor Reviewer to assign 

reviews that did not meet criteria, select the “Check here if criteria is NOT MET and formal 

hospital policy does NOT require physician review” check box, select the “Check this box if you 

will not be doing further views on this stay” checkbox and set a reminder by selecting the Next 

Review Reminder date. Select the Admitting Physician from the dropdown, select the Admission 

Source the dropdown, select the Attending Physician from the dropdown, select the Treating 

Specialty from the dropdown, and select the Service Section from the dropdown. Verify the 

Ward, is correct, generate a report from the custom notes entered in the free text field (mentioned 

above) [Section 12.6] that shows those notes), identify unscheduled readmissions, copy a review 

(via a link in the Reviews table), and save/lock reviews to the database.  
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The bottom half of the screen displays read-only review text information from McKesson 

CERME. (The information that displays in the Attending, Treating Specialty and Ward fields 

will depend on which Review hyperlink you selected on the Patient Stay History screen). When 

the screen first displays, the Patient Selection/Worklist, Patient Stay History, CERME, and 

Primary Review buttons will be available for selection. The features on this screen are listed in 

Table 9.  

 

If a user creates Admission or Initial Review type reviews, the system will display an Admission 

Review Type dropdown (discussed in Section 8.15), a Number of Days Since Last VA Acute 

Care Discharge field (discussed in Section 8.23), and a Check if Unscheduled Readmit Within 30 

Days checkbox (discussed in Section 8.17 ) on the Primary Review Summary screen.   

 

  All fields on the Primary Review Summary screen (with the exception of Custom and 

Reviewer Comments) are required and must be populated before a review can be saved 

and locked to the database. If the review Meets you must select Review Date, Attending 

Physician, Current Level of Care, Treating Specialty, Ward, and Service Section. If the 

review Does Not Meet you must select options from the abovementioned fields as well as 

options for Recommended Level of Care and Physician Advisor. If the review is an 

Admission or BH Initial type you must select an Admission Review Type. If you do not 

select something from these dropdowns you will see one or more messages in red text. 

(Figure 59).   

 

 

 

Figure 59: Example required field messages on Primary Review screen 
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Note that red text error messages depicted in the various figures within this document may vary 

from their appearance to the actual application as indicated in Figure 60 . This is due to on-going 

section 508 compliance changes.   

  

 

 

Figure 60:  Red text example 

 

Table 9: Primary Review Summary Screen Features 

FEATURES 

Select Day Being Reviewed Date 

Select/Change Current Level of Care 

Select/Change Attending Physician 

Select/Change Treating Specialty 

Select/Change Ward 

Select/Change Service Section 

 Working with Admission Review Types 

Working with Admission Sources 

Add Reviewer Comments 

Select Stay Reasons 

Assign a Physician Advisor to a Review that has Not Met Criteria 

Change Next Review Reminder Date 

Indicate no more Reviews on a Stay 
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FEATURES 

Select/Change Recommended Level of Care 

Indicate an Unscheduled Readmission within 30 days 

Show a Patient’s Reviews 

Copy a Review 

View CERME Review Text 

Add Custom Notes 

Save and Lock a Final Review 

Add an Admitting Physician 

Days Since Last VA Acute Care Discharge Calculation 

 

8.1 Selecting the Day Being Reviewed Date 

When the Primary Review Summary screen opens, you will need to select a Day Being 

Reviewed date.  This calendar feature is located below the Admit Date field and above the 

Review Type field.  If you selected the review from the “Reviews from Currently Selected 

Stays” list on the Patient History page, the review date will be pre-populated.  

 

To select the Day Being Reviewed date 

1. Click on the dropdown box beside the Calendar icon (Figure 61) and select a 

date between the Admission date and the Discharge date (or the current day’s 

date if the patient has not been discharged).  

 

 

Figure 61: Calendar 

  The calendar only lets you select a date between Admission and Discharge dates (or 

current day’s date if the patient is still in the hospital). If you manually enter a date, it must 

be within that range or a message like the one shown in Figure 62 will display. If you type 

in the date, you must use the format mm/dd/yyyy. 
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Figure 62: Review Date prompt 

Once you select the Review Date, the Day of Stay populates with a number representing the 

difference between the Admission Date and the Review Date plus one. e.g., if the Review Date 

and Admission Date are the same, the Day of Stay is “1”. If you selected the review from the 

“Reviews from Currently Selected Stays” list on the Patient History page, the review date will be 

pre-populated as will be the Day of Stay.  

8.2 Selecting Admission Review Type 

Use this feature to select the Admission Review Type for a patient. You must select an 

Admission Review Type or you will not be able to save the review. 

 

To select the Admission Review Type 

1. Click on the Admission Review Type dropdown.  

2. Select an Admission Review Type by clicking on an option in the list.  

8.3 Selecting or Changing Current Level of Care  

Use this feature to select or change the Current Level of Care for a patient. You must select a 

Current Level of Care or you will not be able to save the review (see Figure 63). 

 

 

Figure 63: Primary Review screen 
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To select or change the Current Level of Care 

1. Click on the Current Level of Care dropdown.  

2. Select a Current Level of Care by clicking on an option in the list. OR 

3. Change the Current Level of Care to another value by clicking on a different 

one.  

  If ‘Other’ is selected, a text box will display and you will need to type in a description. 

You may type up to 1,000 characters into the text box.  

8.4 Enter Criteria Not Met Elaboration 

Use this feature to elaborate on criteria not met.   

 

To enter Criteria Not Met Elaboration 

1. Type up to 100 characters directly into the Criteria Not Met Elaboration 

field (see Figure 64). 

 

Figure 64: Criteria Not Met Elaboration 

8.5 Adding Reviewer Comments 

Comments that you enter here will also display in the Comments window on the Physician 

Advisor Worklist screen for reviews not meeting criteria. Your comments may be up to 4,000 

characters in length. It is helpful to enter information, which will explain why the patient does 

not meet criteria. For reviews meeting criteria, use this field to document information that will be 

helpful to you for future reference. (Please see Section 11.5 for more information about this 

screen).  

 

To add reviewer comments 

1. Type your comments directly into the Reviewer Comments field (Figure 65).  

 

 

Figure 65: Reviewer Comments 
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8.6 Selecting a Stay Reason 

Stay reasons will only be required on the Primary Review Summary for reviews that have not 

met criteria. The Stay Reason categories are collapsed when the screen first opens. To expand 

the categories and view the list of Stay subcategories, click the <+> buttons (Figure 66).  

 

  You must choose a Stay Reason if the stay does not meet criteria or you will not be 

able to save the review and the message “Please Select a Reason” will display.  

 

 

Figure 66: Expanded Stay Reason Categories 

To select a stay reason 

1. Click on the <+> button beside the desired stay reason category. 

2. Choose a stay reason by clicking on it. 

 

  If none of the listed Stay Reasons are appropriate and ‘Other’ is selected, a text box 

will display and you must type in a description of what your reason for the Stay Not 

Meeting Criteria is. You may type up to 500 characters into the text box.  

8.7 Selecting or Changing Recommended Level of Care 

The Recommended Level of Care dropdown will only display for reviews that have not met 

criteria. 

 

To select or change Recommended Level of Care 

1. Click the Recommended Level of Care dropdown. 

2. Select an option from the dropdown (Figure 67) by clicking on it. 
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Figure 67: Recommended Level of Care options 

  If none of the listed levels of care are appropriate and ‘Other’ is selected, a text box 

will display and you must type in a description of what the ‘other’ level of care involves. 

You may type up to 1,000 characters into the text box.  

8.8 Assigning a Physician Advisor to a Review that has Not 
Met Criteria 

Use this feature to assign a review that did not meet criteria to a Physician Advisor. You must 

choose a Physician Advisor or you will not be able to save the review and the message “Please 

Select a Physician Advisor” will display.  

 

To select a Physician Advisor to receive a review that has not met criteria 

1. Select the Physician Advisor Review dropdown and select a name by 

clicking on it (Figure 68). 

2. Once you click the <FINAL SAVE/Lock to Database> button, the review 

will be assigned to that individual and it will display the next time they open 

their Physician Advisor Worklist screen.  

 

 

Figure 68: Physician Utilization Management Advisor dropdown 
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8.8.1 Physician Advisor Review Not Required 

There is an overarching rule that all unmet reviews are sent to a Physician Advisor. NUMI gives 

you an option to indicate that a Physician Advisor Reviewer review is not required.  

 

  In order to check the box indicating that the Physician Advisor review is not required, 

a local facility policy must be in place defining the specific cases not requiring Physician 

Advisor review. If this box is checked and the unmet review is not sent for physician 

review, the review will still be stored in the NUMI database as an unmet review, and 

included in the unmet review reporting. 

 

To indicate that a Physician Advisor Reviewer is not required 

1.  Click the <Check here if criteria is NOT MET and formal 

hospital policy does NOT require physician review> checkbox 

(Figure 69) beside the Physician Advisor Reviewer dropdown list for the 

desired patient. 

2. Click the <FINAL SAVE/Lock to Database> button. 

3. A Physician Advisor Reviewer review will not be created. 

 

 

Figure 69: Physician Advisor Reviewer review not required checkbox indicator 

  If the checkbox is selected, you do not have to choose a Physician Advisor (and no 

Physician Advisor review will be created). And if a Physician Advisor had been selected 

from the dropdown and the checkbox was then selected, the system will ignore the 

Physician Advisor information. 

 

  If your facility policy does not require Physician Advisor review, the reviews that do 

not meet criteria will be included in reports and treated the same as all other reviews  

(including the requirement to select a Stay Reason and Recommended Level of Care), 

except that there is no Physician Advisor Review attached to the primary review. 
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8.9 Changing the Next Review Reminder Date 

Use this feature to indicate when the next review should be performed. The default is the next 

day’s date. This feature can also be used to defer reviews. For example, if a patient is going to be 

in the ICU for the next 3 days, you might choose to defer the next review and use the time to 

review other higher priority stays, then catch up with the deferred reviews later. 

 

To change the next review reminder date 

1. Click on the dropdown box beside the Calendar icon. 

2. Scroll through the calendar screens and select the desired date by clicking on 

it  (date field and calendar are shown in Figure 70) OR 

3. Type the desired date into the Next Review Reminder field.  

 

 

Figure 70: Next Review Reminder Date field with calendar displayed 

When a patient review reminder is set to a day outside of a date filter range, then the 

patient stay will disappear from the list. If you would like to use the Patient 

Selection/Worklist in such a way that when a review is performed, the patient disappears 

from the list, set the reminder date on the Primary Review Summary to an appropriate 

future reminder date (e.g.,  the next day), and then set the date filters to have an End Date 

prior to that day. If you don’t want the reviews to disappear from your Patient 

Selection/Worklist, then leave the End Date filter blank 

8.10 Indicating No More Reviews on a Stay  

Use this feature to indicate that no more reviews will be performed on a stay. For example, you 

might use this in a situation where a patient is discharged on Sunday, and a Continued Stay 

review was performed for Saturday. The patient is now discharged and the review no longer 

meets criteria. Selecting this option will ensure that the review no longer appears on the Patient 

Selection/Worklist unless a subsequent VistA movement brings the patient back to the list.  

 

To indicate that you will not be doing further reviews on a stay 

1. Click the <Check this box if you will not be doing further 

reviews on this stay> checkbox. (Figure 71).  

2. Click the <FINAL SAVE/Lock to Database> buttons to dismiss the 

reminder.  
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Figure 71: Further Review on Stay checkbox 

  Once you indicate that you will not be doing any further reviews on a stay, it will be 

removed from the table on the Patient Selection/Worklist. It will display on the screen again 

only after someone goes to the Dismissed Patient Stays and performs another review on it. 

(See Section 11.3 for more information about the Dismissed Patient Select screen.)  

Note: another movement may cause a stay to re-display on the Patient Selection/Worklist. 

8.11  Admitting Physician 

During the initial patient review, if the Admitting Physician field is not already populated by 

VistA, the reviewer should select an Admitting Physician. 

To select the Admitting Physician 

1. Click on the Admitting Physician dropdown. 

2. Select an option from the dropdown by clicking on it ( 

3. Figure 72). 

 

 
Figure 72: Admitting Physician dropdown 
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8.11.1 Adding an Admitting/Attending Physician  

If you can’t find your doctor in the Admitting Physician/Attending Physician dropdowns, you 

can add him/her to the dropdown using the “Add Physician” text box. The new physician name 

along with the current site ID will be added to the Physician table. 

 

To add an Admitting/Attending Physician: 

 

 

1. Click on the Add Physician button. 

2. In the pop-up window, type the Physician’s name. 

3. Click the Submit button. 

4. The new physician and current site ID are added to the Physician table. 

 

  As long as the physician’s name and the site ID are unique, they will be added and 

available for selection from the dropdown (Figure 73).  Every attempt should be made by 

the user to carefully examine the list to avoid duplicate name entry. The new Physician 

name should be entered in the format “LastName,FirstName(space)OptionalMiddleInitial”. 

Entries should not include titles (Dr. RN, etc.) and are limited to 100 characters in length. 

If you attempt to enter a duplicate physician, you will receive a warning:  The entered 
Physician Name already exists for your site. Please choose the Physician from the 
existing Physician drop down list(s).   
 

 
 

Figure 73 - Warning for Duplicate Physician Name 

 

 Attempts to enter a blank physician name in the Admitting Physician dropdown will 

not be accepted (Figure 74).  
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Figure 74 - Warning for Blank Physician Name 
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8.12 Working with Admission Sources 

When you select a patient for an Admission or BH Initial review and navigate to the Primary 

Review screen, the system will display the following list of options in the Admission Sources 

dropdown (also illustrated in Figure 75): 

 

 Scheduled Admission 

 Unscheduled Admission – ED 

 Unscheduled Admission – Clinic 

 Unscheduled Admission – Other 

 Transfer in – from VA Facility 

 Transfer in – from non-VA Facility 

 Other 

 

Figure 75: Admission Source Options 

8.12.1 Select /Change Admission Sources 

To select or change the Admission Sources 

 

1. Click on the Admission Source dropdown. 

2. Select an option from the dropdown by clicking on it. 

8.12.2 Selecting or Changing Attending Physician  

NUMI gives you a convenient way to select or change the Attending Physician information for a 

review, and associate the review with the correct Attending. This feature is especially handy in 

cases where the Attending information from VistA is not provided or is incorrect.   

 

To select or change Attending Physician 

3. Click on the Attending Physician dropdown (Figure 76).  

4. Select a new Attending by clicking on the name. OR 

5. Change the Attending by clicking on the dropdown and selecting another 

name. 

 

  

Figure 76: Attending Physician dropdown 
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8.13 Selecting or Changing Treating Specialty  

To select or change the Treating Specialty 

1. Click on the Treating Specialty dropdown (Figure 77).  

2. Select a Treating Specialty by clicking on it. OR 

3. Change the Treating Specialty by clicking on the dropdown and selecting 

another one. 

 

 

Figure 77: Treating Specialty dropdown 

8.14 Selecting or Changing Service Section  

To select or change the Service Section 

1. Click on the Service Section dropdown (Figure 78).  

2. Select a Service Section by clicking on it. OR 

3. Change the Service Section by clicking on the dropdown and selecting another 

one. 

 

 

Figure 78: Service Section dropdown 

  There may be instances where you may expect to see a particular Ward, Treating 

Specialty, Service Section or Admitting Physician, but the information does not display. 

The NUMI database will not include this information until NUMI first finds it in a patient 

movement record from VistA. While you cannot manually add this information to the 

dropdowns, you can use the Manual VistA Synchronization feature (please see Section 11.6 

for more information). Once the information has been synchronized and pulled into NUMI, 

the information will display in the dropdowns. 

8.15 Selecting or Changing Ward  

To select or change the Ward 

1. Click on the Ward dropdown (Figure 79).  

2. Select a Ward by clicking on it. OR 

3. Change the Ward by clicking on the dropdown and selecting another one. 

 

 

Figure 79: Ward dropdown 

8.16 Adding Custom Notes 

You may wish to enter special notes, to be used when you are doing a focused study or doing 

special tracking of some issue. NUMI provides you with a field specifically for that purpose. 

Some examples of when this feature would be used are: 
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 Tracking diabetic-related admissions 

 Tracking Operation Enduring Freedom/Operation Iraqi Freedom (OEF/OIF) patients 

 Entering the Admitting Physician 

 Flagging this review for special studies    

 

To add a custom note 

1. Click in the Custom field (shown in Figure 80) and type in up to 25 

characters’ worth of text. 

2. Click the <FINAL SAVE/Lock to Database> button and your notes will be 

saved. 

 

  

Figure 80: Custom field text example 

  NUMI lets you generate a report [Section 12.6] showing notes that were typed into the 

Custom field.   

8.17 Indicating an Unscheduled Readmit Within 30 Days 

This checkbox feature will only display on the screen if you are doing an admission or initial 

review. Use this feature to indicate that a patient was an unscheduled readmit to the hospital 

within the past 30 days (Figure 81).  

 

 

Figure 81: Unscheduled Readmit Within 30 Days checkbox 

 

To indicate an unscheduled readmit within 30 days 

4. Click on the Check if Unscheduled Readmit Within 30 Days checkbox 

to select.  

 

  NUMI lets you generate a report showing reviews performed on unscheduled 

readmissions. Please see Section 12.10 for more information. 

8.18 Working with Admission Review Types 

Review Type information comes over to NUMI in a separate field from CERME. The 

Admission Review Type dropdown list, shown in Figure 82, will only be displayed if the review 

type is an Admission or BH Initial review.  If the review type is Continued Stay or BH 

Concurrent, the dropdown will not be displayed. 

   

Figure 82: Admission Review Type dropdown 
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8.18.1 Admission Review Types for Admission Reviews 

When you select a patient for an Admission or BH Initial review and navigate to the Primary 

Review screen, the system will display the following list of options in the Admission Review 

Type dropdown (also illustrated in Figure 83): 

 

 Hosp Acute Adm - Traditional Criteria  (formerly called Hospital Acute Admission) 

 Hosp Acute Adm – Condition-Specific Criteria 

 Observation Converted to Hospital Admission 

 Conversion to New Condition-Specific Criteria 

 BH Initial Review 

 Transfer to Higher Level of Care 

 Transfer to/from Acute Care and BH 

 Observation Review 

 

 

Figure 83: Review Type Options 

8.18.2 Select / Change Admission Review Type 

To select or change the Admission Review Type 

 

1. Click on the Admission Review Type dropdown. 

2. Select an option from the dropdown by clicking on it. If you hover your mouse 

pointer over the dropdown you will see a tooltip advising that you can select 

multiple choices from the dropdown. 

  If you create an Admission or BH Initial review and do not select an Admission 

Review Type and then try to save/lock the review, a red error message will display ( 

 

Figure 84) and advise that you must select one of the valid types.  
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Figure 84: Admission Review Type error message 

  The information that displays on the NUMI reports will depend on the Admission 

Review Type that is selected on the Primary Review Summary screen. (See Chapter 12). 

8.19 Showing a Patient’s Reviews 

To show reviews for a patient 

1. Click on the <Show Reviews> button. 

2. Reviews for the patient will display in a table, as depicted in Figure 85. (Note 

that the button display changes to <Hide Reviews>). 

 

 

 

Figure 85: Show Reviews table display 

8.20 Copying a Review from the Primary Review Screen 

To copy a review from the Primary Review Summary screen 

1. Click on the <Show Reviews> button. 

2. Reviews for the patient will display in a table, as depicted in Figure 85.  

3. Clicking a View hyperlink in the table will display the <Copy This Review> 

button, and you can make a copy of the review from there.  



 

May 2014 NUMI User Guide 8-20 

8.21 Viewing CERME Review Text 

The lower half of the Primary Review Summary screen displays CERME Review Text. What 

displays depends on the criteria that have been selected, and is read-only. An example is shown 

in Figure 86. All possible subset criteria are displayed with an [X] to the left of the selected 

criteria. 

 

 

Figure 86: CERME Review Text example 

8.22 Saving and Locking a Final Review 

This feature will save and lock a review to the database. In order to be included in NUMI reports, 

a review must be locked into the database. If you lock a review and then later need to amend it, 

you can do this by clicking on the View link in the Reviews Table on the Patient Stay History. 

Clicking on View for a locked review will produce the saved review with boxes that allow you to 

unlock and edit, delete, or copy the review. 

 

To save changes to the database and lock the review 

 

1. Click the <FINAL SAVE/Lock to Database> button. 

2. The message “This review will now lock into the NUMI Database. 
Further changes require an administrator. Are you sure you are 

ready to lock this review?” will display, with <OK> and <Cancel> 

buttons. 

3. Click the <OK> button.  

4. While this period of saving and checking is occurring, all buttons and links on 

the page will be disabled, and an on-screen textual legend will appear, reading 

“Saving review. Please wait.” (Figure 87) This legend will disappear when the 

saving and checking are complete.  
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Figure 87: Saving review legend 

 

Additionally, if users attempt to leave the Primary Review Summary screen 

without saving their work, they will be informed of this fact via a dialog box, 

and be prompted as to whether they really wish to abandon their changes 

(Figure 88). 

 

 

 

Figure 88: Unsaved review message 

5. Click “OK”. 

6. The review will be locked and saved to the database and can then be accessed 

from the Utilization Management Review Listing screen in view-only format. 

(Please see Section 11.2 for more information about the Utilization 

Management Review Listing screen). 

 

If NUMI cannot confirm that the data has been saved, it will not proceed to the next screen. It 

will instead display an error message, “An error occurred during commit…” and leave the 

review data previously entered on the screen. The reviewer may again attempt to save the data. 

 

Figure 89: Commit error 

  Only reviews with ‘Don’t Meet Criteria’ status will go to the Physician Advisor Review 

screen from the Primary Review Summary screen. All reviews that are locked (both ‘Meets 

Criteria’ and ‘Don’t Meet Criteria’ statuses) will automatically be reported in the Date of 

Last Review field on the Patient Selection/Worklist. 
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  If you would like to perform another review on the same patient stay, you can do this 

by selecting a saved review from the Reviews table and copying it. There is a gold button on 

the Patient Stay History and Primary Review Summary screens that you can click on to see a 

listing of the saved reviews on a patient stay and make a copy from there, as well. (See 

Chapter 14 for more information). Reminder: the system will only permit you to save one 

continued stay review per day. 

 

 When you create a review, the Review Type comes pre-populated from CERMe.  In 

some instances, CERMe does not do this and the Review Type field is blank. NUMI will not 

let you save a review without the review type information. If the review you are working on 

has no review type information and you try to save it, you will now see the message: 
“Review Type cannot be blank. Please return to CERMe to select a Review Type 

and re-enter criteria”. To continue with your review, click the CERMe tab at the top 

of the Primary Review Summary screen, reselect your CERMe criteria, and you will be able 

to complete your review and save it. (Note: if you generate Report #1, if any reviews are 

missing the Review Type, those reviews will display at the top of the report.)     

8.23 Days Since Last VA Acute Care Discharge Calculation 

The NUMI system calculates the number of days since a patient’s last discharge from a VA 

facility. It displays the number in the Days Since Last VA Acute Care Discharge field. The 

field is above the Check if Unscheduled Readmit Within 30 Days checkbox field. 

 

If the value in the field is over 30 days, the reviewer will know that it is not possible for the stay 

to be an unscheduled readmission in less than 30 days. If the value in the field is less than 30 

days, the reviewer would then consider whether the stay is unscheduled. 

 

  

Figure 90: Days Since Last VA Acute Care Discharge field 

8.23.1 Calculation Rules 

The NUMI system shall display an error message, “The last VA discharge date is not 

available” in the Days Since Last VA Acute Discharge field when a prior stay does not 

have a discharge date.  

 

The NUMI system shall display “n/a” in the Days Since Last VA Acute Discharge field when 

there is no VA facility discharge. (illustrated in Figure 90).  

 

The NUMI system shall display the number of days between the last VA facility discharge date 

and the current VA facility admission date in the Days Since Last VA Acute Discharge field 

when there has been a prior VA facility discharge.  
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9 Saved Review Summary  

The Saved Review Summary screen offers a synopsis of information saved from the Primary 

Review screen.  This is accessed via the Utilization Management Review Listing screen, the 

Stay History screen and by clicking the View hyperlink. 

 

 

Figure 91: Saved Review Summary 
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Fields of interest include the following Primary Review Screen data available on the Review 

Summary screen: 

 

 Admitting Physician: The Admitting Physician will display if selected on the Primary 

Review screen 

 Admission Source: The Admission Source will display if selected on the Primary 

Review screen 

 Episode Day of Care: The most recent Episode Day of Care data will be viewable on the 

Saved Review Summary screen. For reviews created using criteria that are not condition 

specific, Episode Day of Care will be listed as “N/A” 

 Reason Code: The Reason Code will be viewable on the Saved Review Summary Screen 

for reviews where the criteria were not met. 

 Reason Description: The Reason Description will be viewable on the Saved Review 

Summary Screen for reviews where the criteria were not met. 
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10 Physician Advisor Review 

This chapter describes the Physician Advisor Review screen (Figure 93). Physician Advisors 

access this screen by selecting the Physician Advisor Review option from the Tools menu. This 

screen lets Physician Advisors see the reviews that have been sent to them (including the name 

of the sender). The features of this screen are listed in  

Table 10. 

 

  If you do not have Physician Advisor permissions, you will not see the Physician 

Advisor Review option in the Tools menu dropdown. 

 

Table 10: Physician Advisor Screen Features 

FEATURES 

The Physician Advisor Review 

Select a Physician Advisor Review 

Agree / Disagree with Current Level of Care 

Enter Physician Advisor Review Comments 

FINAL SAVE/Lock To Database 

 

  All reviews that are locked (both ‘Meets Criteria’ and ‘Don’t Meet Criteria’) will 

automatically go to the Patient Selection/Worklist screen from the Physician Advisor Review 

screen. 

 

  If a Primary Review is deleted, its associated Physician Advisor Review will also be 

deleted. 

10.1 Physician Advisor Review 

When this screen first opens, Physician Advisors will see a table with reviews that did not meet 

criteria and have been sent to them from a UM reviewer (Figure 93). If there are no reviews 

assigned, their list will be empty and “No Records Found” will display (Figure 92). 

 

 

 

Figure 92: Physician Advisor Review with no reviews assigned 
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  The Review Date column on the screen will always display the date with a time of 

00:00:00 underneath. This is not an error. The time will always display as 00:00:00 

(Midnight) because reviews are for the CALENDAR DAY.  

 

 

Figure 93: Physician Advisor list of reviews sent by Reviewers 

10.2 Selecting a Physician Advisor Review 

To select a review from the list 

1. On the Physician Advisor Review screen, click on the Review hyperlink on 

the far right side of the row of the review you wish to access. 

2. The Physician Advisor Review summary for that patient will display below 

the Physician Advisor Review screen, as shown in Figure 94. 

3. Immediately below the review list, you will see the Agree or Disagree 

response box and a Comments box. This is where the Physician Advisor 

enters information. All that is required from the Physician Advisor is an Agree 

or Disagree response. Additional comments are optional. If Other is selected, 

comments are required. 

4. Below the Agree or Disagree response box, the entire review is available for 

review. 
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Figure 94: Physician Advisor Review screen 

10.3 Agreeing / Disagreeing with Current Level of Care 

Use this feature to show concurrence or non-concurrence with the indicated Current Level of 

Care. 

 

To Agree with the Current Level of Care 

1. In the I AGREE with the current level of care section (Figure 95), 

click on the desired radio button. 

 

 

Figure 95: Agree Reasons 

To Disagree with the Current Level of Care 

1. In the I DISAGREE with the current level of care section (Figure 96), 

click on the desired radio button. 

 

 

Figure 96: Disagree Reasons 
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  If none of the listed Agree or Disagree options are appropriate and ‘Other’ is selected, 

a text box will display and you must explain what the Other reason is. You may type up to 

1,999 characters into the Agree and Disagree text boxes.   

 

10.4 Entering Physician Advisor Comments 

To enter Physician Advisor comments 

1. Type the desired comments into the Comments window. (You may type up 

to 4,000 characters). 

2. When you click the <FINAL SAVE/Lock to Database> button, your 

comments will be saved. 

10.5 Saving and Locking a Final Review 

This feature will save and lock a review to the database.  

 

To save changes to the database and lock the review 

1. Click the <FINAL SAVE/Lock to Database> button. 

2. The message “This review will now lock into the NUMI Database. 
Further changes require an administrator. Are you sure you are 

ready to lock this review?” will display, with <OK> and <Cancel> 

buttons. 

3. Click the <OK> button. The review will be locked and saved to the database 

and can then be accessed from the Utilization Management Review Listing 

screen in read-only format. (Please see Section 11.2 for more information 

about the Utilization Management Review Listing screen). 
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11 Tools Menu 

This chapter describes the Tools menu, which offers you different options that can be selected by 

clicking on them (Figure 97). It is a navigation menu that includes some features that are 

accessible through other screens and other features only accessible here. The Tools Menu 

dropdown is located at the top of several NUMI screens. You can choose options related to 

selecting patients and reviews, unlocking and deleting reviews (see Chapter 13 for more 

information), locating dismissed patient movements, accessing the Physician Advisor Worklist 

(if you are designated as a Physician Advisor on NUMI), and on-demand synchronization of stay 

information between VistA and NUMI. Note: the features you see in the dropdown will depend 

on your NUMI privileges (e.g., Physician Advisors will not see the Patient Selection/Worklist 

option; Primary Reviewers will not see the Physician Advisor Review, etc.) The features on the 

Tools menu are listed in Table 11. 

Table 11: Tools Menu features 

FEATURES 

Patient Selection/Worklist Option 

Utilization Management Review Listing Option  

(includes Unlock/Copy/Delete options, and Print Preview and Export to Excel features) 

Dismissed Patient Stays Option 

Free Text Search Option 

Physician Advisor Review Option 

Manual VistA Synchronization Option 

Patient Stay Administration Option 

Logout Option 

 

  

Figure 97: NUMI Tools Menu 
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11.1 Patient Selection/Worklist Option 

Select this option to work with the Patient Selection/Worklist screen, where you can select stays 

to perform primary reviews. This screen also contains paging features that allow you to navigate 

thru the information in the table on the screen. Use of the paging features is explained in Section 

2.1.20.  The Find and Reset buttons are available on the right hand side of the screen. Please see 

Chapter 5 for more information about the Patient Selection/Worklist. 

 

To work with the Patient Selection/Worklist 

1. Click on the Tools dropdown. 

2. Select the < Patient Selection/Worklist> option by clicking on it and 

the Patient Selection/Worklist will display (Figure 98).   

 

 

Figure 98: Patient Selection/Worklist screen 

11.2 Utilization Management Review Listing Option 

Select this feature to work with the Utilization Management Review Listing screen, where you 

can see reviews that have been locked to the database. Section 2.1.10 explains how to use the 

filters at the top of the screen, and use of the paging features is covered in Section 2.1.20. 

Observation stays can be included in results.  Please see Section 5.3 for more information.  

 

NUMI reviewers will be able to Unlock, Copy, and Delete reviews.  (See Chapter 13 for details 

about NUMI’s Unlock and Delete features, and Chapter 14 for details on copying.)  The 

hyperlinked patient name brings you to the Review Summary and CERMe Review Text screen 

for that particular patient. The Utilization Management Review Listing also provides Print 

Preview and Export to Excel buttons on this screen. (Figure 100).  These features work the 

same way that they do on the Report screens. Note: if more than 5,000 rows of information 

display in your search results, the Print feature will be disabled and the message in Figure 99 will 

display. Selecting additional filters to further refine your search and obtain fewer results will 

resolve this. Unlike the Print feature, there are no restrictions to how many rows you may export 

to Excel. Please see Section 11.2.1 and Section 11.2.2 for more information about Printing and 

Exporting information from this screen. 
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Figure 99: Print Function Disabled message 

To work with the Utilization Management Review Listing 

 

1. Click on the Tools dropdown. 

2. Select the <Utilization Management Review Listing> option by clicking 

on it. 

3. The Utilization Management Review Listing screen will display (Figure 

100). 

4. Selecting filters to search by and clicking the <Find> button will display a list 

of patients based on your search criteria, as shown in Figure 101.    

 

  Locked reviews will display a blue hyperlink. Clicking on these will open the Review 

Summary screen. Reviews that have been unlocked for editing will display a red hyperlink. 

Clicking on these will open the Primary Review screen. An example of the screen with red 

and blue links is shown in Figure 101.  

11.2.1 Printing Utilization Management Review Listing Screen 
Information 

To print out information on the screen 

1. Select the desired search filter options. 

2. Click the <Find> button. 

3. When the results display, click the <Print Preview> button. 

4. When the print preview window opens with results, select <File> from the 

menu bar and then select <Print>. If you prefer, you can just right-click in 

the preview window and click the <Print> option. 

11.2.2 Exporting Utilization Management Review Listing Screen 
Information 

To export the information on the screen to Excel 

1. Select the desired search filter options. 

2. Click the <Find> button. 

3. When the results display, click the <Export to Excel> button.  

4. A File Download dialog box may display indicating: Some files can harm 
your computer. If the file information below looks suspicious, 

or you do not fully trust the source, do not open or save this 

file. You may also see the message: “Would you like to open the file 

or save it to your computer?” along with Open, Save, Cancel and More 

Info buttons. To proceed, click the <Open> button. 

5. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 
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than specified by the file extension (Figure 119). Click the <Yes> button to 

continue.   

6. The report will display.  

7. Select the <File> dropdown and click on <Print> to print it out. 

 

 

Figure 100: Utilization Management Review Listing screen with grayed out Print and Export buttons 

 

 

Figure 101: Utilization Management Review Listing screen with results and selectable buttons 

11.2.3 Filtering Reviews by Free Text  

To filter by Free Text 

1. Type directly in the Free Text field. 

2. Click the <Find> button and the results will display in a table. To select a 

patient, click on their hyperlinked name in the Patient Name column. 

 

  Using Free Text, you can search for an exact word or phrase, for synonymous words, 

for partial words, or for a specific word, and the system will check the database for certain 

information. (The system searches the following to try to match what you’ve 

entered:  treating specialty, ward, patient name and SSN, movement, reviewer name, 
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attending physician name, comments, custom notes, and admitting diagnosis.  If the 

admitting physician name has been manually entered in the custom notes or comments 

fields, the search will find it).  

11.2.4 Filtering Reviews by Date  

To filter by Date 

1. Click on the Date filter checkbox to activate it. 

2. Select a date from the Start Date dropdown by clicking on it. (Start Date is 

from 12:00  a.m. that day) 

3. Select a date from the End Date dropdown by clicking on it. (End Date is 

until 11:59 p.m. that day) 

4. Click the <Find> button and the results will display in a table. 

 

  To select only one day, select the same date for the Start and End Date fields. Entering 

the Start Date only will give you the start date and everything after. Entering the End Date 

only will retrieve everything up to, and including, the end date. 

11.2.5 Filtering Reviews by Reviewer  

To filter by Reviewer 

1. Click on the Reviewer filter checkbox to activate it. 

2. Select another option from the dropdown by clicking on it OR 

3. Select “All” to see all (regardless of whether a reviewer has been assigned or 

not) OR 

4. Click the <Find> button and the results will display in a table. 

11.2.6 Filtering Reviews by Attending 

To filter by Attending 

1. Click on the Attending filter checkbox to activate it. 

2. Select an Attending from the dropdown list by clicking on it OR 

3. Select “All” to see the Attendings for all reviews  OR 

4. Click the From VistA checkbox to see Attendings from VistA  OR 

5. Click the Corrected checkbox to see all Attendings that were corrected after 

coming across to NUMI from VistA. 

6. Click the <Find> button and the results will display in a table. 

11.2.7 Filtering Reviews by Ward  

To filter by Ward 

1. Click on the Ward filter checkbox to activate it. 

2. Select a Ward from the list by clicking on it. To select multiple Wards, click 

on one, then hold the <Ctrl> key down and click on others. You can also 

press and hold the <Shift> key down to select a block of Wards. OR  

3. Select “All” to see the Wards for all reviews.  
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4. Click the <Find> button and the results will display in a table. 

 

  There may be instances where you may expect to see a particular ward in the Ward 

dropdown, but it does not display. Ward lists are populated as movements for those wards 

occur. For example, a patient you are looking for has been in a bed for a while and has not 

had any movements. Their information has not been picked up by the overnight 

synchronizer yet because there weren't any qualifying movements. While you cannot 

manually add a ward to the dropdown, you can use the Manual VistA Synchronization 

feature (please see Section 11.6 for more information) to search for a patient that you know 

is in a particular ward. Once their information has been synchronized and pulled into 

NUMI, that ward will display in the Wards dropdown. 

11.2.8 Filtering Reviews by Service/Specialty/Status  

To filter by Service/Specialty/Status 

1. Click on the Service/Specialty/Status filter checkbox to activate it. 

2. Select options from the Service and/or Specialty and/or Status dropdowns 

by clicking on them. 

3. Click the <Find> button and the results will display in a table. 

11.2.9 Filtering Reviews by Review Type 

To filter by Review Type 

1. Click the Review Type filter checkbox to activate it. 

2. Select an option from the dropdown by clicking on it. 

3. Click the <Find> button and the results will display in a table. 

11.3 Dismissed Patient Stays  

This feature opens the Dismissed Patient Stays screen. This is where patient stays that were 

dismissed from the Patient Selection/Worklist screen will display. The screen contains the same 

filters that appear on the Patient Selection/Worklist screen. Section 2.1.10 describes the use of 

these filters. Observation stays can be included in results.  Please see Section 5.3 for more 

information.  The hyperlinked patient name brings you to the NUMI Patient Stay History screen 

for that particular patient. The Dismiss Stays button is also available for dismissing selected 

stays with the selected Dismiss Type. For more information about dismissing patient stays, 

please see Section 5.5.  

 

When the screen opens, a series of filters will display. The Date checkbox will be pre-selected, 

as will the Start Date and End Date checkboxes. A 1 week date range, to include the last day of 

the week, will also be pre-populated. The default Start and End dates will appear as the last 

week, even after clicking the Reset button, but each time they appear on the screen, these dates 

can be changed (Figure 102). After obtaining search results, this screen could potentially display 

several thousand stays, so paging features have been built into it so you can view next, previous, 

first and last pages, and indicate how many rows of results you would like to see in each page of 

the table. Please see Section 2.1.20 for more information).  
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The following informational message displays on the screen under the Find and Reset buttons: 
“Click FIND to list all dismissed stays meeting the filters specified above. 

To create a different stay list, click RESET, select your filter criteria and 

click FIND”.  

 

A Dismissal Type checkbox below the Reviewer criteria allows you to select Dismissal Type 

search criteria from the dropdown. When you initiate a search, this criteria will be applied to 

your search. After a search, the Dismissed Patient Select Screen presents three related columns: 

Dismissed By, Dismissed On, and Dismissal Type.  

 

  “Non-reviewable” Treating Specialties (i.e., Domiciliary, Nursing Home, Outpatient 

and Rehab) will be intercepted as they come from VistA into NUMI, and automatically 

moved to the Dismissed Patient Stays screen. Each evening, treating specialties that are not 

reviewable in NUMI will automatically be marked “inactive” and moved to the Dismissed 

Patient Stays screen after the information is sent to NUMI from VistA. (“Inactivated” stays 

will not appear on the Patient Selection/Worklist screen unless a review is performed on 

them).  To identify stays that are not reviewable, the system looks for one of the following 

in the Treating Specialty description: DOM, NH, OUTPATIENT, REHAB. The system 

then sets the stays to ‘dismissed’ and moves them to the Dismissed Patient Stays. (This can 

be overridden by the Dismissal Administrative setting(s).  This is a scheduled job that will 

run daily. As the synchronizer runs throughout the day, there is a chance for additional 

non-reviewable specialties to appear in NUMI. 

 

  While working on the screen, you may see a message, “Error Occurred Loading the 

Page. Please click your browser’s Refresh button and try again” advising there 

was a problem loading the webpage (Figure 18). Refreshing your browser will reload the 

webpage and display the NUMI screen.   You may also want to 1.) Check to see if you 
have a blank Start Date and/or End Date field and 2.) Check to see if the 

date range you have selected produces too many stays in the results. Narrow 

your date range to produce a smaller number of stays  

 

To work with the Dismissed Patient Stays 

1. Click on the Tools dropdown. 

2. Select the < Dismissed Patient Stays > option by clicking on it and 

the Dismissed Patient Stays screen will display, as shown in Figure 102.   

3. Select the desired search filters and click the <Find> button. (If there are 

no dismissed movements, ‘No Records Found’ will display on the 

screen). 

4. After the results display, to see a particular patient stay, click on the 

hyperlinked patient name in the Patient Name column.  

 

  Once a patient review has been performed, the patient’s name will be removed from 

the Dismissed Patient Stays screen and will re-display on the Patient Selection/Worklist 

screen.   
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Figure 102: Dismissed Stays screen with 1 week default date range 

After obtaining search results on the Dismissed Patient Stays screen, when you click on the 

Reset button the system will restore all fields to their default values, except the 1 week default 

date range.  The fields and default values are: 

 

 Date – Checkbox selected and defaults with a 1 week range (this timeframe keys off the 

Next Review Date)   

 Reviewer – Checkbox not selected and will display the logged in user’s name   

 Ward – Checkbox not selected and defaults to All 

 Treating Specialty and Service – Checkbox not selected and defaults to All 

 Movement– Checkbox not selected and no default values display 

 Patient Search – Checkbox not selected and no default values display 

11.4 Free Text Search Option 

This feature lets you type information in and search by exact words, similar words, partial words 

or specific words. Observation stays can be included in results.  Please see Section 5.3 for more 

information.  You can filter by Date, Reviewer, Ward, Treating Specialty and Service, 

Movement and Patient Search. When you search using free text, the system will check for certain 

types of information.   

 

To work with the Free Text Search option 

1. Click on the Tools dropdown. 

2. Select the <Free Text Search > option by clicking on it and the Free Text 

Search screen will display, as shown in Figure 103.  (See Section 2.1.10 for 

more information about how to use NUMI filters, and Section 11.2.3 for 

more information about using the free text search options).  

3. To select a patient for review from the Free Text Search screen, just click on 

the hyperlinked name of the patient.  

 



 

May 2014 NUMI User Guide 11-9 

 

Figure 103: Free Text Search screen 

  The NUMI free text search will search the following to try to match what the user 

enters: treating specialty, ward, patient name and SSN, movement type, reviewer name, 

review comments, review custom field, attending physician name, and admitting diagnosis.  

 

The NUMI free text search is based on whole words (with the exception of the Partial Word 

match explained below) so you should enter whole words in the Free Text field.  An explanation 

of each search option and examples are given below. 

 

Exact – The whole exact phrase is searched for. 

Example:  cardiology department – This will match the phase “cardiology department”.  It will 

not match a field containing only “cardiology” or “department”. 

 

Similar Word – Does a search using the database Thesaurus to search for the word or similar 

words.  This search is dependent on the Thesaurus installed for the NUMI database.  Currently, 

there is no Thesaurus installed for NUMI so this search is unreliable. 

 

Partial Word – Searches for words that begin with the word entered in the Free Text field. 

Example:  bio – This will match “bioscience” or “biosphere” but will not match 

“autobiography”. 

 

Specific Word – Searches for words that are based on the word entered in the Free Text field. 

Example:  ride – This will match words based off of ride such as “rider” or “riding”. 

 

Note: when searching for a phrase in the Patient Review comments or custom field, only the 

latest review for a given stay will be searched for the phrase (or word). 

11.5 Physician Advisor Review Option 

This feature opens the Physician Advisor Review screen (Figure 104). This is where Physician 
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Advisors will be able to access and work on the reviews that have been assigned to them. (See 

Chapter 1 for more information about this screen). 

 

To work with the Physician Advisor Review  

1. Click on the Tools dropdown. 

2. Select the <Physician Advisor Worklist> option by clicking on it. 

3. The Physician Advisor Review screen will open. If a Physician Advisor has 

reviews assigned to them, the reviews will display in a table.  

 

  Only reviews with ‘Don’t Meet Criteria’ status will go to the Physician Advisor Review. 

 

 

Figure 104: Physician Advisor Review screen 

11.6 Manual VistA Synchronization Option 

This feature lets you synchronize stay information between VistA and NUMI. An automatic feed 

containing admissions, ward transfers, discharges and provider and specialty changes is sent to 

NUMI from VistA at the top of each hour during the day, and at midnight.  Stays that were 

dismissed the previous day will not redisplay in the Patient Selection/Worklist after the midnight 

synchronizer information feed occurs.  (Note: if information changes in VistA, the information in 

NUMI will be overwritten / overlaid in the next feed. It should also be noted that resynching with 

VistA will always update the stay data, but the review data will not be overwritten). When you 

synchronize a patient or several patients, you are bringing VistA information on those patients 

into NUMI and placing those patient stays in your Patient Selection/Worklist. 

 

With the Manual VistA Synchronization feature, you do not need to wait for a feed. You can 

retrieve and synchronize information on-demand. This feature comes in handy when you know a 

patient has been admitted to the hospital (or transferred to another Ward – a frequent occurrence 
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during the day) and is in VistA, but you do not see them in NUMI yet. As an added convenience, 

the table on the screen includes Ward, Specialty and Admitting Diagnosis information to help 

you identify which patients need to be “synched” onto the Patient Selection/Worklist. 

 

  You can only synchronize by Date OR by Checkin ID OR by Patient on this screen. In 

addition, please note that if you only enter a date without a patient name, everything for 

that date will be synchronized.  

 

  You must click on the Date, Checkin ID or Patient Search radio buttons in order to 

activate the search filters on the Manual VistA Synchronization screen. For more 

information about using the filters in NUMI, please see Section 5.4 in this guide. 

 

  While working on the Manual VistA Synchronization screen, you may see a message 

in red text advising that the server is busy (Figure 105). Perform your last action (e.g., re-

click a button; re-select a hyperlink) to retry.    

 

 

 

Figure 105: Server Busy Error Message 

To work with the Manual VistA Synchronization 

1. Click on the Tools dropdown. 

2. Select the <Manual VistA Synchronization> option by clicking on it, and 

the Manual VistA Synchronization screen will display. 

3. Click the Date radio button, and select or type the desired date in the 

Movement Start Range field. If you type in the date, use the format 

mm/dd/yyyy. 

4. Select a specific time range, if desired, by clicking in the Hour fields and 

entering the desired hours (e.g.,  06:00 thru 11:00) OR 

5. Click the Patient Search radio button, type in a Patient name (in <Lastname, 

Firstname> format) and click the <Find Patient> button. Then single-click 

on a patient name in the result window to select it. If you do not select a 

patient, the message “You must select a patient.” will display (Figure 

109) OR 

6. Click the Checkin ID radio button and type in a Checkin ID, if you know it.
2
 

(You can always search by Date or Name and the Checkin ID will be 

displayed in the search results, as shown in Figure 106). If the patient isn’t in 

NUMI but has an inpatient stay in VistA, you can add them to NUMI by 

searching for them by date range or patient name. If the patient doesn’t have 

any inpatient stays in VistA, they will display in the search by patient list but 

no stays will be returned. If the patient’s admission is not in NUMI, you can 

                                                 
2
 The NUMI Checkin ID (or “Movement ID” field in the Stay Movements grid on the Patient Stay History screen) 

is the internal record number in the VistA Patient Movement file #405, which is not visible to end users. 
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synchronize with VistA by entering the Admission date, which will add the 

Admission movement to NUMI.  

 

   If NUMI still can’t find the admission, you may need to get the VistA Patient 

Movement file admission movement’s internal entry number (IEN) from your local IRM 

and enter it as the Check In ID, then click <Find Stays in VistA> and, when the list 

appears, click on the box to the left of the ones you want to add to NUMI and press 

<Synchronize Stays>.  Note: The number displayed as the Movement ID on the Patient 

Stay History screen corresponds to the VistA Patient Movement IEN if the movement 

already appears in NUMI. 

 

7. Click the <Find Stays in VistA> button. 

8. When the search results display, click on the checkboxes in the far left hand 

column in the row for each patient stay you wish to synchronize into NUMI 

and display on the Patient Selection/Worklist (Figure 107).  

9. Click the <Synchronize Stays> button. 

10. The message: “Synchronized <number> stays for site <site 

number>” will display on the screen (Figure 108).  

 

 

Figure 106: Manual VistA Synchronization search results screen 
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Figure 107: Stays selected for Synchronizing 

 

 

Figure 108: Synchronized Stays confirmation message 

 

 

Figure 109: Patient Search Message 
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11.7 Patient Stay Administration Option 

This option can only be used by NUMI Administrators. While non-Administrator users will see 

this option displayed in the Tools menu, selecting it will display an error message (i.e., “You are 

not authorized to administer patient stays at this site”). If a VistA patient stay is 

entered in the NUMI database and VistA subsequently deletes the stay, NUMI will display an 

“invalid stay” message when the NUMI user clicks the review link for the deleted 

stay.  Additionally, NUMI will move the NUMI patient stay record to the Patient Stay 

Administration screen. NUMI Administrators can use the Patient Stay Administration screen to 

verify the status of the stay in VistA and delete NUMI patient stay records that are no longer in 

VistA. 

 

Here is some background information about how this process works: 

 

Patient Stay Movements are entered into VistA and then synchronized into the NUMI database. 

Every time a stay is touched in NUMI, NUMI goes back to VistA to update the stay record with 

any changes in VistA. If nothing is returned from VistA when the record is requested, then 

NUMI marks its record of the stay as “invalid”, and removes it from the Patient 

Selection/Worklist. It is put in a limbo state, but not deleted. NUMI Administrators can then 

review the invalid stays using this screen. Selecting them from the table will cause NUMI to 

again try to retrieve them from VistA. If NUMI can retrieve the stay, then the Administrator has 

the option of selecting the Restore button to reactivate the stay. 

 

To access the Patient Stay Administration feature 

1. Click on the Tools dropdown. 

2. Select the <Patient Stay Administration> option.  

3. The Patient Stay Administration screen displays with a list of invalidated stays 

(Figure 110). 

 

 

Figure 110: NUMI Patient Stay Administration screen 
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Note: Observations can be included in results.  Please see Section 5.3 for more information. 

11.7.1 Finding Patient Stays that were Removed from VistA 

To find patient stays that were removed from VistA 

1. Choose search filters by clicking on the checkboxes in the filter headers. This 

will activate the options in each filter. (For more information about NUMI 

filters, please see Section 2.1.10). 

2. Choose the desired options from each filter and click the <Find> button.  

3. A list of patient stays matching your search criteria will display in a table.  If 

your search produces no results, No Records Found will display.  

11.7.2 Restoring a Patient Stay 

To restore a patient stay 

1. Click the Validate hyperlink beside the stay you wish to restore. 

2. Click the <OK> button when this message displays: “Stay <number> for 
patient <patient name> has been retrieved from VistA. Please 

click on the Restore button to set it as valid in NUMI.” (Figure 

111).  

 

 

Figure 111: Stay retrieval advisory message. 

 

3. Click the Restore button in the center of the screen (illustrated in Figure 112). 

4. The screen will refresh and the patient record will no longer display in the table. 

5. The patient will display in the table on the Patient Selection/Worklist screen. 
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Figure 112: Patient Stay Administration with Restore button displayed 

11.8 Logout Option 

This feature will take you to the logout screen. 

 

To access the Logout option 

1. Click on the Tools dropdown. 

2. Select the <Logout> option by clicking on it. 

3. The Logout screen opens. (See Chapter 16 for more information about 

logging out of the NUMI application). 
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12 Reports Menu 

This chapter describes the Reports Menu (Figure 113). If you have report-access privileges you 

can generate a variety of on-demand reports that can be printed out on your local printer or 

exported to an Excel spreadsheet and printed from there. Some reports were designed to display 

in landscape orientation (vs. portrait) – those display an (L) in the menu dropdown. Marking 

those reports that way was intended to indicate that you should print them out in landscape 

mode.  Some reports have less ‘real estate’ than others, and printing those particular reports out 

in Landscape orientation produces nicer output. 

 

For convenience, the reports are numbered 1 thru 12. This eliminates the need to remember the 

exact name of any particular report. The Reports Menu dropdown is on the menu bar located 

along the top of most NUMI screens.  

 

It is important to note that the reports will not generate until the <Find> button is clicked. In 

addition, the report search filters are ‘sticky’. This means that if you choose dates, radio buttons 

or dropdown options, your choices will remain populated until you either manually change the 

dates or click on the calendar and then click on ‘Clear Date’, or select different radio buttons or 

dropdown options - or leave the report altogether. If you leave a report and then come back to it, 

all of the search filters will be reset to the original settings.  

 

Based on the Admission Review Type selection that is made on the Primary Review screen, the 

output on the reports will vary. Please see Section 8.18 for more information about working with 

admission review types.  Each report (with the exception of Reports #3 and #7) will have an 

Admission Review Types dropdown.   *Note: Only the Hosp Acute Adm-Traditional Criteria 

(formerly called Hospital Acute Admission), Hosp Acute Adm – Condition-Specific Criteria 

(Admission reviews only), Observation Converted to Hospital Admission, Conversion to New 

Condition-Specific Criteria (Admission reviews only), BH Initial Review, Transfer to Higher 

Level of Care and Transfer to/from Acute Care and BH options are selectable when entering 

reviews on the Primary Review screen. Other review types are included as selections when 

generating reports because they were used in previous versions of NUMI. 

 

Reports #s 1, 2, 4, 5, 6, 8, 9, 11 and 12 will display these general Admission Review Type 

options, in the order listed: 

 All Admission Reviews 

 Hosp Acute Adm – Traditional Criteria 

 Hosp Acute Adm – Condition-Specific Criteria   

 Observation Converted to Hospital Admission   

 Conversion to New Condition-Specific Criteria   

 BH Initial Review  

 Transfer to Higher Level of Care 

 Transfer to/from Acute Care and BH 

 Admission Review –Type Unknown 

 

Report #10 will display the Admission Review Type options below, in the order listed: 
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 Hosp Acute Adm – Traditional Criteria 

 Hosp Acute Adm – Condition-Specific Criteria 

 Observation Converted to Hospital Admission 

 BH Initial Review 

 

The contents of the reports will display as follows, when the various options are selected: 

 

 If the All Reviews filter option is selected, the report will display all review types 

 If the All Admissions filter option is selected, the report will display Hospital Acute 

Admission, Admission Review: Type Unknown, BH Initial Review, Transfer to Higher 

Level of Care and Transfer to/from Acute Care and BH reviews 

 If the Not an Admission Review filter option is selected, the report will display all 

Continued Stay and BH Concurrent review types 

 If the Hosp Acute Adm – Traditional Criteria filter is selected, the report will display 

Hosp Acute Adm – Traditional Criteria and BH Initial reviews 

 If the Hosp Acute Adm – Condition-Specific filter is selected, the report will display Hosp 

Acute Adm – Condition-Specific reviews 

 If the Observation Converted to Hospital Admission filter is selected, the report will only 

display reviews for observation patients that were not discharged within the required 24 

hour period, then were admitted to acute care (Note: this filter is not available on Reports 

#3 and #7) 

 If Conversion to New Condition-Specific Criteria filter is selected, the report will display  

Conversion to New Condition-Specific Criteria  reviews 

 If the BH Initial Review filter is selected, the report will only display BH Initial reviews 

 If the Transfer to Higher Level of Care filter is selected, the report will only display 

Transfer to Higher Level of reviews 

 If the Transfer to/from Acute Care and BH filter is selected, the report will only display 

Transfer to/from Acute Care and BH reviews 

 If the Admission Review - Type Unknown filter is selected, the report will only display 

Admission Review: Type Unknown reviews 

 

Report #s 5, 6, 7, 8, 9, 10 and 12 include the following columns captured from CERMe: 

 Criteria Subset:  

 Episode Day of Care: Most recent day of care where applicable. 

 Reason Code: This column shows data only for not-met reviews. 

 Reason Description: This column shows data only for not-met reviews. 

 

Enhanced Reporting is available in NUMI. For information about this option and the 

underlying reports and when they are available for selection, please see Section 12.13. 

 

The NUMI reports are listed in Table 12. 
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Table 12: Reports Menu list of reports 

FEATURES 

Report #1 - Summary Met/Not Met  

Report #2 - Reasons for Admission Reviews Not Meeting  

Report #3 - Reasons for Continued Stay/Concurrent Reviews Not Meeting Criteria  

Report #4 - Summary RLOC Reasons  

Report #5 - Patient Reviews Met/Not Met  

Report #6 - Patient Reviews Met/Not Met ‘Custom’  

Report #7 - Patient Detail  

Report #8 - Physician Advisor Reviews  

Report #9 - Physician Advisor Response  

Report #10 - Unscheduled Readmits in Less Than 30 Days  

Report #11 - RLOC Aggregate  

Report #12 – Clinical Comments Detail  

Enhanced Report Menu 

 

 

 

Figure 113: Reports Menu 
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12.1 Report #1 - Summary Met/Not Met  

This report summarizes the reviews that Meet and Don’t Meet criteria, displayed in descending 

sort order within the Admission and Continued Stay categories. The count of reviews on the 

report output will match the count of saved/locked reviews that display on the Utilization 

Management Review Listing screen. You can generate the report by Attending MD, Reviewer, 

Service Section, Treating Specialty and Ward Location, and print it out on your local printer or 

export it to Excel. (If you run this report and any reviews have a blank Review Type, those 

reviews will display at the top of the report. The resulting report list will be subtotaled by 

Review Type with observation reviews listed before other non-observation reviews.  The grand 

total of the report includes the count of reviews with blanks).  

 

To generate the report 

1. Click the Reports menu dropdown. 

2. Click on 1: Summary Met/Not Met. The search filters will display  (Figure 

114). 

 

 

Figure 114: Percent of Reviews Meeting Criteria filters 

 

 

Figure 115: Admission Review Types list display 
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3. Select an option from the Current Lookup Site dropdown by clicking on it. 

4. Select the “Include Observations” check box if so desired. (See Section 5.3 

for details.) 

5. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format 

mm/dd/yyyy. 

6. Select a Review By radio button by clicking on it.  

7. A corresponding dropdown will display for the radio button you chose 

(Figure 114).  

8. Select an option from the dropdown by clicking on it.  

9. Select a single option from the CERMe Review Types pick list by clicking 

on it.  (If you select Admission or BH Initial Review, the Admission Review 

Types pick list will display (Figure 115). 

10. Select one or more options by clicking on them. (Note: the information that 

displays on this report when each of the admission review type filter options 

is selected will vary. Please see Section 8.18 for details). 

11. Be sure to click the <Find> button after you select ALL of the report 

parameters. As soon as you select the <Find> button, you will see report 

information. If you specify other parameters such as Start and End dates, 

don’t forget to click on <Find> to generate your specific report. The subtitle 

on the report will contain the parameters you specify, so double-check that 

all of your parameters are specified in the sub-title.  

12. The report output will display, as illustrated in Figure 116. 

 

 

Figure 116: Percent of Reviews Meeting Criteria output 

 

13. To print, click the <Print Preview> button.  

14. When the Print Report preview window opens, (Figure 117) right click to 

display browser menu and then select ‘Print’ to display the local Print Dialog 

box.   

15. When the Print Dialog Box opens, select printer and printer options and 

finally select the Print button to print the report. 
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Figure 117: Percent of Reviews Meeting Criteria printout 

 

16. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

17. A File Download dialog box may display indicating: “ Do you want to 
open or save Report<report name>.xls(1.44 KB)from <server 

name>?” along with Open, Save, and Cancel buttons (Figure 118).  If it 

does, click  the <Open> button. 

 

 

Figure 118: Export to Excel download advisory 

 

 

Figure 119: Excel format dialog box 

 

18. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed. 
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19. The report will be displayed, as illustrated in Figure 120.  

20. Select the <File> dropdown in Excel and click on <Print> to print it out.  

 

 

Figure 120: Percent of Reviews Meeting Criteria spreadsheet 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

12.2 Report #2 - Reasons for Admission Reviews Not Meeting 
Criteria  

This report will show you a distribution listing of Admission reviews not meeting criteria, sorted 

in descending order within each subcategory of reasons. The resulting report list will be 

subtotaled by Review Type with observation reviews listed before other non-observation 

reviews.  You can generate the report by Attending MD, CERMe Review Types, Treating 

Specialty or Ward Location, and print it out on your local printer or export it to Excel. 

 

To generate the report 

1. Click the Reports menu dropdown. 

2. Click on 2: Summary Adm Reasons. The search filters will display (Figure 

121).  
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Figure 121: Reasons for Admission Reviews Not Meeting Criteria filters 

 

3. Select an option from the Current Lookup Site dropdown by clicking on it. 

4. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

5. Click on the Start Date and End Date calendar icons and select dates by clicking 

on them. You can also type in the date, using the format mm/dd/yyyy. 

6. Select a Review By radio button by clicking on it.  

7. A corresponding dropdown will display for the radio button you chose (not shown 

in Figure 121.  

8. Select options from the dropdown by clicking on them.  

9. If you choose the CERMe Review Types radio button, CERMe Review Types 

will display inside the selection box (Figure 122). The system will only let you 

select a single option from this dropdown.  When an option is selected, the 

Admission Review Types pick list will display (Figure 115).  

10. Select one or more options by clicking on them. (Note: the information that 

displays on this report when each of the admission review type filter options is 

selected will vary. Please see Section 8.18 for details). 

11. Be sure to click the <Find> button after you select ALL of the report parameters. 

As soon as you select the <Find> button, you will see report information. If you 

specify other parameters such as Start and End dates, don’t forget to click on 

<Find> to generate your specific report. The subtitle on the report will contain the 

parameters you specify, so double-check that all of your parameters are specified 

in the sub-title.  

12. The report output will display, as illustrated in Figure 122. 
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Figure 122: Reasons for Admission Reviews Not Meeting Criteria output 

 

13. To print, click the <Print Preview> button.  

14. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 123). 
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Figure 123: Reasons for Admission Reviews Not Meeting Criteria printout 

 

15. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

16. A File Download dialog box may display indicating: Do you want to open or 

save Report<report name>.xls(1.44 KB)from <server name>” along with 

Open, Save, and Cancel buttons (Figure 118). If it does, click the <Open> button. 

17. Excel will open. Note: if you are using Excel version 2007, you may see a dialog 

box advising that the file you are trying to open is in a different format than 

specified by the file extension (Figure 119). Click the <Yes> button to proceed.  

18. The report will display, as illustrated in Figure 124.  

19. Select the <File> dropdown and click on <Print> to print it out. 
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Figure 124: Reasons for Admission Reviews Not Meeting Criteria spreadsheet 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

12.3 Report #3 - Reasons for Continued Stay/Concurrent 
Reviews Not Meeting Criteria  

This report will show you Continued Stay/Concurrent Reviews that did not meet criteria. The 

resulting report list will be subtotaled by Review Type.  You can generate the report by 

Attending MD, CERMe Review Type, Treating Specialty or Ward Location, and print it out on 

your local printer or export it to Excel. 

 

To generate the report 

1. Click the Reports menu dropdown. 

2. Click on 3: Summary CS Reasons. The search filters will display (Figure 

125).  

 

 

Figure 125: Reasons for CS/Concurrent Reviews Not Meeting Criteria filters 
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3. Select an option from the Current Lookup Site dropdown by clicking on it. 

4. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 

5. Select a Review By radio button by clicking on it.  

6. A corresponding dropdown will display for the radio button you chose (not 

shown in Figure 125).  

7. Select options from the dropdown by clicking on them.  

8. If you choose the CERMe Review Type radio button, a CERMe Review 

Type dropdown will display with non-admission options (Figure 126). The 

system will only let you select a single option from this dropdown.   

9. Select an option from the dropdown by clicking on it. 

10. Be sure to click the <Find> button after you select ALL of the report 

parameters. As soon as you select the <Find> button, you will see report 

information. If you specify other parameters such as Start and End dates, don’t 

forget to click on <Find> to generate your specific report. The subtitle on the 

report will contain the parameters you specify, so double-check that all of 

your parameters are specified in the sub-title.  

11. The report output will display, as illustrated in Figure 127. 

 

 

Figure 126: Non-Admission CERMe Review Type options 

 

 

Figure 127: Reasons for CS/Concurrent Reviews Not Meeting Criteria output 

 

12. To print, click the <Print Preview> button.  

13. When the Print Report preview window opens, right-click in the preview 



 

May 2014 NUMI User Guide 12-13 

window and click the <Print> option (Figure 128).  

 

 

Figure 128: Reasons for CS/Concurrent Reviews Not Meeting Criteria printout 

 

14. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

15. A File Download dialog box may display indicating: Do you want to open 

or save Report<report name>.xls(1.44 KB)from <server name>” 

along with Open, Save, and Cancel buttons (Figure 118). If it does, click the 

<Open> button. 

16. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed.   

17. The report will display, as illustrated in Figure 129.  

18. Select the <File> dropdown and click on <Print> to print it out. 

 

 

Figure 129: Reasons for CS/Concurrent Reviews Not Meeting Criteria spreadsheet 

 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 
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12.4 Report #4 - Summary RLOC Reason  

This report provides a report of Recommended Level Of Care Reasons for Not-Met reviews and 

is generated in landscape orientation. The resulting report list will be subtotaled by Reason 

Description with observation reviews listed before other non-observation reviews.  You can print 

the report out on your local printer or export it to Excel. 

 

To generate the Report 

1. Click the Reports menu dropdown. 

2. Click on 4: Summary RLOC Reason (L). The search filters will display 

(Figure 130).  

 

 

Figure 130: Summary RLOC Reason Criteria filters 

 

3. Select an option from the Current Lookup Site dropdown by clicking on it. 

4. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

5. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 

6. Click on the Service Section dropdown.  

7. Select an option by clicking on it. To select more than one option, hold down 

the <Ctrl> key before clicking on each one. 

8. Select an option in the Treating Specialty dropdown by clicking on it. To 

select more than one option, hold down the <Ctrl> key before clicking on 

each one. 

9. Select an option from the CERMe Review Type pick list by clicking on it. If 

you select Admission or BH Initial Review, the Admission Review Types 

dropdown will display (Figure 115).  

10. Click the Admission Review Types dropdown. Select one or more options by 

clicking on them. (Note: the information that displays on this report when 
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each of the admission review type filter options is selected will vary. Please 

see Section 8.18 for details). 

11. Be sure to click the <Find> button after you select ALL of the report 

parameters. As soon as you select the <Find> button, you will see report 

information. If you specify other parameters such as Start and End dates, don’t 

forget to click on <Find> to generate your specific report. The subtitle on the 

report will contain the parameters you specify, so double-check that all of 

your parameters are specified in the sub-title.  

12. The report output will display, as illustrated in Figure 131. 

 

 

Figure 131: Summary RLOC Reason output 

 

13. To print, click the <Print Preview> button.  

14. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 132). 
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Figure 132: Summary RLOC Reason printout 

 

15. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

16. A File Download dialog box may display indicating: Do you want to open 

or save Report<report name>.xls(1.44 KB)from <server name>” 

along with Open, Save, and Cancel buttons (Figure 118). If it does, click the 

<Open> button. 

17. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed.    

18. The report will display, as illustrated in Figure 133.  

19. Select the <File> dropdown and click on <Print> to print it out. 
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Figure 133: Summary RLOC Reason spreadsheet 

 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

12.5 Report #5 - Patient Reviews Met/Not Met  

This is a basic patient level report, generated in landscape orientation and sorted in ascending 

alphabetical order by patient last name within Met and Not Met subcategories. The reviews on 

the report output will match the saved/locked reviews that display on the Utilization 

Management Review Listing screen. The resulting report list will be subtotaled by Crit Met? 

with observation reviews listed before other non-observation reviews.  You can generate the 

report by Attending MD, Reviewer, Treating Specialty, Ward Location and Service Section, and 

print it out on your local printer or export it to Excel.  

 

To generate the Report 

1. Click the Reports menu dropdown. 

2. Click on 5: Pt Reviews Met/Not Met (L). The search filters will display 

(Figure 134).  
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Figure 134: Patient Reviews Met/Not Met filters 

 

3. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

4. Select an option from the Current Lookup Site dropdown by clicking on it. 

5. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 

6. Select a Review By radio button by clicking on it.  

7. A corresponding dropdown will display for the radio button you chose (not 

shown in Figure 134).  

8. Select an option by clicking on it. To select more than one option, hold down the 

<Ctrl> key before clicking on each one. 

9. Select an option from the CERMe Review Types pick list by clicking on it. If 

you select Admission or BH Initial Review, the Admission Review Types 

dropdown will display (Figure 115). 

10. Select one or more options from the Admission Review Types dropdown by 

clicking on them. (Note: the information that displays on this report when each of 

the admission review type filter options is selected will vary. Please see Section 

8.18 for details). 

11. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 

12. Be sure to click the <Find> button after you select ALL of the report parameters. 

13. As soon as you select the <Find> button, you will see report information. If you 

specify other parameters such as Start and End dates, don’t forget to click on 

<Find> to generate your specific report. The subtitle on the report will contain 

the parameters you specify, so double-check that all of your parameters are 

specified in the sub-title.  

14. The report output will display, as illustrated in Figure 135. 
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Figure 135: Patient Reviews Met/Not Met output 

15. To print, click the <Print Preview> button.  

16. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 136).  

 

 

Figure 136: Patient Reviews Met/Not Met printout 

 

14. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

15. A File Download dialog box may display indicating: Do you want to open 

or save Report<report name>.xls(1.44 KB)from <server name>” 

along with Open, Save, and Cancel buttons (Figure 118). If it does, click the 

<Open> button. 

16. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed.   

17. The report will display, as illustrated in Figure 137.  

18. Select the <File> dropdown and click on <Print> to print it out. 
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Figure 137: Patient Level Met/Not Met spreadsheet 

 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

12.6 Report #6 - Patient Reviews Met/Not Met ‘Custom’  

This report is similar to the Patient Reviews Met/Not Met Report, but this report includes the 

information that has been typed into the Custom field on the Primary Review screen. The report 

is generated in landscape orientation. The resulting report list will be subtotaled by Crit Met? 

with observation reviews listed before other non-observation reviews.  You can generate the 

report by Attending MD, Reviewer, Treating Specialty, Ward Location and Service Section, and 

print it out on your local printer or export it to Excel. 

 

To generate the report 

1. Click the Reports menu dropdown. 

2. Click on 6: Pt Reviews Met/Not Met Custom (L).   

3. The search filters will display (Figure 138). 

 

 

Figure 138: Patient Reviews Met/Not Met Custom filters 
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4. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

5. Select an option from the Current Lookup Site dropdown by clicking on it. 

6. Select a Review By radio button by clicking on it.  

7. A corresponding dropdown will display for the radio button you chose (not 

shown in Figure 138). 

8. Select an option by clicking on it. To select more than one option, hold down 

the <Ctrl> key before clicking on each one. 

9. Select an option from the CERMe Review Types pick list by clicking on it. If 

you select Admission or BH Initial Review, the Admission Review Types 

dropdown will display (Figure 115).   

10. Select one or more options from the Admission Review Types dropdown by 

clicking on them. (Note: the information that displays on this report when 

each of the admission review type filter options is selected will vary. Please 

see Section 8.18 for details). 

11. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 

12. Be sure to click the <Find> button after you select ALL of the report 

parameters.  

13. As soon as you select the <Find> button, you will see report information. If 

you specify other parameters such as Start and End dates, don’t forget to click 

on <Find> to generate your specific report. The subtitle on the report will 

contain the parameters you specify, so double-check that all of your 

parameters are specified in the sub-title.  

14. The report output will display as illustrated in Figure 139. 

 

 

Figure 139: Patient Reviews Met/Not Met Custom output 
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14. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

15. A File Download dialog box may display indicating: Do you want to open 

or save Report<report name>.xls(1.44 KB)from <server name>?” 

along with Open, Save, and Cancel buttons (Figure 118). If it does, click the 

<Open> button. 

16. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed.   

17. The report will display, as illustrated in Figure 140.  

 

 

Figure 140: Patient Reviews Met/Not Met Custom spreadsheet 

 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

 

18. To print, click the <Print Preview> button.  

19. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 141).  
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Figure 141: Patient Reviews Met/Not Met Custom printout 

12.7 Report #7 - Patient Details  

This report shows all reviews saved for a specific patient for a selected time period, sorted 

chronologically by Service Date Reviewed with earliest date first and most recent date last. The 

report is generated in landscape orientation. You can print the report out on your local printer or 

export it to Excel. 

 

  When searching for patients by Patient Name, please use lastname,firstname format 

(e.g.,  Smith,John) without putting a space after the comma, as depicted in Figure 142.  For 

a more general search, you may also type in the patient’s last name (e.g., Smith). You will 

not get any results if you search for patients using their last initial + last 4 SSN, or their last 

4 SSN. 

 

To generate the Report 

1. Click the Reports menu dropdown. 

2. Click on 7: Reviews for One Pt (L). The search filters will display (Figure 

142).  
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Figure 142: Patient Details filters 

 

 

Figure 143: Patient Details filters with patient name populated 

 

3. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

4. Select an option from the Current Lookup Site dropdown by clicking on it. 

5. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 

6. Type a patient’s name in the Patient Name field, as shown in Figure 143. 

(You may also type in a partial name, e.g.,  Van). 

7. Click the <Find Patient> button. 

8. When the list of results displays in the window, single –click on a name.   

9. Be sure to click the <Find> button after you select ALL of the report 

parameters.  

10. As soon as you select the <Find> button, you will see report information. If 

you specify other parameters such as Start and End dates, don’t forget to click 

on <Find> to generate your specific report. The subtitle on the report will 

contain the parameters you specify, so double-check that all of your 

parameters are specified in the sub-title.  
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11. The report output will display for the patient you specified, as illustrated in 

Figure 144. 

 

 

Figure 144: Patient Details output 

 

11. To print, click the <Print Preview> button.  

12. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 145).  

 

 

Figure 145: Patient Details printout 

 

13. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

14. A File Download dialog box may display indicating: Do you want to open 

or save Report<report name>.xls(1.44 KB)from <server name>” 

along with Open, Save, and Cancel buttons (Figure 118). If it does, click the 

<Open> button. 

15. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed.    

16. The report will display, as illustrated in  

17. Figure 146.  

18. Select the <File> dropdown and click on <Print> to print it out. 
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Figure 146: Patient Details spreadsheet 

 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

12.8 Report #8 - Physician Reviews  

This report will show you a patient-level listing of reviews that were sent to Physician Advisors 

and their responses (i.e., Agree or Disagree). The report is generated in landscape orientation. 

You can print the report out on your local printer or export it to Excel. 

 

To generate the report 

1. Click the Reports menu dropdown. 

2. Click on 8: Physician Reviews (L). The search filters will display (Figure 

147).  

 

 

 

Figure 147: Physician Reviews filters 

 

3. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

4. Select an option from the Current Lookup Site dropdown by clicking on it. 

5. Select an option from the Physician Advisor dropdown by clicking on it. 

5. Select an option from the CERMe Review Types pick list by clicking on it. If 
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you select Admission or BH Initial Review, the Admission Review Types 

dropdown will display (Figure 115).   

6. Select one or more options from the Admission Review Types dropdown by 

clicking on them. (Note: the information that displays on this report when 

each of the admission review type filter options is selected will vary. Please 

see Section 8.18 for details). 

7. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 

8. Be sure to click the <Find> button after you select ALL of the report 

parameters.  

9. As soon as you select the <Find> button, you will see report information. If 

you specify other parameters such as Start and End dates, don’t forget to click 

on <Find> to generate your specific report. The subtitle on the report will 

contain the parameters you specify, so double-check that all of your 

parameters are specified in the sub-title.  

10. The report output will display, as illustrated in Figure 148. 

 

 

Figure 148: Physician Reviews output 

15. To print, click the <Print Preview> button.  

16. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 149).  
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Figure 149: Physician Reviews printout 

 

11. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

12. A File Download dialog box may display indicating: Do you want to open 

or save Report<report name>.xls(1.44 KB)from <server name>” 

along with Open, Save, and Cancel buttons (Figure 118). If it does, click the 

<Open> button. 

13. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed.    

14. The report will display, as illustrated in Figure 150.  
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Figure 150: Physician Reviews spreadsheet 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

12.9 Report #9 - Physician Advisor Response  

This report will show you a patient-level listing of reviews that were sent to Physician Advisors, 

their response (i.e., Agree or Disagree) and their comments. The report generates in landscape 

orientation. You can print the report out on your local printer or export it to Excel. 

 

To generate the Report 

1. Click the Reports menu dropdown. 

2. Click on 9: Phy UM Advisor Response (L). The search filters will display 

(Figure 151).  

 

 

Figure 151: Physician Advisor Response filters 

 

3. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

4. Select an option from the Current Lookup Site dropdown by clicking on it. 

5. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 
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6. Click the Physician Advisor dropdown. Click on the desired Physician 

Advisor name.  

7. Select an option from the CERMe Review Type pick list by clicking on it. If 

you select Admission or BH Initial Review, the Admission Review Types 

dropdown will display (Figure 115).   

8. Select one or more options from the Admission Review Types dropdown by 

clicking on them. (Note: the information that displays on this report when 

each of the admission review type filter options is selected will vary. Please 

see Section 8.18 for details). 

9. Click the Treating Specialty dropdown. Select an option by clicking on it. To 

select multiple options, click and hold down the <Ctrl> key before clicking 

on them. 

10. Be sure to click the <Find> button after you select ALL of the report 

parameters.  

11. As soon as you select the <Find> button, you will see report information. If 

you specify other parameters such as Start and End dates, don’t forget to click 

on <Find> to generate your specific report. The subtitle on the report will 

contain the parameters you specify, so double-check that all of your 

parameters are specified in the sub-title.  

12. The report output will display, as illustrated in Figure 152. 

 

 

Figure 152: Physician Advisor Response output 

 

13. To print, click the <Print Preview> button.  

14. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 153).  
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Figure 153: Physician Advisor Response printout 

 

14. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

15. A File Download dialog box may display indicating: Do you want to open 

or save Report<report name>.xls(1.44 KB)from <server name>?” 

along with Open, Save, and Cancel buttons (Figure 118). If it does, click the 

<Open> button. 

16. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed.   

17. The report will display, as illustrated in Figure 154.  

18. Select the <File> dropdown and click on <Print> to print it out. 

 

 

Figure 154: Physician Advisor Response spreadsheet 

 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 
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12.10 Report #10 - Unscheduled Readmits in Less than 30 
Days  

This report will let you see a listing of all reviews of unscheduled readmits within the last 30 

days, sorted in ascending alphabetical order by patient name. The report generates in landscape 

orientation. You can print the report out on your local printer or export it to Excel. 

 

To generate the report 

1. Click the Reports menu dropdown. 

2. Click on 10: Unsched Readmission (L). The search filters will display 

(Figure 155).  

   

 

Figure 155: Unscheduled Readmits in Less than 30 Days filters 

 

3. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

4. Select an option from the Current Lookup Site dropdown by clicking on it. 

5. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 

6. Select an option from the CERMe Review Type pick list by clicking on it, 

and the Admission Review Types dropdown will display.   

7. Select one or more options from the Admission Review Types dropdown by 

clicking on them. (Note: the information that displays on this report when 

each of the admission review type filter options is selected will vary. Please 

see Section 8.18 for details). 

8. Be sure to click the <Find> button after you select ALL of the report 

parameters.  

9. As soon as you select the <Find> button, you will see report information. If 

you specify other parameters such as Start and End dates, don’t forget to click 

on <Find> to generate your specific report. The subtitle on the report will 
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contain the parameters you specify, so double-check that all of your 

parameters are specified in the sub-title.  

10. The report output will display, as illustrated in Figure 156. 

 

 

 

Figure 156: Unscheduled Readmits in Less than 30 Days output 

 

10. To print, click the <Print Preview> button.  

11. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 157).  

 

 

Figure 157: Unscheduled Readmits in Less than 30 Days printout 

 

12. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

13. A File Download dialog box may display indicating: Do you want to open 

or save Report<report name>.xls(1.44 KB)from <server name>?” 

along with Open, Save, and Cancel buttons (Figure 118). If it does, click the 

<Open> button. 

14. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed.   

15. The report will display, as illustrated in Figure 158.  

16. Select the <File> dropdown and click on <Print> to print it out. 

 

 

Figure 158: Unscheduled Readmits in Less than 30 Days spreadsheet 
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Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

12.11 Report #11 - RLOC Aggregate  

This report shows an aggregated listing of recommended levels of care, grouped by Treating 

Specialty and based on the review entries into NUMI. The report is sorted on the following 

columns: Service Section (first sort field), Treating Specialty (second sort field), Review Type 

(third sort field), and Recommended Level of Care (fourth sort field). In addition, the report will 

display the percentage of reviews for each treating specialty based on the radio button selection, 

the count of the total number of reviews, and the count subtotals by Treating Specialty, Service, 

and Review Type for Not-Met reviews. The resulting report list will be subtotaled by Review By 

with observation reviews listed before other non-observation reviews.  The report generates in 

landscape orientation. You can print the report out on your local printer or export it to Excel. 

 

To generate the report 

 

1. Click the dropdown. 

2. Click on 11: RLOC Aggregate (L). The search filters will display, as shown 

in Figure 159. 

3. Select an option from the Current Lookup Site dropdown by clicking on it. 

4. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

5. Click on the Start Date and End Date calendar icons and select dates by 

clicking on them. You can also type in the date, using the format mm/dd/yyyy. 

6. Select a Review By radio button by clicking on it. A list of options within 

each Review By radio button choice will display when the radio button is 

selected. 

7. Select an option by clicking on it. To select more than one option, hold down 

the <Ctrl> key before clicking on each one. 

8. If you choose CERMe Review Types, a CERMe Review Types pick list will 

display (Figure 160).  The system will only permit you to select one option 

from the list.  If you choose either Admission or BH Initial Review, the 

system will display an additional dropdown box - Admission Review Types 

(Figure 115). You may select one or more options by clicking on them. 

9. Click the <Find> button. 

10. The report output will display with the title Recommended Level of Care 

Aggregate by <review by option>, as illustrated in Figure 161. 

11. To print, click the <Print Preview> button.  

12. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 162).  

13. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  
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14. A File Download dialog box may display indicating: Do you want to open 

or save Report<report name>.xls(1.44 KB)from <server name>?” 

along with Open, Save, and Cancel buttons. (Figure 118). If it does, click the 

<Open> button. 

15. Excel will open. Note: if you are using Excel version 2007, you may see a 

dialog box advising that the file you are trying to open is in a different format 

than specified by the file extension (Figure 119). Click the <Yes> button to 

proceed.   

16. The report will display, as illustrated in Figure 163.  

17. Select the <File> dropdown and click on <Print> to print it out. 

 

Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

 

 

Figure 159: RLOC Aggregate Report filters 

 

 

Figure 160: RLOC Aggregate CERMe Review Types filter 
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Figure 161: RLOC Aggregate Report output 

 

 

Figure 162: RLOC Aggregate Report printout 

 

 

Figure 163: RLOC Aggregate Report spreadsheet 

 

12.12 Report #12 - Clinical Comments Detail  

This report shows all comments that have been entered into NUMI regarding a patient.  The 

report entries are sorted on the following columns: Patient Name, Review Date and Treating 

Specialty. The sort order is first by Treating Specialty and then alphabetically.  In addition, the 
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report displays a Grand Total count of the total number of reviews. The report generates in 

landscape orientation. You can print the report out on your local printer or export it to Excel. 

 

To generate the report 

1. Click the Reports menu dropdown. 

2. Click on 12: Clin. Comments Detail (L). The search filters will display, as 

shown in Figure 164. 

3. Select the “Include Observations” check box if so desired. (See Section 5.3 for 

details.) 

4. Select an option from the Current Lookup Site dropdown by clicking on it. 

5. Click on the Date Being Reviewed Start Date and End Date calendar icons and 

select dates by clicking on them. You can also type in the dates, using the format 

mm/dd/yyyy. 

6. Click on the Date Review Saved Start Date and End Date calendar icons and 

select dates by clicking on them. You can also type in the dates, using the format 

mm/dd/yyyy. 

7. Select a Review By radio button by clicking on it. A list of options within each 

Review By radio button choice will display when the radio button is selected. 

8. Select an option by clicking on it. To select more than one option, hold down the 

<Ctrl> key before clicking on each one. 

9. If you select the CERMe Review Types radio button, the CERMe Review 

Types pick list will display. The system will only permit you to select one option 

from the list. Select an option by clicking on it. If you select Admission or BH 

Initial Review, the Admission Review Types dropdown will display (Figure 

115). 

10. Select one or more options from the Admission Review Types dropdown by 

clicking on them. (Note: the information that displays on this report when each of 

the admission review type filter options is selected will vary. Please see Section 

8.18 for details). 

11. Click the <Find> button. 

12. The report output will display with the title Clinical Comments Detail by 

<review by option>, as illustrated in Figure 165.  

13. To print, click the <Print Preview> button.  

14. When the Print Report preview window opens, right-click in the preview 

window and click the <Print> option (Figure 166).  

15. To export the report to an Excel spreadsheet, click the <Export to Excel> 

button.  

16. A File Download dialog box may display indicating: Do you want to open or 

save Report<report name>.xls(1.44 KB)from <server name>?” along with 

Open, Save, and Cancel buttons. (Figure 118). If it does, click the <Open> button. 

17. Excel will open. Note: if you are using Excel version 2007, you may see a dialog 

box advising that the file you are trying to open is in a different format than 

specified by the file extension (Figure 119). Click the <Yes> button to proceed.   

18. The report will display, as illustrated in Figure 167.  

19. Select the <File> dropdown and click on <Print> to print it out. 
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Note: After you have downloaded the raw data to Excel, the data comes over without totals and 

subtotals. You may format the size of columns and rows according to your needs. All dates will 

be expressed in numerical format, so date columns will need to be reformatted into a Date 

format. 

  

Figure 164: Clinical Comments Detail Report filters 

 

 

Figure 165: Clinical Comments Detail Report output 
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Figure 166: Clinical Comments Detail Report printout 

 

 

Figure 167: Clinical Comments Detail spreadsheet 

12.13 Enhanced Reporting 

The option for Enhanced Reporting is located at the bottom of the Reports menu. When you 

select the Enhanced Reporting option from the Reports menu the system will check to see if 

your Windows and NUMI credentials match. Please see Section 4.1.2 for more information 

about this.  

 

Credentials Match 

If your credentials match, when you select the Enhanced Reporting option from the Reports 

menu you will see the list of available reports. An example is shown in Figure 168.  
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Figure 168: Example Enhanced Reporting List 

 

If you login with matching credentials and there are no available enhanced reports to view you 

will see the message that is shown in Figure 169. 

 

 

Figure 169: Enhanced Reporting - no active reports 

 

Credentials Do Not Match 

If your credentials do not match, when you select the Enhanced Reporting option from the 

Reports menu you will see the message depicted in Figure 170. You will then have the option of 

either updating your network account name in NUMI or logging out and logging back in using 

your own VA network account. 

 

 

Figure 170: Enhanced Reporting Security Warning 

12.13.1 Updating your Network Account Name for Enhanced 
Reporting 

If you wish to update your network account name 

1. With the Security Warning message displayed, click on the <Update My 

Network Account name in NUMI> hyperlink. 

2. Your network account name will be updated by the system. This update will 

not be visible to you.  

3. Click on the Reports menu. 
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4. Click on the Enhanced Reporting option. 

5. The list of enhanced reports will display. (Note: if you have been using NUMI 

thru someone else’s Windows session and opt to update your network account 

from their PC, your credentials will not match when you login to NUMI from 

your PC. You will need to update your credentials from your PC in order to 

see the Enhanced Reporting artifacts).  

 

If you do not wish to update your network account name 

1. With the Security Warning message displayed, click on the <Logout> 

hyperlink. 

2. Your network account name will not be updated by the system and you will be 

logged out of NUMI. 

3. Login to NUMI using your own credentials. 

4. Click on the Reports menu. 

5. Click on the Enhanced Reporting option. 

6. The list of enhanced reports will display. 

12.13.2 Generating Enhanced Reporting Reports   

To generate Enhanced Reporting reports    

1. Click the Reports menu dropdown. 

2. Click on the Enhanced Reporting option at the bottom of the dropdown list. 

3. A list of available reports will display. An example is shown in Figure 168. 

4. Select a report in the list by clicking on its hyperlink.   

5. A new window (report viewer) will open. 

6.  will briefly display in the window. 

7. The report contents will display (Figure 171).  

8. To print, click the <File> dropdown in the report viewer window.  

9. Select <Print>.   

10. The report will print to your local printer. 

11. To export the report, click on the Select a Format dropdown and select Excel. 

12. Hover your mouse over the word Export. It will display as a red hyperlink 

(Figure 172).   

13. Click on the Export hyperlink. 

14. The information will be exported to an Excel spreadsheet.  
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Figure 171: Enhanced Reporting report viewer window 

 

 
 

Figure 172: Format dropdown selection and Export hyperlink 
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13 Unlocking and Deleting Reviews 

The features for unlocking Primary and Physician Advisor Reviews, and Deleting reviews are 

accessed from the Utilization Management Review Listing screen, which is located on the Tools 

menu.  

 

 Primary Reviewers have the ability to Unlock and Delete their own reviews.  

 Administrators have the ability to Unlock and Delete any reviews.  

 Administrators can Unlock or Delete reviews, on behalf of  Physician Advisors  

13.1 Unlocking a Locked Primary Review  

NUMI offers the ability for a Primary Reviewer to unlock any Primary Review that was locked 

to the database at their site. This would be handy in cases where a reviewer might be covering 

for someone else in the VISN. (Note: if there is a Physician Advisor review associated with the 

Primary Review, unlocking the Primary Review will automatically unlock the Physician Advisor 

review portion, as well).  

 

  If a Primary Review that Did Not Meet criteria is Unlocked and then its status 

changes to Meets criteria, the associated Physician Advisor review will be deleted.  

 

To unlock a Primary Review that was locked to the database 

1. Click on the Utilization Management Review Listing on the Tools menu to 

open the Utilization Management Review Listing  screen. 

2. Select the desired filter options by clicking on them. 

3. Click the <Find> button and the results will display in a table. 

4. Click on the desired Patient Name hyperlink to open the Review Summary 

screen. (You can also get to the Review Summary screen from the Reviews 

table on the Patient Stay History  screen and the Primary Review screen). 

5. The Review Summary screen will display with <Close>, <Unlock> and 

<Delete> buttons (Figure 173).  
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Figure 173: Review Summary window 

 

6. Click the <Unlock> button. 

7. A dialog box displays with the message: “Are you sure you want to 

Unlock this Review?” 

8. Click the <OK> button and the screen will refresh and display: 

“Successfully unlocked the record” and the <Unlock> button on the 

Review Summary screen will now display as <Review>. 

9. Click the <Review> button. 

10. The message “Are you sure you want to review?” displays. 

11. Click the <OK> button  to be redirected to the Primary Review Summary 

screen where you can continue working on the review.  

13.2 Unlocking the Physician Advisor Portion of a Locked 
Review 

NUMI offers the ability to unlock just the Physician Advisor portion of a review that has been 

locked to the database.  

 

Certain events must occur before the <Unlock Physician Advisor Review> button will 

display on the Utilization Management Review Listing screen: a Primary Review that Does Not 
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Meet is assigned to a Physician Advisor and locked to the database; the Physician Advisor opens 

the review from their Worklist, performs a review, and locks the Physician Advisor portion of 

the review back to the database.  

 

To unlock the Physician Advisor portion of a review that was locked to the database 

1. Click on the Utilization Management Review Listing on the Tools menu. 

2. Click on the View hyperlink for the review.  

3. The Utilization Management Review Listing screen will display with 

<Close>, <Unlock>, <Delete> and <Unlock Physician Advisor 

Review> buttons (Figure 174).  

4. Click the <Unlock Physician Advisor Review> button.  

5. The Physician Advisor can then open the review from their Worklist, 

perform a review and lock the Physician Advisor portion of the review back 

to the database. (Note: the Primary Review portion of the review remains 

locked to the database).   

 

 

Figure 174: Review Summary with Unlock Physician Advisor Review button 
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13.3 Deleting a Review 

NUMI Administrators will use this feature to delete reviews. Primary Reviewers will be able to 

delete their own reviews. Administrators can delete reviews on behalf of Physician Advisors. A 

review that has been performed on a patient stay might be deleted if that stay has been deleted 

from VistA. Deleting the review from NUMI will ensure that no ‘orphan’ stays are on the 

application. 

 

  If a Primary Review is deleted, the associated Physician Advisor review will also be 

deleted. There is no way to directly delete a Physician Advisor review. You may, however, 

unlock it and reassign to another Physician Advisor and even change it completely. 

 

To delete a review 

1. Click on the Utilization Management Review Listing on the Tools menu to 

open the Utilization Management Review Listing screen. 

2. Select the desired filter options by clicking on them. 

3. Click the <Find> button and the results will display in a table. 

4. Click on the desired View hyperlink to open the Review Summary screen in 

a different window. 

 

  If you select the Review hyperlink, you will not be able to delete the review. You will 

be taken to the Primary Review page where you can continue working on it. If another 

review is in process, then all changes will be lost unless it has been saved or locked. 

 

5. The screen will display <Close>, <Unlock> and <Delete> buttons (Figure 

173).  

6. Type a Deletion Reason into the text box. (Note: you will not be able to 

delete the review unless you do this first). 

7. Click the <Delete> button. 

8. A dialog box will display with this message: “Are you sure you want to 

Delete this Review?” 

9. Click the <OK> button, and the screen will refresh and display: 

“Successfully Deleted the record” and the <Delete> button will be 

grayed out. 

10. Click <Close> to return to the Utilization Management Review Listing  

screen. 

 

  Be very careful when using the Delete option. Once a review has been deleted, it 

cannot be restored. 
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14 Copying Reviews 

NUMI simplifies the process of creating multiple reviews for the same patient/stay. You can 

easily create and save a review by copying another review. This will save you considerable time 

and effort, especially for weekend stay days and patients awaiting long term care beds and 

procedures. A review can be copied from the Patient Stay History screen, the Primary Review 

screen, or the Review Summary screen.   

 

 IMPORTANT: Do not copy an Admission review. Since Admission reviews are only 

done once, there is no reason to copy them.  (If your intent is to copy the criteria and use it 

for the following day, note that CERMe will not permit you to do that, and will require you 

to select the type of review before you select the criteria. If you are doing a Continued Stay 

review, you will want to be using Continued Stay criteria - not Admission criteria. So, there 

would not normally be any scenario in which you would copy an Admission review). 

 

To copy a review from the Patient Stay History screen 

1. From the Patient Stay History screen, click the gold Show Reviews tab to 

display all the reviews. 

2. The Reviews table will open and display all reviews for the patient. 

3. Click on a View hyperlink in the table. 

4. The Review Summary screen will open and the <Copy This Review> 

button will display. 

5. Click the button and an identical copy of the review will be created. You can 

change anything you need to on the copy, and then save it.  

 

To copy a review from the Primary Review screen 

1. From the Primary Review screen, click the gold Show Reviews tab to 

display all the reviews. 

2. The Reviews table will open and display all reviews for the patient. 

3. Click on a View hyperlink in the table. 

4. The <Copy This Review> button will display (Figure 175).  

5. Click the button and an identical copy of the review will be created. 

 

  It is only appropriate to copy a review if the criteria and met/not met outcome have 

not changed. You can copy a review as many times as you wish.   
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Figure 175: Primary Review Summary screen with Copy This Review button 

 

To copy a review from the Review Summary screen 

1. From the Primary Review screen, click the gold Show Reviews tab to 

expand the Reviews table.  

2. The original review and all its copies will display.  

3. To see the summary for any review, click its View hyperlink.  

4. The Review Summary screen will display (Figure 176).  

5. Click the <Copy This Review> button and an identical copy of the review 

will be created. 
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Figure 176: Review Summary screen with Print and Copy This Review buttons 
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15 Admin Menu 

This chapter describes the Admin menu. Only NUMI Administrators can use these features. The 

menu is located in the Admin dropdown at the top of the Patient Stay History, InterQual 

Criteria and Primary Review Summary screens. (Non-Administrator users will see the Admin 

menu header on the screen but if they click on it they will not see any options). On this screen, 

Administrator users can search for VistA users, add them as NUMI users, add and edit NUMI 

user information and assign privileges, deactivate user sites, and add/remove users from the 

Physician Advisor, Primary Reviewer and Site Administrator panels. There are 3 Admin options: 

Users, Admin Site and Treating Specialty Configuration (Figure 177). The administrative 

features of the Users screens are listed in Table 13, and the features of the Admin Sites screens 

are listed in Table 14. The Treating Specialty Configuration features are listed in Table 15. 

 

Table 13: Admin Users features 

FEATURES 

National Utilization Management Integration (NUMI) Users Feature 

Find VistA Users by Name 

Find VistA Users by Site 

Find VistA Users by Status 

Add NUMI User / Assign Privileges 

View NUMI User information / Privileges 

Edit NUMI User information 

Deactivate a User’s Site 

 

Table 14: Admin Site features 

FEATURES 

National Utilization Management Integration (NUMI)Admin Sites Feature (find VistA Users) 

Find VistA Users 

Add Users to the Physician Advisor Panel 

Add Users to the Primary Reviewer Panel 

Add users to the Site Administrators Panel 

Remove Users from the Physician Advisor Panel 

Remove Users from the Primary Reviewer Panel 

Remove Users from the Site Administrators Panel 
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Table 15: Treating Specialty Configuration features 

FEATURES 

Assign or Update Treating Specialties 

 

 

Figure 177: Admin Menu 

15.1 Accessing the NUMI Users Feature 

NUMI Administrators will use this feature to find VistA users, add/edit NUMI user information 

including the assignment of user privileges, and deactivate user sites. 

  

To access the NUMI ‘Users’ feature 

1. Select the Admin dropdown and click on the Users option. A list of existing 

NUMI users displays on the NUMI User List screen, as illustrated in Figure 

178. 

 

 

Figure 178: NUMI User List screen 



 

May 2014 NUMI User Guide 15-3 

15.1.1 Finding VistA Users by Name 

The list of NUMI users can be very long. But you don’t have to scroll thru the entire list. NUMI 

saves you time by letting you search for specific VistA users using a Find feature. You can 

search by the user’s full name using lastname, firstname format (e.g., Smith, John) or you can 

search by a partial name (e.g., Smi). Please note that if you search by partial name you may 

receive a long list of results (e.g., Smi will retrieve all instances of ‘smi’ in user names (e.g.,  

Goldsmith, Smit, Smith, Smithfield, etc.). 

 

To find VistA users by name 

1. Type the user’s name into the VISTA User Name field (Figure 179).  

2. Click the <Find> button.  

 

 

Figure 179: Find VistA Users search fields 

15.1.2 Finding VistA Users by Site 

To find VistA users by Site 

1. Click the Site dropdown (Figure 179) and select a site by clicking on it. 

2. Click the <Find> button. 

15.1.3 Finding VistA Users by Status 

To find VistA users by Status (Active / Inactive) 

1. Click the Status dropdown (shown in Figure 179) and select an option by 

clicking on it. 

2. Click the <Find> button. 

15.1.4 Assigning Privileges to a NUMI User 

To add a NUMI user and assign privileges 

1. Click the <Add New User> button (shown in Figure 179).    

2. When the Add New User/Privileges screen displays (Figure 180), enter the 

user’s name into the VISTA User Name field. You can also enter partial 

names (e.g.,  instead of Smith, John you can search by Smith or Smi). 

3. Select the VISTA User Login Site dropdown and choose a site by clicking 

on it. 

4. Click the <Find VISTA User> button.  

 



 

May 2014 NUMI User Guide 15-4 

 

Figure 180: Add NUMI User 

 

5. When the results display on the screen (Figure 181), click the Select 

hyperlink in the Select One column for the user you wish to add.  

 

 

Figure 181: Find VistA User results 

 

6. When the screen with user privilege checkboxes displays (Figure 182), 

choose a site in the NUMI Access Site dropdown by clicking on it. 

 

  Multiple sites can be chosen from the Select Site for Granting Access dropdown on the 

Add User screen, if the user has permission to visit more than one site. Only one site can be 

selected and viewed at a time, however.  
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Figure 182: Add User Permissions 

 

7. Choose NUMI privileges by clicking on the User Privileges checkboxes. 

8. Type a reason into the Reason field. 

9. Click the <Save> button and the message: ‘Successfully updated user 

site. Site: <location> privileges’ will display, as illustrated in 

Figure 183. 

15.1.5 Viewing NUMI User Information and Privileges 

To view a NUMI user’s information and privileges  

1. Click the Select hyperlink (illustrated in Figure 178) for the desired user on 

the NUMI User List screen.  

2. Each site that they have access to will display either a View or an Edit 

hyperlink, as depicted in Figure 183.  
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Figure 183: View User Privileges 

3. To view privileges for a particular site, click the View hyperlink for that site. 

4. The information will display and the View hyperlink will change to grayed 

out text displaying Selected Site (Figure 184).  

5. While on this screen, if the user has privileges at multiple sites, you can click 

on the NUMI Access Site dropdown and then click on the desired site in the 

dropdown to see them. 

6. Click the <Cancel> button to return to the NUMI User List screen. 

 

 

Figure 184: View NUMI User Information 
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15.1.6 Editing NUMI User Information 

To edit NUMI user information  

1. Click the Select hyperlink for the desired user on the NUMI User List 

screen.  

2. Each site that they have access to will display either a View or an Edit 

hyperlink, as depicted in Figure 183. 

3. To edit privileges for a particular site, click the Edit hyperlink (shown in 

Figure 184) for that site. 

4. The information will display and the Edit hyperlink will change to grayed 

out text displaying Selected Site (Figure 185).  

5. Type a reason for the change(s) into the Reason field. 

6. Add or change the user’s privileges by selecting/deselecting the User 

Privileges checkboxes.  

7. Select the site that the privileges will apply to from the NUMI Access Site 

dropdown by clicking on it. 

8. Click the <Save> button. The message “Successfully Updated User: 

<user name>” will display, as well as the reason you entered, as depicted 

Figure 183. 

 

  While multiple sites can be selected from the NUMI Access Site dropdown if the user 

has permission to visit more than one site, only one site’s privileges can be viewed at a time.  

 

 . 

Figure 185: Edit NUMI User screen 
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  If someone tries to edit a NUMI user record and they do not have the proper 

administrator privileges, an error message will display: “You do not have admin access 

to modify user privileges for: <user name>”. 

 

  If a user’s privileges are changed, they will need to logout and log back in for the 

changes to take effect. 

15.1.7 Deactivating a User’s Site 

A user’s permission to visit and view site information for a particular facility can be deactivated 

using this feature. (NUMI does not allow you to deactivate a user, but you can accomplish that 

general goal by deactivating all of their site permissions). 

  

To deactivate a user site 

1. Click the Select hyperlink for the desired user on the NUMI User List 

screen. 

2. Click the Edit hyperlink to display the user’s privileges (Figure 183).  

3. Select the desired site from the NUMI Access Site dropdown by clicking on 

it. 

4. Click the Deactivate button. 

5. When the prompt “Are you sure you want to deactivate user site 

<City, State>” displays. 

6. Click the <OK> button to deactivate the site. 

15.2 Accessing the NUMI Site Admin Feature 

Administrators will use this feature to find VistA users, and add or remove users from the NUMI 

Physician Advisor, NUMI Primary Reviewer and NUMI Site Administrators lists. The examples 

below illustrate adding HARRIS to several Admin lists. 

 

To access the NUMI ‘Admin Site’ feature 

1. Select the Admin dropdown and click on the Admin Sites option.  

2. The Site Admin Panel screen (Figure 186, Figure 187, and Figure 188) 

displays the names of existing users in the NUMI Physician Utilization 

Management Advisor List, NUMI Primary Reviewer List and NUMI Site 

Administrator List panels. 
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Figure 186: Site Admin screen (top section)  
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Figure 187: Site Admin screen (middle section) 
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Figure 188: Site Admin screen (bottom section) 

15.2.1 Finding a VistA User 

To find a VistA User 

1. Type the user’s name into the VISTA User Name field. 

2. Select a site from the VISTA User Login Site dropdown by clicking on it. 

3. Select a site from the NUMI Access Site dropdown by clicking on it. 

4. Click the <Find VISTA User> button. A list of names matching your search 

criteria will display in the Physician Advisor, Primary Reviewer and Site 

Administrators VistA User List panels (shown in Figure 186 and Figure 187).  

 

  When searching for a VistA user, the user name is required. If you try to search for a 

user without providing this information, the message ‘Please enter VISTA User ID’ will 

display.  

15.2.2 Adding a User to NUMI Physician Advisor Panel 

To add a user to the list 

1. In the Physician Advisor Panel portion of the screen, click on a name in the 

VISTA User List. 

2. Click the  button, and the name will populate to the NUMI Physician 
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Advisor List. 

3. When the message ‘Are you sure you want to add <name(s)> to the 

Physician Advisor panel?’ displays, click the <OK> button. 

15.2.3 Adding a User to NUMI Primary Reviewer Panel 

To add a user to the list 

1. In the Primary Reviewer Panel portion of the screen, click on a name in the 

VISTA User List. 

2. Click the  button, and the name will populate to the NUMI Primary 

Reviewer List portion of the panel. 

3. When the message ‘Are you sure you want to add <name(s)> to the Primary 

Reviewer panel?’ displays, click the <OK> button 

15.2.4 Adding a User to NUMI Site Administrators Panel 

To add a user to the list 

1. In the Site Administrators Panel portion of the screen, click on a name in the 

VISTA User List. 

2. Click the  button, and the name will populate to the NUMI Site 

Administrators List portion of the panel. 

3. When the message ‘Are you sure you want to add <name(s)> to the 

Site Administrators panel?’ displays, click the <OK> button 

15.2.5 Adding a User to NUMI Report Access Panel 

You can assign the “Report Access” role for a user when editing an individual user under Admin 

/ Users, and when viewing roles and their members under Admin / Admin Sites. Only users that 

have this role will be able to run and view reports.   

 

To add a user to the list 

4. In the Report Access portion of the screen, click on a name in the VISTA 

User List. 

5. Click the  button, and the name will populate to the NUMI Report 

Access portion of the panel. 

6. When the message ‘Are you sure you want to add <name(s)> to the 

Report Access panel?’ displays, click the <OK> button. 
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15.2.6 Removing a User from the NUMI Physician Advisor Panel 

To remove a user from the list 

1. Click on a name in the NUMI Physician Advisor List. 

2. Click the   button, and the name will be moved from the list to the 

VISTA User List portion of the panel. 

3. When the message ‘Are you sure you want to remove <name(s)> from 

the Physician Advisor panel?’ displays, click  the <OK> button. 

15.2.7 Removing a User from the NUMI Primary Reviewer Panel 

To remove a user from the list 

1. Click on a name in the NUMI Primary Reviewer List. 

2. Click the   button, and the name will be moved from the list to the VISTA 

User List portion of the panel. 

3. When the message ‘Are you sure you want to remove <name(s)> from 

the Primary Reviewer panel?’ displays, click  the <OK> button. 

15.2.8 Removing a User from the NUMI Site Administrators Panel 

To remove a user from the list 

1. Click on a name in the NUMI Site Administrators List. 

2. Click the   button, and the name will be moved from the list to the 

VISTA User List portion of the panel. 

3. When the message ‘Are you sure you want to remove <name(s)> from 

the Site Administrators panel?’ displays, click the <OK> button. 

15.2.9 Removing a User from the NUMI Report Access Panel 

To remove a user from the list 

4. Click on a name in the NUMI Report Access  List. 

5. Click the   button, and the name will be moved from the list to the 

VISTA User List portion of the panel. 

6. When the message ‘Are you sure you want to remove <name(s)> from 

the Report Access panel?’ displays, click the <OK> button. 
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15.3 Accessing the NUMI Treating Specialty Configuration 
Feature 

 

 

Figure 189: NUMI Treating Specialty Configuration Feature 

 

Under the Admin menu, the “Treating Specialty Configuration” option is available. You must 

have Site Administrator rights to view this screen. Information viewable on the screen will apply 

facility-wide. 

 

The Treating Specialty Configuration screen explains, “You may use this utility to let NUMI 

know which treating specialties from your facility are reviewable and whether or not they will be 

reviewed. NUMI will use this information to determine which patient stays should be included in 

your work list. NUMI will also use this information to determine which patient stays should be 

included in performance score calculations. If your facility is part of an integrated site or 

integrated health system, you only need to configure treating specialties that are (or have been) 

used by your specific facility. ” and offers a list of Treating Specialties with accompanying 

Dismissal Behavior list boxes. 

 

The list boxes are pre-populated with the following choices for Dismissal Behaviors:  Not 

Configurable, Acute Reviewable, Obs Reviewable, Acute Non Reviewable, Obs Not 

Reviewable, Non-Acute Not Reviewable, and Opting Not to Review. More than one Treatment 

Specialty can be updated with a new Dismissal Behavior. You may scroll through the current 

Treatment Specialties/Dismissal Behaviors by clicking the Next, Previous, Last Page or First 

Page hyperlinks (Figure 189). 
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To update a Treatment Specialty with a new Dismissal Behavior: 

1. Select new behavior(s) from the Treatment Dismissal Behavior dropdown for 

the corresponding Treatment Specialty (Figure 190). 

 

 

Figure 190: Select Treatment Dismissal Behavior list box 

2. Press <Save>.  

3. The choice(s) selected in the dropdowns are accepted. 
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16  Logging Out of the NUMI Application 

The Logout option is located on the Tools menu. 

 

To logout of the NUMI application 

1. Click on the Tools dropdown. 

2. Click on <Logout> option. 

3. The National Utilization Management Integration (NUMI)screen will 

display. 

4. Click the <Close Browser> button. The message “The Web page you are 

viewing is trying to close the window. Do you want to close this 

window?” displays. 

5. Click <Yes> to close the browser window. 
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17 Online Help Menu 

All NUMI users can access the most current version of this User Guide and other NUMI system 

documentation on the National VistA Software Documentation Library at 

http://www.va.gov/vdl/application.asp?appid=184 or through links on the OQSV website. 

 

The Office of Quality Safety and Value (OQSV) website can be accessed from the online Help 

menu, located at the top of many NUMI screens. If the online help information does not answer 

your question, first contact your NUMI site POC/Administrator for assistance. If the question is 

still unresolved, you may log a Remedy ticket.  

 

You may also go to the OQSV web page directly by typing this URL in your browser’s address 

line: http://vaww.oqsv.med.va.gov/functions/integrity/um/utilization.aspx   

 

17.1 Selecting the Online Help Menu 

To access the online Help feature 

1. Click on the Help menu dropdown (Figure 191). 

2.  

 

Figure 191: Help Menu dropdown 

 

2. Select the On-Line Help option by clicking on it, and you will be redirected 

to the Office of Quality Safety and Value (OQSV) web page (Figure 192).  

3. Click on the NUMI User Guide option. (Here you will be able to click on a 

link that will open an electronic copy of this User Guide in its entirety. Or, if 

you prefer, you can click on individual links to each chapter in the document.) 

 

http://www.va.gov/vdl/application.asp?appid=184
http://vaww.oqsv.med.va.gov/functions/integrity/um/utilization.aspx
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Figure 192: OQSV Web Page 
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18 Glossary of Terms 

A glossary of UM terms that are relevant to the NUMI application are defined in Table 16. 

 

Table 16: Glossary of Terms 

Term Description 

Acute A level of health care in which the patient’s 

severity of illness and intensity of service can 

only be performed in an in-patient setting. 

Admission Review An assessment of medical necessity and 

appropriateness of a hospital admission after 

the hospitalization has occurred and the patient 

has been moved to a higher level of care (e.g., 

from a Ward to MICU). This review is 

typically performed on admission, within 24 

hours following admission or no later than the 

first business day following the admission. 

Standardized review criteria must be used to 

determine the appropriateness of care. 

ALOC Acronym for Alternate Level Of Care 

Behavioral Health Assists in determining initial and successive 

level of care decisions for psychiatric 

conditions, chemical dependency and dual 

diagnosis for individuals at each stage of life, 

e.g., InterQual
®

 Behavioral Health Criteria. 

BH Acronym for Behavioral Health 

CERMe Acronym for Care Enhance Review Manager 

enterprise. A Web-based application, made 

available by McKesson that provides 

computerized InterQual
®

 templates to field 

Utilization Management staff. 

Concurrent Review A Behavioral Health review for a patient who 

has already received an initial review. 

Concurrent Review Process An assessment of medical necessity or 

appropriateness of services that covers the time 

period throughout the time of review and the 

previous 24 hours. 

COTS Acronym for Commercial Off-the-Shelf  

CPRS Acronym for Computerized Patient Record 
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Term Description 

System 

CS Acronym for Continued Stay 

DoD Acronym for Department of Defense  

ECT Acronym for Electroconvulsive Therapy 

Episode Day of Care A term commonly used to measure the 

duration of a single episode of hospitalization. 

Inpatient days are calculated by subtracting day 

of admission from day of discharge. However, 

persons entering and leaving a hospital on the 

same day have a length of stay of one. 

ET Acronym for Eastern Time 

FAQ Acronym for Frequently Asked Questions 

G&L Acronym for Gains and Losses 

HIPPA Acronym for Health Insurance Portability and 

Accountability Act of 1996  

Hospital Admission Review A review that is performed when a patient first 

comes into the hospital. All admission reviews 

should be dated with the actual admission date, 

regardless of when the review is performed.  

HTTP Acronym for Hypertext Transfer Protocol 

IE Acronym for Internet Explorer 

IEN Acronym for Internal Entry Number 

InterQual
®

 Clinical Evidence Summaries Collection of current white papers that 

synthesize medical research to support 

controversial diagnoses, which support second-

level medical review recommendations and 

promote evidence-based standards of care. 

InterQual
®

 Criteria 
InterQual

®
 is a product of the InterQual

®
 

division of McKesson Corporation. InterQual
®

 

criteria is used to determine if a patient’s 

hospital length of stay is appropriate. The 

criteria is based on the diagnoses and any 

treatments involved in the patient’s care.  

InterQual
®

 Level of Care Criteria InterQual Level of Care Criteria addresses 

admissions and continued stays across the 

continuum of care, from acute settings through 
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Term Description 

home care and outpatient treatment. 

IRM Acronym for Information Resource 

Management 

Level of Care Refers to the continuum of care, which 

includes various intensities of service levels 

such as acute, rehabilitation, sub-acute, home 

care and outpatient rehabilitation.  See also 

InterQual
®

 Level of Care Criteria. 

LOC Acronym for Level Of Care 

MDWS Acronym for Medical Domain Web Services 

Movement Types A movement refers to the act or process of 

moving a sick, injured, wounded, or other 

person to obtain medical care or treatment. 

Movement types in NUMI include Admission, 

Continued Stay, Discharge and Transfer. 

National Utilization Management Integration A Web-based application that automates 

documentation of clinical features relevant to 

each patient’s condition and the associated 

clinical services provided as part of VHA’s 

medical benefits package. 

NQF Acronym for National Quality Forum  

NUMI Acronym for National Utilization Management 

Integration 

Observation(s) An alternative level of health care comprising 

short-stay encounters for patients who require 

close nursing observation or medical 

management. 

OEF Acronym for Operation Enduring Freedom 

OIF Acronym for Operation Iraqi Freedom 

OIG Acronym for Office of Inspector General  

OQSV Acronym for Office of Quality Safety and 

Value 

PC Acronym for Personal Computer 

POC Acronym for Point of Contact 

RLOC Acronym for Recommended Level Of Care 
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Term Description 

Severity of Illness The extent of organ system derangement or 

physiologic de-compensation for a patient. 

Classified into minor, moderate, major, and 

extreme. Meant to provide a basis for 

evaluating hospital resource use or to establish 

patient care guidelines. 

SQL Acronym for Structured Query Language 

SSN Acronym for Social Security Number 

UM Acronym for Utilization Management 

URL Acronym for uniform Resource Locator  

Utilization Management The process of evaluating and determining the 

coverage and the appropriateness of medical 

care services across the patient health care 

continuum to ensure the proper use of 

resources. 

Utilization Review A formal evaluation or the coverage, medical 

necessity, efficiency or appropriateness of 

health care services and treatment plans for an 

individual patient 

VA Acronym for Department of Veterans Affairs 

VHA Acronym for Veterans Health Administration 

VISN Acronym for Veterans Integrated Service 

Network.  

VistA Acronym for Veterans Health Information 

Systems and Technology Architecture  

VSSC Acronym for VISN Support Services Center 
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Appendix A  – NUMI Screen Flow 
Figure 193 illustrates the basic flow of the major NUMI screens. 

 

 

UM Reviewer

Select VISN, then 

Site Screen

Access NUMI 

System Screen 

(login)

Patient Selection 

Screen

History Screen

CERMe Screen

Review hyperlink

Primary Review 

Screen

Tools Menu

Reports Menu

Admin Menu

Physician UM

Advisor Worklist

Screen

Review hyperlink

Continue Primary Review

FINAL SAVE/Lock To Database

Physician UM

Advisor Worklist

NOTES:

- On the Primary Review Screen, only reviews with Don’t Meet Criteria status will go to the Physician Advisor 

Worklist. 

Help Menu

 
 

Figure 193: NUMI Basic Screen Flow 
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Appendix B – NUMI Tips for Success 
This Appendix contains tips that will help you make the most of working with NUMI. 

 

Remember that each row on the Patient Selection/Worklist is a patient stay.  Use the Patient 

Selection/Worklist to identify your patient stays and the reviews needed. This screen will tell 

you:  

 Time and date of admission 

 If the patient is discharged 

 When the last review was done 

 Whether criteria was met on the last review 

 

Use the Assign Reviewer function. This will make it easier for you to locate your patients 

on the Patient Selection/Worklist.   

When you do a review, NUMI automatically assigns you as the reviewer. If you assign yourself 

to new admissions in your area of responsibility every day, then you can filter your facility 

Patient Selection/Worklist by your name, and you will have a complete listing of your active 

patient stays. 

 

Be diligent with Patient Selection/Worklist “housekeeping.”    

Every day, dismiss patients in non-acute specialties, such as Nursing Home and Domiciliary, and 

dismiss patients who are discharged and up to date with reviews. A shorter Patient 

Selection/Worklist will result in faster response time when you are filtering and sorting the 

patient stays. 

 

Use your Gains and Losses (G&L) or Ward Roster reports to confirm that all admissions 

are appearing in NUMI.    

Occasionally patient admissions are not picked up by the NUMI synchronizer.  When this 

happens, you can add that patient through the Synch with Vista feature. If you make certain that 

all admissions are captured every day, your patient stay list will be complete. 

 

Use short cuts and best practices whenever possible.    

As you work with NUMI, you will find the workflow that is best for you. Here are some things 

that are time-savers: 

 Navigate around the system using the 4 tabs 

 Filter your Patient Selection/Worklist– make sure everyone gets an admission review. They 

will then be in your list daily until you dismiss them. 

 Use the Copy Review function as much as possible…especially after weekends. 

 Some people make brief written notes while in CPRS or on the units and enter reviews all at 

once. Others prefer to toggle back and forth between NUMI and CPRS while doing reviews. 

 

Use Clinical Comments fields strategically.   

Enter information in the Clinical Comments boxes that will assist you in identifying critical 

issues with this stay and jog your memory for future reviews. This is an optional field, if there is 

nothing notable, leave it blank. For reviews not meeting criteria that will be sent to the Physician 

Advisor, enter clinical comments that can provide information to help the Physician Advisor 
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understand the Not Met status. 

 

Meet with your Physician Advisor to develop policy and guidelines for reviews.  Discuss 

which types of Not Met reviews should go to the Physician Advisor for review. If there are 

categories of Not Meeting reviews that the Physician Advisor would consider “Automatic 

Agree,” consider establishing a formal local policy to not send those to the Physician Advisor. 

Find out what types of clinical comments are helpful to the Physician Advisor.  

 

Use reporting.   

There are eight basic report templates. Some are facility aggregates, and some are patient level 

detail. At day’s end, use the patient detail report to print out a summary of your reviews. This is a 

helpful tool for the following day. 

 

 Utilize the training and help resources available. Ask for help when needed.   

The NUMI implementation for your facility will include LiveMeeting training classes. Make 

time to attend them. The UM website will have a NUMI section with helpful tools and resources.  

Call on the NUMI Trainers for assistance as needed. 

 

Be patient with yourself and the NUMI system.   

It takes time to learn how to apply a new tool like NUMI. Expect that you will make mistakes at 

first. NUMI is in its first version, so there will be new capabilities and changes identified. NUMI 

enhancements are already in development. NUMI upgrades will be rolling out regularly.  
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Appendix C – NUMI Terminology 
 

Below are some clarifications to terminology that is used in NUMI. 

 

Primary Reviewer and Primary Reviews 
Primary Reviewers may also be known as Nurse Reviewers or UM Reviewers. Whichever 

descriptor is utilized, this refers to the individual looking at the patient stay and performing the 

review that determines whether or not the stay meets InterQual
®

 Criteria. In general, NUMI 

attempts to use the terms Primary Reviewer and Primary Review. 

 

 

Physician Advisors and Medical Reviews 
In cases where the Primary Review does not meet InterQual

®
 Criteria as determined by the 

CERMe component of NUMI, the Primary Reviewer will be asked to assign a Physician Advisor 

to perform a medical review of the primary review. 

 

InterQual
®

 and some UM programs make use of a Secondary Reviewer who lies between the 

Primary Reviewer and the Physician Advisor. In NUMI there is no discreet Secondary Reviewer 

step -- this is best done by saving a review, and then having the Secondary Reviewer look at it. 

 

 

CERME vs. CERMe vs. CERM 
CERME stands for Care Enhanced Review Manager, McKesson's automation of their InterQual

®
 

Criteria -- an industry standard. Per McKesson, it is pronounced "Kermie". The 'E' or 'e' on the 

end technically refers to the standalone version of CERM, which has its own administrative and 

reporting tools.  

 

Regardless of how you see it in the application, this refers to the McKesson software embedded 

within NUMI.  References to a "standalone CERME" refer to the correct usage of the CERME 

(or CERMe) name. There are sites in the Department of Veterans Affairs (VA) that have been 

using their own standalone instances of CERME without the VistA integration. 
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Appendix D – UM Admission Reason Codes 
 

Table 17 provides a list of UM Admission Reason Codes and their definitions. 

  

Table 17: UM Admission Reason Codes 

UM Code Code Description for Admission 

Reviews 

Definition for Reason 

8.1 Outpatient Care  

8.11 Work-up Work-up 

8.12 Pre-op Pre-op 

8.13 Ambulatory surgery Ambulatory surgery 

8.14 Diagnostic study  

8.1401 Ablation/EPS Diagnostic study 

8.1402 Bronchoscopy Diagnostic study 

8.1403 Cardiac Cath Diagnostic Diagnostic study 

8.1404 Colonoscopy/EGD Diagnostic study 

8.1405 CT Scan Diagnostic study 

8.1406 Echo-cardiac Diagnostic study 

8.1407 EEG Diagnostic study 

8.1408 ERCP Diagnostic study 

8.1409 Interventional Radiology Diagnostic study 

8.141 MPI   Diagnostic study 

8.1411 MRA/MRV Diagnostic study 

8.1412 MRI Diagnostic study 

8.1413 Nuclear Med Cardiac Diagnostic study 

8.1414 Nuclear Med Non-cardiac Diagnostic study 

8.1415 PET Scan Diagnostic study 

8.1416 Sleep Study Diagnostic study 

8.1417 Stress Test Diagnostic study 

8.1419 Transesophageal Echo Diagnostic study 

8.142 Transthoracic Echo Diagnostic study 

8.1421 Ultrasound (non-cardiac) Diagnostic study 

8.1422 US/CT Guided Procedure Diagnostic study 

8.1423 Vascular Studies Diagnostic study 

8.15 Therapeutic procedure  

8.1501 Infusions Therapeutic procedure 

8.1502 Transfusions Therapeutic procedure 

8.1503 Chemotherapy Therapeutic procedure 

8.1504 Radiation Therapy Therapeutic procedure 

8.1505 Cardioversion Therapeutic procedure 

8.1506 Cardiac Cath w/Intervention Therapeutic procedure 

8.1507 Pacemaker/ICD Implantation Therapeutic procedure  
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UM Code Code Description for Admission 

Reviews 

Definition for Reason 

8.1508 Enteral Feeding Tube Therapeutic procedure 

8.1509 ECT Therapeutic procedure 

8.151 PICC Line Insertion Therapeutic procedure 

8.1511 Paracentesis Therapeutic procedure 

8.1512 Thoracentesis Therapeutic procedure 

8.2 Clinical  

8.21 Treatment/services Clinical 

8.22 Symptoms/findings Clinical 

8.23 Comorbid conditions  Clinical 

8.24 BH patient with medical care needs Clinical 

8.25 Premature Obs. Order Clinical 

8.21 Treatment/services Clinical 

8.22 Symptoms/findings Clinical 

8.23 Comorbid conditions  Clinical 

8.24 BH patient with medical care needs Clinical 

8.25 Premature Obs. Order Clinical 

8.3 Regulatory  

8.31 Court ordered  Regulatory 

8.32 CMS 3 day rule Regulatory 

8.33 APS Regulatory 

8.4 Social  

8.41 Self-Care Deficit Social 

8.42 Transportation Social 

8.43 Planned respite Social 

8.44 Homeless Social 

8.5 LOC Availability  

8.51 No bed available in RLOC LOC Availability 

8.52 RLOC not provided at facility LOC Availability 

8.6 Environmental  

8.61 Adverse Conditions Enviromental 
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Appendix E – UM Continued Stay Reason Codes 
 

Table 18 provides a list of UM Continued Stay Reason Codes and their definitions.  

 

Table 18: UM Continued Stay Reason Codes 

UM Code Code Description for Cont’d 

Stay Reviews 

Definition for Reason 

18.1 Outpatient Care  

18.11 Diagnostic  

18.1101 Ablation/EPS Diagnostic 

18.1102 Bronchoscopy Diagnostic 

18.1103 Cardiac Cath Diagnostic Diagnostic 

18.1104 Colonoscopy/EGD Diagnostic 

18.1105 CT Scan Diagnostic 

18.1106 Echo-cardiac Diagnostic 

18.1107 EEG Diagnostic 

18.1108 ERCP Diagnostic 

18.1109 Interventional Radiology Diagnostic 

18.111 MPI   Diagnostic 

18.1111 MRA/MRV Diagnostic 

18.1112 MRI Diagnostic 

18.1113 Nuclear Med Cardiac Diagnostic 

18.1114 Nuclear Med Non-cardiac Diagnostic 

18.1115 PET Scan Diagnostic 

18.1116 Sleep Study Diagnostic 

18.1117 Stress Test Diagnostic 

18.1119 TEE Diagnostic 

18.112 TTE Diagnostic 

18.1121 Ultrasound (non-cardiac) Diagnostic 

18.1122 US/CT Guided Procedure Diagnostic 

18.1123 Vascular Studies Diagnostic 

18.11 Diagnostic Diagnostic 

18.1101 Ablation/EPS Diagnostic 

18.1102 Bronchoscopy Diagnostic 

18.1103 Cardiac Cath Diagnostic Diagnostic 

18.1104 Colonoscopy/EGD Diagnostic 

18.1105 CT Scan Diagnostic 

18.1106 Echo-cardiac Diagnostic 

18.1107 EEG Diagnostic 

18.1108 ERCP Diagnostic 

18.1109 Interventional Radiology Diagnostic 

18.111 MPI   Diagnostic 
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UM Code Code Description for Cont’d 

Stay Reviews 

Definition for Reason 

18.1111 MRA/MRV Diagnostic 

18.1112 MRI Diagnostic 

18.1113 Nuclear Med Cardiac Diagnostic 

18.1114 Nuclear Med Non-cardiac Diagnostic 

18.1115 PET Scan Diagnostic 

18.1116 Sleep Study Diagnostic 

18.1117 Stress Test Diagnostic 

18.1119 TEE Diagnostic 

18.112 TTE Diagnostic 

18.1121 Ultrasound (non-cardiac) Diagnostic 

18.1122 US/CT Guided Procedure Diagnostic 

18.1123 Vascular Studies Diagnostic 

18.12 Procedures  

18.1201 Infusions Procedures 

18.1202 Transfusions Procedures 

18.1203 Chemotherapy Procedures 

18.1204 Radiation Therapy Procedures 

18.1205 Cardioversion Procedures 

18.1206 Cardiac Cath w/Intervention Procedures 

18.1207 Pacemaker/ICD Procedures 

18.1208 Enteral Feeding Tube Procedures 

18.1209 ECT Procedures 

18.121 PICC Line Insertion Procedures 

18.1211 Paracentesis Procedures 

18.1212 Thoracentesis Procedures 

18.1213 Surgical Procedure Procedures 

18.1201 Infusions Procedures 

18.1202 Transfusions Procedures 

18.1203 Chemotherapy Procedures 

18.1204 Radiation Therapy Procedures 

18.1205 Cardioversion Procedures 

18.1206 Cardiac Cath w/Intervention Procedures 

18.1207 Pacemaker/ICD Procedures 

18.1208 Enteral Feeding Tube Procedures 

18.1209 ECT Procedures 

18.121 PICC Line Insertion Procedures 

18.1211 Paracentesis Procedures 

18.1212 Thoracentesis Procedures 

18.1213 Surgical Procedure Procedures 

18.2 Clinical  

18.21 Lack of medical necessity Clinical 

18.22 Clinical instability Clinical 
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UM Code Code Description for Cont’d 

Stay Reviews 

Definition for Reason 

18.23 Comorbid conditions Clinical 

18.24 BH Patient with medical care 

needs 
Clinical 

18.25 ALOC available and appropriate Clinical  

18.26 No documented plan or 

evaluation 
Clinical  

18.21 Lack of medical necessity Clinical  

18.22 Clinical instability Clinical  

18.23 Comorbid conditions Clinical  

18.24 BH Patient with medical care 

needs 
Clinical  

18.25 ALOC available and appropriate Clinical  

18.3 Regulatory  

18.31 Court ordered stay Regulatory 

18.32 CMS 3 day rule Regulatory 

18.34 Guardianship Regulatory 

18.31 Court ordered stay Regulatory 

18.4 Social  

18.41 Lack of caregiver  Social 

18.42 Transportation Social 

18.43 Planned respite Social 

18.44 Homeless Social 

18.45 Resistance to discharge plan Social 

18.5 LOC Availability  

18.51 No bed available in RLOC LOC Availability 

18.52 RLOC not provided at facility LOC Availability  

18.53 Transfer Delay  

18.531 VA Facility Transfer Delay  

18.532 Non-VA Facility Transfer Delay  

18.6 Enviromental  

18.61 Adverse Conditions Enviromental 

18.7 Post-Acute Transition  

18.71 Placement Issues  

18.711 Financial Placement Issues 

18.712 Administrative Placement Issues 

18.713 Clinical Placement Issues 

18.714 Behavioral Placement Issues 

18.72 Awaiting CLC acceptance Post-Acute Transition 

18.73 Awaiting CLC bed Post-Acute Transition 

18.74 Awaiting community placement  

18.741 VA paid Awaiting community placement 

18.742 Non-VA paid Awaiting community placement 
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UM Code Code Description for Cont’d 

Stay Reviews 

Definition for Reason 

18.75 Ineffective discharge 

planning/process 
Post-Acute Transition 

18.8 Scheduling  

18.81 Delayed diagnostic test   

18.8101 Ablation/EPS Delayed diagnostic test 

18.8102 Bronchoscopy Delayed diagnostic test 

18.8103 Cardiac Cath Diagnostic Delayed diagnostic test 

18.8104 Colonoscopy/EGD Delayed diagnostic test 

18.8105 CT Scan Delayed diagnostic test 

18.8106 Echo-cardiac Delayed diagnostic test 

18.8107 EEG Delayed diagnostic test 

18.8108 ERCP Delayed diagnostic test 

18.8109 Interventional Radiology Delayed diagnostic test 

18.811 MPI   Delayed diagnostic test 

18.8111 MRA/MRV Delayed diagnostic test 

18.8112 MRI Delayed diagnostic test 

18.8113 Nuclear Med Cardiac Delayed diagnostic test 

18.8114 Nuclear Med Non-cardiac Delayed diagnostic test 

18.8115 PET Scan Delayed diagnostic test 

18.8116 Sleep Study Delayed diagnostic test 

18.8117 Stress Test Delayed diagnostic test 

18.8118 Swallow Study Delayed diagnostic test 

18.8119 TEE Delayed diagnostic test 

18.812 TTE Delayed diagnostic test 

18.8121 Ultrasound (non-cardiac) Delayed diagnostic test 

18.8122 US/CT Guided Procedure Delayed diagnostic test 

18.8123 Vascular Studies Delayed diagnostic test 

18.82 Delayed Surgery/procedure  

18.8201 Infusions Delayed Surgery/procedure 

18.8202 Transfusions Delayed Surgery/procedure 

18.8203 Chemotherapy Delayed Surgery/procedure 

18.8204 Radiation Therapy Delayed Surgery/procedure 

18.8205 Cardioversion Delayed Surgery/procedure 

18.8206 Cardiac Cath w/Intervention Delayed Surgery/procedure 

18.8207 Pacemaker/ICD Delayed Surgery/procedure 

18.8208 Enteral Feeding Tube Delayed Surgery/procedure 

18.8209 ECT Delayed Surgery/procedure 

18.821 PICC Line Insertion Delayed Surgery/procedure 

18.8211 Paracentesis Delayed Surgery/procedure 

18.8212 Thoracentesis Delayed Surgery/procedure 

18.8213 Surgical Procedure Delayed Surgery/procedure 

18.8201 Infusions Delayed Surgery/procedure 
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UM Code Code Description for Cont’d 

Stay Reviews 

Definition for Reason 

18.8202 Transfusions Delayed Surgery/procedure 

18.8203 Chemotherapy Delayed Surgery/procedure 

18.8204 Radiation Therapy Delayed Surgery/procedure 

18.8205 Cardioversion Delayed Surgery/procedure 

18.8206 Cardiac Cath w/Intervention Delayed Surgery/procedure 

18.8207 Pacemaker/ICD Delayed Surgery/procedure 

18.8208 Enteral Feeding Tube Delayed Surgery/procedure 

18.8209 ECT Delayed Surgery/procedure 

18.821 PICC Line Insertion Delayed Surgery/procedure 

18.8211 Paracentesis Delayed Surgery/procedure 

18.8212 Thoracentesis Delayed Surgery/procedure 

18.8213 Surgical Procedure Delayed Surgery/procedure 
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Appendix F – Frequently Asked Questions (FAQ) 
This Appendix contains a list of Frequently Asked Questions about NUMI: 

 

Getting Started: 

 

Q: What do I need before I start using NUMI? 

A: This is what you will need: 

 a Windows PC on the VA intranet, running Microsoft Internet Explorer 6.0 (IE6) or higher  

 While it is expected that NUMI will run on your PC without any difficulty, should you 

experience problems please contact your local IRM for assistance. Many issues can be 

resolved by changing some settings on the PC. (See Section 2.1 in the User Guide for 

more information).If you are not permitted to change settings yourself due to restrictions 

at your particular VA site, your local IRM can help you.  

 a production VistA account at one site that has CPRS access to that site 

 You only need one “home” login site. Please note that NUMI access is completely 

separate from access for CPRS and VistAWeb - you will need to arrange for those rights 

separately. Performing reviews in NUMI without proper additional clinical informatics 

tools such as CPRS and VistAWeb is strongly discouraged. 

 to have your account set up by a NUMI Administrator 

 The rights you will need will depend on whether you are a Primary Reviewer, a Physician 

Advisor or an Administrator. 

 the URL for the NUMI application 

 This will be provided to you after you have attended NUMI training. 

 

Login Error Messages: 

 

Q: I’m unable to login to VistA. I’m getting this message: “Unable to login to VistA. The 

error was: Device IP address is locked due to too many invalid signon attempts”. What 

should I do? 

A: This error means you have exceeded the maximum number of login attempts permitted by 

your local VistA. When this happens, VistA will lock you out of the NUMI application for 20 

minutes. After 20 minutes, VistA will clear your login restriction and you can try to login again. 

You can also call your IRM support person and ask them to zero out your login attempt count so 

you can login without waiting for 20 minutes. 

 

Q: During login, after selecting my VISN and site and entering my access and verify codes, 

a mostly blank screen appears with the site I selected towards the upper left and a “GO” 

button next to it.  Do I need to click the button to proceed? 

A: No. In fact, if you click the button you will get an error and have to start the login process 

over again.  Just wait for the screen to paint fully. 

 

Q: I’m unable to login.  I’m getting this message: “Verify code must be changed before 

continued use.”  What should I do? 

A: Your VistA site Verify code has expired and you need to log into VistA.  After you enter your 
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Verify code VistA will ask you to re-enter it and enter a new Verify code, then re-enter it to 

confirm.  After you have successfully logged into VistA you should be able to log in to NUMI. 

 

Warning / Advisory Messages: 

 

Q: I selected a patient stay from the Stay Movement table, but got a warning message 

telling me that the stay cannot be retrieved from VistA and may be invalid. Why would this 

happen?   

A: This warning may occur because an invalid patient admission was entered, and the record was 

deleted from the hospital database – but not before it was sent to NUMI. The stay can be deleted 

from NUMI using the Patient Stay Administration option. However, before deleting anything in 

NUMI, check CPRS or VistA to verify that the admission or movement is no longer in VistA. 

The invalid stay message can also appear if NUMI cannot connect to VistA when a reviewer 

clicks the review link, even if the movement is still in VistA. (See Chapter 11 in the User Guide 

for more information about deleting patient stays).  

 

Q: I selected criteria from the InterQual Criteria screen, but when I clicked the Continue 

Primary Review button I got this message: “Unsupported review type. Please use another 

CERMe review”. What does this mean? 

A: The review is not supported in NUMI. Certain InterQual subsets, such as Behavioral Health 

Procedure criteria, are not supported in NUMI. You will need to select another review. (See 

Chapter 0 [Table 7] in the User Guide to see the list of unsupported criteria).  

 

Working with the NUMI Screens: 

 

Q: Sometimes clicking on the Patient Stay History screen View link doesn’t cause the 

expected screen to pop up. 

A: It is likely that the screen is already up but hidden in back of another screen.   You can use 

alt-tab to move between screens that are already up, or minimize each screen until you see the 

hidden screen. 

 

Q: The “typing memory” feature seems to have disappeared.  Previously, when I typed in 

something, NUMI would often complete the text and save me from typing the whole thing. 

A: This happens if your web browser is upgraded to a new version.  The auto-populate feature is 

wiped out when updates are applied, but will return gradually as you use the browser and NUMI. 

(If your local IRM policy controls the browser’s auto-complete function, this may never be 

available). 

 

Working with Patient / Attending Information: 

 

Q: I know a patient has been admitted to the hospital and they are in VistA, but I don’t see 

them listed on the Patient Selection/Worklist in NUMI. How can I get them to display? 

A: You can manually synchronize NUMI with what is in VistA. Select Manual VistA 

Synchronization from the Tools Menu. Choose the desired search options and click the Find 

Stays in VistA button. When the results display, click the checkboxes beside the stays you wish 

to synchronize and select the Synchronize Stays button. NUMI will now show what is in VistA. 
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(See Chapter 11 in the User Guide for more information about using the Manual VistA 

Synchronization option). 

 

Q: I have a patient on the list whose listed Attending Physician is different than the actual 

Attending. Is this supposed to be so? 

A: When that happens, it is because it was entered inaccurately on the unit or in Admissions. 

When you put in your review, you can correct this by selecting the correct Attending from the 

drop-down box on the Primary Review screen. (See Chapter 8 in the User Guide for more 

information about how to change the Attending Physician). 

 

Q: While waiting for a patient’s information to load after selecting a stay, if I click on 

another button, I get an error message and have to start over again. 

A: Please be patient and wait until NUMI responds to a click or other command. Clicking 

multiple times before the system responds will produce an error. 

 

Q: I changed the Attending on the Primary Review Summary screen - so why doesn't my 

change show up on the Patient Selection/Worklist? 

A: That is because it is showing you the values from VistA. 

 

Q:  On the patient list under Wards, there is no option to select surgical patients. I have 

various areas that are not showing up on that list (i.e., one of my CLC units; 3B 

Observation). How can I get this information? 

A:  The Ward list will be populated as movements for those wards occur. It may be that no 

surgical patients had been picked up yet, and that existing patients hadn't been picked up by the 

overnight synchronizer because there weren't any qualifying movements.  This will be a common 

phenomenon when NUMI is first up and running. If you know you're missing someone, use the 

manual synchronizer (Sync With VistA) feature of NUMI, to get that patient’s information. If 

they are on the missing ward, that ward will also be added to the database. (See Chapter 11 in the 

User Guide for more information about using the Manual VistA Synchronization option). 

 

This isn't a problem that you need to contact your Help Desk team about. It is just a one-time 

initial condition that can cause some confusion. It is very similar to the example of a long-term 

care patient who hasn't had a movement since NUMI started running, and doesn't show up in the 

database. 

 

Q: Patient stays seem to be either disappearing from the Patient Selection/Worklist or 

never appear.  What should I do? 

A: You can always use the Manual VistA Synchronization option to restore them.  You might 

also want to check with other UM reviewers to find out what when and how they dismiss patient 

stays.  It is important to use filtering on the Patient Selection/Worklist to make sure no one 

dismisses another reviewer’s stays.  It is also important to regularly dismiss stays that won’t be 

reviewed to clear up screen clutter and keep NUMI response time reasonable, so UM reviewers 

should have a procedure for regularly dismissing stays. If you aren’t seeing patients that you 

expect to see, check to see which filters are currently applied to your Patient Selection/Worklist. 

To see a complete list of the patient stays on the List, uncheck all of the filter boxes and click on 

the GO button at the top of the screen. This will generate a complete list of the patient stays at 
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your facility. Another way to check for patient stays is to look at the Patient Stay Administration 

screen and see if the stay was invalidated because it [temporarily] couldn't be found in VistA. 

(Follow the instructions for restoring a stay, as described in Section 11.7.2 of the User Guide).  

 

Q: A patient was admitted and has been in the hospital for a while, but does not appear on 

the Patient Selection/Worklist. Why does this happen and what can I do? 

A: The automatic midnight and hourly synchronization occasionally does not synchronize a 

patient movement, due to timing and network problems. Check CPRS, G&L report, and ward 

rosters to identify any missing patients. Use the Manual VistA Synchronization feature to add a 

patient. Also, some patients may have been admitted prior to, and haven’t had a movement since, 

the inception of NUMI. 

 

Q:  Does resynching with VistA overwrite NUMI data? 

A: Resynching with VistA will always update the stay data, but review data will not be 

overwritten. 

 

Q: A patient admission was on the G&L but does not appear in VistA as an inpatient. 

A: The admission may have been removed from VistA or the hospital’s PIMS staff may be 

editing the movement record at the same time you are trying to access it.  Use the Synchronize 

with VistA option to select the patient and bring the data to NUMI. 

 

Q: Is there a way to pull up data for Admitting Physician? 

A: VistA patient movement data does not include Admitting Physician. In NUMI, you can select 

the Admitting’s name in the Admitting’s name on the Primary Review screen.   

 

Working with Patient Stays: 

 

Q: How can I tell who dismissed a patient? 

A: The information will come up on the Dismissed Patient Stays screen. You can get to this 

screen by selecting Dismissed Patient Stays from the Tools Menu. (See Chapter 11 in the User 

Guide for more information about using the Dismissed Patient Stays option). 

 

Q: Do you have any suggestions for how to go about finding and dismissing Discharged, 

Nursing Home, and Domiciliary patients? 

A: If you have Administrative privileges, you can set up the Treating Specialty Configuration to 

automatically dismiss these treating specialties.  See Section 15.3 for further instructions. 

 

Q: Physicians report receiving several notifications on the same stay for patients admitted 

Friday night. 

A: It isn’t that the patient is showing up multiple times, it’s a notification for each day.  Every 

review that doesn’t meet criteria will go on the physician’s list.  It should be explained to the 

physicians that they do have to review them. 

 

Q: I need to take over reviewing a patient stay that another reviewer had been working on 

and this involves changing a review previously saved. 

A: If it is appropriate to change a saved review, you can ask your site NUMI POC/Administrator 
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to unlock it.  Any reviewer can unlock their own saved reviews, but not a review saved by 

another reviewer. 

 

Working with Reviews: 

 

Q: If one of my reviews is locked and I need to edit it, do I need to delete and restart 

everything? 

A: No. You can unlock the review by selecting the Utilization Management Review Listing from 

the Tools Menu. Click the Reviewer dropdown and your name will appear in the list, by default.  

Click the Find button and a list of your reviews will display. Click the patient’s hyperlink name 

beside the review you wish to edit to open the review summary. Click the Unlock button. You 

now have the option to re-review this day again.  Remember to select the Final Save button when 

you are finished with the review. (See Chapter 13 in the User Guide for more information about 

Unlocking reviews). 

 

Q: Is there a way to complete more than one review at a time in NUMI? 

A: No. Only 1 review can be completed at a time. However, you can create consecutive reviews 

by using the Copy Review feature to copy a completed review multiple times [versus creating a 

new one from scratch each time]. (See Chapters 8, 11 and 14 in the User Guide for more 

information about copying a Review). 

 

Q: Can you clarify the Reason Codes?  What are my options?   

A: You will find the list of Admission and Continued Stay Reason Codes in Appendices D and E 

of the User Guide, respectively. 

 

Q: Do we need to review Observation Admissions?  If we remove them, will it negatively 

impact our report stats? 

A: Observation Admissions do not need to be reviewed in NUMI at this time.  Your reports will 

not be impacted. 

 

Q: I’m having trouble when trying to do a retrospective review because it’s hard to 

remember which days have been reviewed and which is next to be reviewed. 

A: On the Primary Review screen, use the gold “Show Reviews” bar that you can click to show 

the reviews already done for that patient/stay. You can also click on the “View” link for each 

completed review to see its details in a pop-up window. 

 

Q: Physician reviewers are saying they are spending too much time finding the review 

information. 

A: The more descriptive the UM reviewer can be in their Reviewer Comment field, the easier it 

is for the physician.  You can enter up to 4000 characters that will appear on the physician 

review screen, and then the physician only needs to agree or disagree and do a final save to 

remove the patient from the worklist. (Physicians may find it useful to look at the CERMe 

criteria decision tree at the bottom of the screen). 

 

Q: What can I do to decrease the time I spend entering reviews into NUMI? 

A: First, stays that do not need reviews should always be dismissed each morning, if they have 



 

May 2014 NUMI User Guide 18-21 

not been automatically dismissed by the system. Reviewers can use the Reviewer filter, 

whenever possible.   When doing multiple reviews for the same patient, when not copying an 

existing review, go back to the Patient Stay History page rather than the Patient 

Selection/Worklist to save some of the longer load times in NUMI. You may prefer to use filters 

versus sorting. One recommendation is that you first check to see that you have all your patients 

on the Patient Selection/Worklist. If you are missing a patient or two, go to the Tools Menu, 

select Synch with VistA, and synchronize any missing patients before beginning your reviews 

for that day. This will cut down on the disruption of your workflow and ensure that you have all 

of your assigned patient stays. 

 

Working with Reports: 

 

Q:  On those reviews not meeting criteria AND not needing to be sent to a Physician 

Advisor (e.g., :  patient is in ICU, awaiting an acute care bed; or a placement problem), do 

they ultimately get recorded as “approved” or “not approved” if the box is checked?  For 

reporting purposes, how will they break out? 

 A:  In NUMI, there is no “approved” or “not approved” category. All reviews that go to the 

Physician Advisor are returned as “Agree with the current level of care” OR “Disagree with the 

current level of care.” A patient review can be exempted from the physician review process 

through formal hospital policy. All patient reviews not meeting criteria that are automatically 

exempt are recorded in the NUMI database as Agree with the current level of care. These 

reviews will be included in all NUMI reports.  

 

Q: If data, such as Attending Physician, is corrected within NUMI, will the corrected value 

be used on NUMI reports? 

A:  Yes. The next time you generate the reports they will reflect the correct Attending 

Physician’s name. These changes are NOT reflected in VistA, because NUMI has READ-ONLY 

access to VistA. 

 

Working with Text Boxes: 

 

Q:  How many characters can I type in the various text boxes in the NUMI application? 

A: The maximum characters that can be typed into the various text boxes are listed below. 

 

 Primary Review Screen 

 Criteria Not Met Elaboration Box is 100 characters 

 If "Other" is selected from the Current Level of Care dropdown, users will be required to 

enter a description. The maximum number of characters allowed is1,000. 

 If "Other" is selected from the Recommended Level of Care dropdown, users will be 

required to enter a description. The maximum number of characters allowed is1,000. 

 The maximum number of characters allowed in the Comments field is 4,000 

 The maximum number of characters allowed in the Custom field is 25 

 

 Physician Advisor Worklist Screen 

 If "Other" is selected from the Agree (with Current Level Of Care) dropdown, users will 

be required to enter a description. The maximum number of characters allowed is 1,999. 
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 If "Other" is selected from the Disagree (with Current Level of Care) dropdown, users 

will be required to enter a description. The maximum number of characters allowed is 

1,999. 

 Miscellaneous 

If "Other" is selected from any other dropdowns (e.g., Stay Reasons), users will be required to 

enter an explanation. The maximum number of characters allowed is 500. 

 

Appendix G – NUMI Review – Screens 
Encountered 

 

Figure 194 illustrates the major screens that are encountered when doing a review in NUMI. 

 

 

 

Figure 194: Screens Encountered during NUMI Reviews 
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